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Safety
The operator of the ImageXpress® Micro System is assumed to be trained 
in the correct operation of the instrument and the safety issues. 
Throughout the ImageXpress® Micro Widefield High Content Screening 
System User Guide, the word “you” refers to this trained operator. Using 
controls, making adjustments, or performing procedures other than 
those specified in this guide can result in hazardous exposure to laser 
light, high voltage, hot surfaces, or moving parts. Exposure to these 
hazards can cause severe or fatal injury. 

Safety Text Used in this Guide 
Make sure you follow the precautionary statements presented in this 
guide. 

CAUTION! Indicates that damage to the instrument, loss of data, or 
individual injury could occur if the user fails to comply with the advice 
given. 

WARNING! Indicates a possibility of severe or fatal injury to the user 
or other persons if the precautions are not observed.

Note: Highlights information that is critical for optimal performance of 
the system or identifies items of general interest.
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The Protective Housing
The protective outer housing and instrument panel interlocks are 
designed to protect you from exposure to laser light, hot surfaces, or 
moving parts.

Interlock Failure
There are three safety interlocks on the automated door. Do not operate 
this instrument with the door open.

If you experience any of the following symptoms, you might have 
interlock failure:

• The focusing laser stays on after the automated door is opened. 
• The sample stage or filter mechanisms continue to move after 

the automated door is opened. 
If this is the case, it is unsafe to continue using the ImageXpress Micro 
System. Please contact Technical Support immediately (see Obtaining 
Support on page 34). 

Non-Interlocked Panels
There are several other panels on the instrument that are intended for 
use by field service personnel and are not interlocked. All non-

WARNING! Do not defeat the interlocks, open the protective housing, 
or try to gain access to the interior of the instrument through any 
other openings, unless specifically instructed by one of the user 
procedures outlined in this user guide. Read each procedure carefully 
and follow all outlined safety precautions. Incorrectly opening the 
outer protective housing can damage the instrument components and 
result in hazardous exposure to laser light, hot surfaces, or moving 
parts. 

WARNING! Do not disable any of the interlocks. When the automated 
door is opened, the interlocks trigger both the laser light source and 
the motion control electronics to turn off to prevent hazards 
associated with laser emission or moving parts.
10 5015321 C 



Safety
interlocked service panels are secured to the protective housing using 
screws and require a special tool to remove. 

Laser Safety
The ImageXpress Micro System is a Class 1 LASER product. Contained 
within the instrument is an embedded Class 3b high power LASER (used 
for autofocus), which the user cannot and should not attempt to access. 
The classification and power of the embedded LASER are as follows:

Safety interlocks within the instrument allow samples to be loaded and 
unloaded without exposure to LASER radiation. If the top panel is 
removed for service, the LASER beam remains safely contained within 
the optical system until it passes through the microscope objective, 
which diverges the beam and renders incident power levels below 
Class 1 (1 mW/cm2).

Lamp Safety
The ImageXpress Micro System is equipped with an external light source. 
The light source for the Standard model of the ImageXpress Micro 
System is equipped with a 300 W Xenon lamp. These lamps have a 
limited lifetime of approximately 500 hours and will need to be replaced 
upon failure (see Maintaining the ImageXpress Micro Instrument on 
page 175).

WARNING! Make sure the instrument is powered OFF and power 
cable unplugged in the event you are instructed to remove non-
interlocked panels. Absolutely do not operate or access the interior of 
this instrument with any covers or panels removed.

Table 3-1: Embedded laser classification and power

Wavelength Power Duration Embedded Laser’s 
Class

690 nm 20 mW Continuous Class 3b

WARNING! Do not attempt to repair or adjust the LASER. Deliberate 
removal of the top panel, safety interlocks, and microscope objective 
while staring into the LASER beam can cause severe eye injury and 
blindness.
5015321 C 11 
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Liquid Light Guide 
The ImageXpress Micro System uses a liquid light guide between the 
external light source and the instrument. The light source generates a 
very bright light. In addition, the Standard model of the ImageXpress 
Micro System uses a high-powered Xenon lamp. The infrared and 
ultraviolet radiation generated by these lamps can cause significant skin 
burns and eye damage.

WARNING! In the event that a lamp requires replacement, ensure 
that you have allowed the lamp to cool for at least 30 minutes. The 
lamp generates an extreme amount of heat and attempting to remove 
the lamp immediately after use can result in injury. 

Note: The XL model of the ImageXpress Micro System is equipped with 
an external solid-state light source that has a rated lifetime of more 
than 10000+ hours. There are no user-replaceable parts in this light 
source.

WARNING! Do not remove the light guide from the instrument or the 
light source when the lamp is powered on.
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Safety
High-Voltage Hazard 
There are no high-voltage electronics found inside the ImageXpress 
Micro System. High-ignition voltages do exist inside the external Xenon 
lamp light-source housing, which can be lethal. 

Moving Parts
The ImageXpress Micro System contains moving parts that can cause 
injury. Under normal conditions, the instrument is designed to protect 
you from these moving parts. The interlocks and protective housing are 
designed so you cannot access the moving parts during a scan. 

Fuses
In the Standard model of the ImageXpress Micro System, the Xenon light 
source contains a fuse. In the event of fuse failure, disconnect the power 
cord from the light source and consult Maintaining the ImageXpress 
Micro Instrument on page 175 for instruction on how to replace the fuse.
In the XL model of the ImageXpress Micro System, the supplied external 
power supply for the solid-state light source provides over-current 
protection for the light source limited to 7.9A maximum. The solid-state 
light source and power supply contain no user-serviceable parts.
The instrument power supply contains a circuit-breaker switch with a trip 
point of 18.75 amps.

WARNING! Do not operate the light source with the housing open or 
powered ON.

WARNING! Do not try to gain access to the interior of the instrument 
unless specifically instructed to do so. The moving parts inside the 
instrument can cause injury. Do not operate this instrument with 
covers or panels removed.
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Power Supply
The ImageXpress Micro System has one cable running from the 
instrument to the external power supply (input voltage range is from 100 
to 240 VAC, 50/60 Hz, 2 A). 

Figure 3-1: Power supply label 

Lifting Hazard 

WARNING! Make sure this cable is unplugged before accessing any 
part of the instrument. Failure to do so can result in serious harm.

WARNING!  The ImageXpress Micro System weighs approximately 
180 lbs (82 kg). Do not attempt to lift or move the instrument without 
assistance. Moving your instrument can disrupt sensitive optical 
alignments. Molecular Devices recommends that you contact 
Technical Support to schedule a Field Service engineer to help with 
moving your instrument. Your warranty or service contract will not 
cover problems caused during or as a result of shipment or relocation.
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Maintenance and Service
User service and maintenance is strictly limited to the procedures 
outlined in this user guide. Access for the majority of these procedures is 
through the interlocked panels described in The Protective Housing on 
page 10. No other user service that is not outlined within this user guide 
is permitted. If there is a problem or you have questions, please contact 
Technical Support. 

List of Controls 
This guide constitutes a list of controls. 

Hazardous Material Precautions 
Use standard laboratory procedures and cautions when working with 
chemicals. 

WARNING! Use of controls, adjustments, or performance of 
procedures other than those specified within this user guide can result 
in hazardous conditions or injury.

WARNING!  Always follow the manufacturer’s precautions when 
working with chemicals. Molecular Devices is not responsible or liable 
for any damages caused by or as a consequence of the use of any 
hazardous material.
5015321 C 15 



ImageXpress Micro Widefield High Content Screening System User Guide
Safety Label
If the label becomes illegible or is missing for any reason, please contact 
Technical Support for a free replacement label. While waiting for a 
replacement label, copy the label below and attach a copy of the label to 
the instrument.

Figure 3-2: Safety label
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Safety
Symbol Explanations
Table 3-2: Symbols 

Symbols Indication

Indicates a potential pinch hazard location

Indicates that the product contains a laser radiation source

Indicates that product documentation needs to be consulted

Indicates heavy object, lifting hazard

Indicates Alternating Current

Indicates Direct Current

Indicates power on

Indicates power off

Indicates the location of the Protective Earth Ground Terminal
5015321 C 17 
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Indicates that you must not discard this electrical/electronic 
product in domestic household waste

Indicates fuse

Table 3-2: Symbols (cont’d)

Symbols Indication
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1
Introduction
Overview
The ImageXpress® Micro Widefield High Content Screening System from 
Molecular Devices is an integrated cellular imaging and analysis system 
that is designed for rapid, automated screening of fluorescently labeled 
biological samples in microplates.
The core hardware component of the imaging system is a custom-
designed, fully automated, epi-illumination fluorescence microscope, 
with rapid autofocus and precision sample movement features that allow 
large numbers of high-resolution images to be acquired in the shortest 
possible time. All key optical and mechanical elements are motorized, 
with asynchronous command execution, thereby allowing complete real-
time control of the instrument configuration through the MetaXpress® 
High Content Image Acquisition and Analysis Software interface.
When used in combination with the powerful imaging capabilities of the 
MetaXpress Software, the instrument becomes an extremely flexible and 
programmable device, ideally suited for user-defined, high-speed 
automated assays.
Key components of the instrument include the following:

• External light source connected by a liquid light guide
• User-specified camera
 A cooled CCD camera in the standard model
 A scientific CMOS camera in the XLS model

• Fast laser autofocus system with precision motorized Z (focus) 
stage

• Image-based autofocus
• Precision motorized X-Y (sample) stage
• High-quality user-changeable Nikon objectives in a four-position 

linear selector
• User-changeable filter cubes in a five-position slider
• Selectable binning modes to decrease exposure time and 

increase throughput
• Motorized selection of stage position, filter cubes, and objectives 

with asynchronous operation
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• High-transmission fluorescence imaging optics with world-class 
chromatic aberration correction, resolution, and image flatness

• Operation and configuration by integrated MetaXpress Software
• Plate-handling robot (optional) with automated barcode reader

ImageXpress Micro Instrument

Figure 1-1: ImageXpress Micro System Components

Illumination System: Excitation 

Light Source 
The ImageXpress Micro System has an external light source, which 
provides continuous, high-intensity broadband illumination.

• In the Standard model of the ImageXpress Micro System, the 
300 W, long-life Xenon lamp has an expected lifetime of more 
than 500 hours.

• In the XL model of the ImageXpress Micro System, the solid-state 
light source has an expected lifetime of more than 10000+ hours.

Cold Mirror 
In the Standard model of the ImageXpress Micro System, the Xenon lamp 
light source incorporates a cold mirror which prevents light with 
wavelengths longer than 675 nm from reaching the sample. Limiting the 
wavelengths of the light source minimizes sample heating and stress on 
optical components.

DC power

DC power

Camera I/O

USB 2.0

Liquid light
guide

Light
source

Main
power
supply

Camera
power
supply

ImageXpress Micro
System

(main unit)
Computer Monitor

RS-232 to USB 2.0 (XL model only)
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Light Guide 
A liquid light guide couples the light from the light source to the 
illumination optics in the ImageXpress Micro System unit. The light 
source assembly is precisely aligned with the light guide during 
manufacture, and requires no further position adjustment. 

Illumination Optics 
The output end of the liquid light guide is imaged onto the sample by a 
set of internal optics and the objective, providing bright and uniform 
illumination of the specimen over a wide field of view. This constitutes an 
Abbé illumination system (also called critical illumination).

Shutter (standard model only)
A solenoid-activated mechanical shutter controls the exposure of the 
sample to excitation light to minimize sample degradation and 
photobleaching. 

Filter Cube Changer 
The 5-position filter cube changer takes standard Nikon TE2000 filter 
cubes. The ImageXpress Micro System uses Semrock filters. 

Objective (Z) Stage 

Motorized Z Stage 
The Z stage is controlled by a linear encoder and has better than 100 nm 
resolution. 

Objectives 
Standard objectives are Nikon CFI60 series. The selected objective lens 
focuses excitation light onto the sample, and collects fluorescence light 
emitted by the sample. Molecular Devices offers a wide range of 
objectives to suit your experimental needs. 

Motorized Objective Changer 
There is a 4-position objective changer. Only the selected objective 
moves up and down in Z. 

Note: In the XL model of the ImageXpress Micro System, the solid-state 
light source is limited to between 380 nm and 680 nm.
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Sample (X-Y) Stage 

Sample 
The plate holder is designed for scanning multi-well plastic and glass 
bottom microplates in standard ANSI (SBS) formats, but can 
accommodate other plate formats that have standard microplate 
footprint dimensions. For example, glass slides can be imaged using a 
slide adapter included in the tool kit. Optimum image quality depends on 
plate flatness and optical clarity. 

Plate Holder and Plate Clamp 
A spring-loaded mechanical clamp holds the sample plate securely in the 
plate holder. The clamp automatically opens when the X-Y stage moves 
to the load/unload position, and automatically closes when the X-Y stage 
moves the plate into position for imaging. 

Motorized X-Y Stage 
The X-Y stage is controlled by a linear encoder and has better than 
100 nm resolution. 

Autofocus Laser
A red (690 nm) diode laser projects a laser spot onto the sample. 
Reflections of this spot from the bottom of the microplate and the 
plate-sample interface are imaged by a dedicated, fast-focus sensor, and 
are used as a reference for focusing using the autofocus feature of the 
MetaXpress Software. 

Imaging System: Emission

Tube Lens
The tube lens collects collimated light from the objective and focuses it 
onto the detector plane of the camera. The emission wavelength range is 
400 nm to 750 nm.

Camera
The Standard model of the ImageXpress Micro System is shipped with a 
cooled CCD camera. This camera has a 1392 × 1040 pixel resolution (6.45 
× 6.45 μm pixel size), and has a peak quantum efficiency greater than 
60% at 550 nm. 
The XL model of the ImageXpress Micro System is shipped with a 
scientific CMOS camera. This camera has a 2560 × 2160 image sensor 
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format (6.5 × 6.5 μm pixel size), and has a peak quantum efficiency of 
60% at 550 nm. The center 2160 x 2160 pixels are extracted during plate 
acquisition to ensure adequate illumination uniformity.

Electronics 
The ImageXpress Micro instrument also contains the following 
components:

• External power supply and cable.
• USB 2.0 port and cable to computer for device control.
• Camera cabling to camera board in computer.

MetaXpress Software
Use the MetaXpress® Software with the ImageXpress Micro System to 
select a standard image analysis routine or to develop a custom protocol 
to fit your specific acquisition and analysis needs. The MetaXpress 
Software workflow is divided into two major parts: acquisition and 
analysis. 

• The acquisition workflow involves configuring settings, acquiring 
images, and storing plate data in a database. See Preparing For 
Acquisition on page 59, Setting Up Plate Acquisition on page 67, 
and Acquiring Plates on page 143.

• The analysis workflow consists of processing, enhancing, and 
analyzing acquired plate data. See the MetaXpress High Content 
Image Acquisition and Analysis Software Analysis Guide included 
on the MetaXpress Software installation USB flash drive. 

Simplified Menu Structure
An optional simplified menu structure can be installed to reduce the 
number of top-level menus. All the features of the software are available 
in this reorganized menu structure.
The procedures in this guide describe both the default menu structure 
and the simplified menu structure. 
You can use the Menu Map in the Help menu to help you find the 
locations of features in the simplified menu structure.

1. Click Help > Menu Map.
2. In the Menu Map dialog, select to view the Default to 

customized menu map.
3. Click the menu path where the software feature you want is 

found in the default menu structure. 
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The simplified menu path appears to the right of the desired 
feature in the menu.

4. Click the menu path in the software window to access the 
desired feature.

For example, if you want to make a duplicate of an image, then use the 
following procedure:

1. Click Help > Menu Map.
2. In the Menu Map dialog, select to view the Default to 

customized menu map.
3. Click Edit > Duplicate. 

The simplified menu path -> Edit: Image: Duplicate Image/Plane 
appears to the right of the Image option in the submenu.

4. In the software window, click Edit > Image > Duplicate 
Image/Plane.

Administrator Tasks
Most of the procedures in this document are for the general users. 
However, Molecular Devices recommends that you identify one or more 
users as advanced users or system administrators. The responsibilities of 
the system administrator vary from site to site. Variables include the 
number of users on the system, the type of database used, and the type 
of work done. Some common MetaXpress Software system administrator 
tasks include:

• Installation overview with a Molecular Devices representative
• Post-installation hardware and software testing
• Database planning and implementation
• Custom user and group settings creation
• Maintenance scheduling and software updating

Basic Operational Theory

Fluorescence Imaging 
Fluorescence is a phenomenon observed in certain species of molecules 
(fluorochromes, or dyes) in which photons of a specific wavelength are 
absorbed (excitation), and as a result a very short time later photons are 
emitted at a longer wavelength (emission). The utility of fluorescence 
imaging in biological applications stems from the ability to conjugate 
fluorescent molecules with biologically active probe molecules, so that 
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application of the combined dye/probe molecule (fluorophore) to the 
specimen highlights the specific substances or regions to which the 
probe is targeted.
Further, by attaching different probes to a set of dye molecules with non-
overlapping excitation and emission spectra, one can stain a specimen 
with multiple fluorophores, and either simultaneously or sequentially 
image different structures or substances within the same specimen. The 
absorption and emission peaks for each dye in a given environment are 
physical characteristics of that molecule, and their specific properties 
determine the initial selection of the optical components to be used: 
emission and excitation filters, and dichroic mirror.

Excitation and Emission Filters 
In the ImageXpress Micro System, the excitation and emission filters are 
located in a filter cube. 
To selectively excite one fluorophore more intensely than another, or to 
minimize excitation channel crosstalk, it is necessary to provide 
illumination containing only photons with a wavelength range matched 
to the target dye's absorbance (excitation) spectrum. If the primary 
illumination source provided is broadband, such as in the ImageXpress 
Micro System, a bandpass filter in the illumination optical path (called 
the excitation filter, since it filters the excitation light) is used to restrict 
the illumination spectrum to a narrow range of wavelengths. 
Similarly, when imaging the illuminated sample, it is desirable to collect 
only the emission photons from the target fluorophore, rejecting as 
much as possible any reflected or scattered excitation light, any light 
from other dyes, and autofluorescence from the sample and substrate. 
This is accomplished by placing a filter in the collection light path, called 
the emission filter. Emission filters can either be of the bandpass variety, 
for maximum specificity, or longpass, to maximize the amount of 
emission light collected.

Dichroic Mirror 
In the ImageXpress Micro System the dichroic mirror is in a filter cube. 
A dichroic mirror is a specially designed beam splitter that transmits light 
above a certain cutoff wavelength, and reflects light at shorter 
wavelengths. This is the essential component that allows the 
construction of an epi-illumination fluorescence imaging system such as 
ImageXpress Micro System, in which the illumination and imaging optical 
paths overlap at the objective lens. That is, the same objective lens is 
used to focus the illumination light onto the sample as well as collect the 
emitted fluorescent light to form the image. 
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In the illumination path, the dichroic mirror reflects shorter wavelengths 
from the light source up through the objective onto the specimen, as 
shown in Figure 1-2.

Figure 1-2: Dichroic mirror creates two light pathways

Incident light from the illumination source that is longer wavelength than 
the cutoff is transmitted to a beam dump that absorbs and diffuses the 
waste light to prevent it from entering the imaging optical path. 
In the imaging optical path, longer wavelength fluorescence light emitted 
by the excited fluorophores in the specimen is collected by the objective 
lens, and transmitted by the dichroic through to the tube lens and 
camera. Incident light from the sample that is shorter wavelength than 
the cutoff (mostly reflected illumination light from the sample) is 
reflected by the dichroic (and further blocked by the emission filter), and 
is therefore prevented from entering the imaging system of tube lens and 
camera. 
Dichroic mirrors are interference filters made by depositing a number of 
thin film coatings on a glass support. Dichroics need to be kept thin for 
high image quality, so the supporting glass is quite fragile, and generally 
the film coating is not protected with a cover glass. This means that 
unprotected dichroics are delicate and easily damaged components, and 
so care must be taken when handling them. 
26 5015321 C 



Introduction
Dichroic Transmission Spectrum 
An ideal dichroic mirror would have an infinitely sharp cut-off: that is, it 
would have unity transmittance coefficient at wavelengths longer than 
the cut-off, and zero transmittance (and therefore unity reflectance in a 
non-absorbing dichroic mirror) shorter wavelengths. In practice, the 
characteristic transmission spectrum for a dichroic looks something like 
Figure 1-3.

Figure 1-3: Example of a transmission spectrum of a dichroic

In principle, the cutoff wavelength (or midpoint of the cutoff region) of 
the dichroic should be chosen to lie halfway between the absorption and 
emission peaks of the chosen fluorochrome, as this will simultaneously 
maximize the amount of excitation light available at the sample, and also 
the amount of collected fluorescence emission that is transmitted to the 
camera. In practice, however, additional considerations such as 
fluorochrome efficiency can dictate that the cutoff region is biased 
towards one peak or the other-allowing, for example, greater 
transmission of longer wavelength image photons at the expense of less 
reflection of shorter wavelength excitation light. 
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Objective Lenses 
The ImageXpress Micro System can be configured with any of the high 
quality Nikon objectives listed in Appendix C: Objectives Compatible with 
the ImageXpress Micro System on page 211.
If the objective you want to use is not listed, please contact us to verify 
compatibility with the ImageXpress Micro System. 
Note that the extra-long working distance (ELWD) objectives have 
adjustable spherical-aberration correction collars for imaging through 
thick substrates such as most microplates. Please see Maintaining the 
ImageXpress Micro Instrument on page 175 for details on how to 
calculate and set their correct values.   
Several of the other objectives (such as, CFI SUPER FLUOR 40X) also have 
correction collars for adjustment according to the thickness of the glass 
cover slip being used. Setting of these collars should be done according 
to the cover slip manufacturer’s specifications or through optimization of 
image quality. 
Objectives are classified here according to optical correction, flatness of 
field, numerical aperture, and working distance. Before choosing 
additional objectives to use with your system, it is important to consider 
the types of plates you will be imaging. The plate material (plastic vs. 
glass) and thickness are major considerations when choosing an 
objective. Another important practical note is that generally the greater 
an objective's correction, the greater the number of lens elements it 
contains, with correspondingly reduced light transmission, especially in 
the UV spectrum. In particular, apochromatic (“Apo”) objectives tend to 
have poor UV transmission characteristics. 
For detailed information on objectives, please see the Nikon website 
(www.nikon.com).
28 5015321 C 

http://www.nikon.com


2
Getting Started
This chapter provides a quick overview of the start-to-finish workflow for 
using the ImageXpress® Micro System. The following topics are included 
in this chapter:

• Starting the ImageXpress Micro System on page 29
• Acquiring Data on page 33
• Analyzing Data on page 33
• Maintaining the Instrument on page 33
• Shutting Down the System on page 34
• Obtaining Support on page 34

Starting the ImageXpress Micro System
This section explains how to safely power up the ImageXpress® Micro 
instrument and log in to the MetaXpress® Software.

Powering On the Instrument
1. Ensure that the power cords for the instrument and the lamp are 

connected to a 100 VAC to 120 VAC or 220 VAC to 240 VAC power 
source. 

2. Turn on the power switch on the light source power supply unit.

3. Wait for the light source to stabilize before acquiring images.
 In the Standard model of the ImageXpress Micro System, the 

Xenon lamp takes 15 to 20 minutes to stabilize.
 In the XL model of the ImageXpress Micro System, the solid-

state light source takes less than a minute to stabilize.
4. Turn on the power switch on the front of the ImageXpress Micro 

power supply unit.

Note: Turn on this power supply first to minimize electrical 
pulse interference with the electronic components in your 
system.
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5. Ensure that the camera power supply is plugged in and, if 
required, turned on.

6. Turn on the power to the host computer and the monitor.
7. After the computer has started and Windows is running, log in to 

Windows using the User Name/Password combination provided for you 
by your system administrator.

CAUTION! Do not log into your system as “Guest” unless you are 
specifically instructed to do so by your system administrator.

8. Continue to the next procedure, Starting the Software on 
page 30.

Starting the Software
To start the MetaXpress Software, complete the following procedure:

1. Double-click the MetaXpress icon on your desktop or click Start 
> Programs > MetaXpress > MetaXpress.

2. In the MetaXpress Software title screen, in the User Name field, 
select the user name to use and click OK. 

Note: This procedure assumes that your ImageXpress Micro System and 
your MetaXpress Software have been properly installed and configured 
by your Molecular Devices representative and your System 
Administrator.

Note: If you encounter or observe actions or results that are 
inconsistent with your expected results when using ImageXpress Micro 
System and your MetaXpress Software, contact your system 
administrator before continuing your experiment.
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Figure 2-1: MetaXpress Software title screen

The MetaXpress Software starts and a progress bar at the 
bottom of the dialog indicates the loading progress of the 
program.

3. In the Welcome to MetaXpress dialog, select the data source to 
connect to (if there is more than one), enter your login name and 
password, and then click OK. 

Note: This screen appears only when the MetaXpress Software 
is configured to run in multi-user mode from within the Meta 
Imaging Series Administrator. 

If you do not see this screen, the MetaXpress Software is in 
single-user mode. Continue to Step 3.
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Figure 2-2: Welcome to MetaXpress dialog

4. In the dialog to select a Group, select one of the groups assigned in the 
Meta Imaging Series Administrator and click OK. 
The MetaXpress Software application starts and initializes the 
various components of the ImageXpress Micro System. If you 
receive error messages when the system is initializing, ensure 
that all hardware connections are plugged in and fully seated.

Note: For versions 4.0 and 5.0 of the MetaXpress Software, the 
default User Login Name is MolDev, the default System 
Administrator Login Name is sa, and the default password for 
both is moldev. For earlier versions of the software, the default 
User Login Name and password was mdc. You might need to log 
in using mdc if you had an earlier version of the software on your 
instrument workstation. If needed, you can change the password 
by clicking Change Password. 
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Acquiring Data
The acquisition workflow involves configuring settings, acquiring images, 
and storing plate data in a database. 
For detailed information, see the following chapters:

• Preparing For Acquisition on page 59
• Setting Up Plate Acquisition on page 67
• Acquiring Plates on page 143

Analyzing Data
The analysis workflow consists of processing, enhancing, and analyzing 
acquired plate data. See the MetaXpress High Content Image Acquisition 
and Analysis Software Analysis Guide included on the MetaXpress 
Software installation USB flash drive.

Maintaining the Instrument
Specific user-level maintenance can be performed on the ImageXpress 
Micro System for changing the lamp and fuse, changing filter cubes, 
Changing and cleaning objectives, and cleaning the instrument as 
described in Maintaining the ImageXpress Micro Instrument on 
page 175.
For all other service and maintenance needs, please contact Molecular 
Devices. See Obtaining Support on page 34.
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Shutting Down the System
1. Exit the MetaXpress Software application. 

The software prompts you to save any open images.
2. Turn off the power to the computer and the monitor.
3. Turn off or unplug the power to the camera power supply.
4. Turn off the power to the light source unit.

5. Turn off the power switch on the front of the ImageXpress Micro 
System power supply unit.

Obtaining Support
Part of effective communication with Molecular Devices is determining 
the channels of support for the ImageXpress Micro System, including the 
MetaXpress® High Content Image Acquisition and Analysis Software. 
Molecular Devices provides a wide range of support:

1. Documentation — Check the manuals that are included on the 
installation media and the help that is available within the 
MetaXpress Software. Help for an active dialog box can be 
accessed by pressing the [F1] key. 

2. Online knowledge base — The knowledge base has links to 
technical notes, software upgrades, newsletters, manuals, and 
other resources. Visit the Molecular Devices Support web page 
at www.moleculardevices.com/support and follow the links to 
the knowledge base. 

3. Technical Support — 
Phone: Contact Technical Support at (800)-635-5577 (U.S. only) 
or +1 408-747-1700. 
Online: Visit www.moleculardevices.com/support and follow the 
links in the knowledge base to the Technical Support Request 
Form to send an e-mail to a group of experienced Technical 
Support representatives. 

Note: Do not power cycle the light source too frequently. It is 
better to leave the light source on for a short while when it is not 
being used than to turn it on and off frequently. If the light 
source is unused for a longer period of time, turn it off.
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Please have the system ID number, system serial number, 
software version number, and the system owner’s name 
available when you call.
 To find your system ID number, from the Help menu, select 

About MetaXpress. The dialog that appears displays your 
system ID number. 

 The system serial number is located on your instrument.
4. Additional support resources include:
 Nikon web-based microscopy course — 

http://www.microscopyu.com 
 The Molecular Probes handbook — 

http://www.probes.invitrogen.com offers advice on 
fluorescent probes and can help you determine if there are 
better stains available for your analysis.

The following sites offer filter information:
 http://www.chroma.com
 http://www.semrock.com
 http://www.omegafilters.com

Gathering Support Information
If you need to contact Molecular Devices for support, it is very important 
to have the following information available to help Technical Support 
personnel troubleshoot the problem you are experiencing:

• The steps that led up to the occurrence of the problem
• The settings of any dialogs used when the problem occurred
• The text of any error messages
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You should also collect the following information from your system 
whenever reporting software problems:

• Copy of the Plate Acquisition Settings file: By default, the plate 
acquisition settings file is saved to the database. To save the 
settings to a file, go to the Experiment tab of the Plate 
Acquisition Setup dialog, click Save Settings, and then select 
Save to file rather than database. The settings file will then be 
saved to the C:\MX6\HTSSTATE folder by default.

• Journal files: If you were running a journal when the problem 
occurred, include copies of the journal files that you were using. 
By default, journal files are saved in the 
C:\MX6\app\mmproc\journals folder. If you are running 
journals through the review plate data tab, then the journals are 
saved in c:\analysis and c:\assay.

• System Information Report: This report contains information 
about many system settings and the release levels of all the.dll 
files in your currently installed MetaXpress Software. For 
information on how to create a System Information report to 
email to Molecular Devices, see Creating a System Information 
Report on page 38.

Logging AxoTrace Messages to a .txt File
AxoTrace tracks the hardware status of the ImageXpress Micro System 
and logs all the hardware activities of the system. If the error occurs 
downstream of the initial cause, AxoTrace provides a log that Molecular 
Devices Technical Support can use to trace the error back to the original 
cause and pinpoint the problem. Use the procedure below if a 
reproducible hardware error occurs. Follow the AxoTrace setup 
procedure and record the steps that lead to the error. If the error results 
in the instrument not starting up, not responding, or the error cannot be 
reproduced, contact Molecular Devices Technical Support immediately.

To log AxoTrace messages to a .txt file
1. Open the MetaXpress Software and AxoTrace starts 

automatically.
The AxoTrace icon appears in the toolbar.

Figure 2-3: AxoTrace icon in toolbar
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2. Close the MetaXpress Software.
3. Double-click the AxoTrace icon in the toolbar.
4. In the AxoTrace window, click Options > Output to File and make sure 

that the Time prefix option is selected.

Figure 2-4: AxoTrace Options menu

5. Click File > Save As.
6. In the Save As dialog that appears, in the Name field, navigate to 

the location where you want to save the log file, type the file 
name (for example, axotrace log.txt) and then click Save to save 
the log file.

7. Close the AxoTrace dialog and then start the MetaXpress 
Software.

8. Turn off the ImageXpress Micro System and then turn it back on. 
The light source can remain on during this step.

9. Reproduce the error and after the error is reproduced, close the 
MetaXpress Software. 

10. Send the AxoTrace log as an e-mail attachment to Molecular 
Devices Technical Support.
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Creating a System Information Report
Much of the required system setting information can be obtained by 
creating a System Information Report. You create this report from the 
About MetaXpress dialog on the Help menu. This report can be printed 
on a printer connected to your system or a network printer, or it can be 
“printed” to a PDF file or to an ASCII text file. After the report is in the 
form of a PDF file or a text file, you can send this report to appropriate 
Molecular Devices support personnel as an email attachment. Figure 2-5 
shows the About MetaXpress Software dialog.

Figure 2-5: About MetaXpress Software
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System Installation
The ImageXpress® Micro System is shipped fully configured, and is 
installed at your site by a Molecular Devices field service engineer. The 
base system includes the imaging unit, host computer, and toolkit that 
includes a slide holder, three calibration slides, hex wrenches for 
changing filter cubes, and a TetraSpeck bead plate.
The ImageXpress Micro System host computer is shipped with the 
MetaXpress Software already installed, and the instrument is connected 
to the host computer during installation. There are four main 
connections, excluding power cords: 

• Power supply to the ImageXpress Micro System
• Light guide from the external lamp to the ImageXpress Micro 

System
• USB 2.0 data cable from the ImageXpress Micro System to the 

host computer
• Cable from the camera to the computer
• Camera power supply cable to the ImageXpress Micro System. 

If you need to install or re-install the MetaXpress Software on a new 
computer, please see the MetaXpress High Content Image Acquisition 
and Analysis Software Installation Guide included on the MetaXpress 
Software installation USB flash drive, or contact Technical Support. See 
Obtaining Support on page 34.
5015321 C 39 



ImageXpress Micro Widefield High Content Screening System User Guide
Verifying Device Settings in the Meta Imaging Series Administrator
This procedure ensures that the ImageXpress Micro System hardware 
components are properly configured in the Meta Imaging Series 
Administrator application and the MetaXpress Software application. All 
hardware and software configuration settings are implemented in the 
Meta Imaging Series Administrator application.

To check the hardware configuration in the Meta Imaging Series 
Administrator application, complete the following procedure:

1. Use the procedure described in Powering On the Instrument on 
page 29, to power up the system, but do not start the 
MetaXpress Software application.

2. From the Windows Start menu, click All Programs > MetaXpress > 
Meta Imaging Series Administrator. 
The Meta Imaging Series Administrator program opens.

3. Select MetaXpress from the List of Groups field.

Figure 3-1: Meta Imaging Series Administrator Program

Note: For additional information about any of the dialogs in the Meta 
Imaging Series Administrator, press the F1 key to access the application 
help for the active dialog. The Meta Imaging Series Administrator and 
the MetaXpress Software application cannot be run simultaneously.
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4. Click Configure Hardware.
5. In the Configure Hardware dialog, click Configure Devices.

Figure 3-2: User Settings hardware configuration dialog

6. In the User Settings hardware configuration dialog, select 
ImageXpress Micro X from the Claimed Devices list and then click 
Settings. 

7. In the ImageXpress Micro X Settings dialog, increase the step size to 
10,000 μm.

Figure 3-3: ImageXpress Micro X Settings dialog 
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8. Ensure that Reverse Coordinate System is NOT checked.
9. Click the icon and confirm that the stage responds to the control.
10. Change the step size back to 10 μm and click OK.
11. Select ImageXpress Micro Y from the Claimed Devices list and click 

Settings. 

Figure 3-4: ImageXpress Micro Y Settings dialog

12. In the ImageXpress Micro Y Settings dialog, increase the step size to 
10,000 μm.

13. Ensure that Reverse Coordinate System check box is selected.
14. Click the icon and confirm that the stage responds to the control.
15. Change the step size back to 10 μm and click OK.
16. Select ImageXpress Z from the Claimed Devices list.
17. Click Settings. 

The ImageXpress Z Settings dialog appears.
18. Verify that the value in the Device Units field is 50.
19. Increase the step size to 1000 μm.
20. Click the icon and confirm that the Z Motor responds to the 

control.
21. Change the step size back to 10 μm and click OK.
22. Select ImageXpress Objective from the Claimed Devices list and 

click Settings. 
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Figure 3-5: ImageXpress Objective Settings dialog

23. In the ImageXpress Objective Settings dialog, confirm that the 
Objective labels and values in the Num Aperture fields match each 
objective on your system. The Numerical Aperture (NA) values are 
written on each objective. Position 1 is the position on the right if you 
are facing the filter cube access door at the front of the instrument.

24. Click the Param Group #1 tab in the Objective Parameters section on 
the bottom half of the dialog. This tab contains the Z offset positions in 
μm for the objectives. Confirm that these are valid numbers and all but 
one are greater than 0.

25. Click Param Group #2, then click Open Control Dialog. 
The Control – ImageXpress Micro Objective dialog appears.

26. Click the arrow buttons and confirm that the objective changer is 
moving appropriately.

27. Click Done, then click OK to close the dialog.
28. Select ImageXpress Micro Filter Cube from the Claimed Devices 

list and click Settings.

Note: If you need to determine the offset values, see 
Configuring Parfocality after Changing Objectives on page 186.
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Figure 3-6: ImageXpress Micro Filter Cube Settings dialog

29. In the ImageXpress Micro Filter Cube Settings dialog, confirm that the 
filter sets listed in the Filter Labels field are correct. Position 1 is the 
position closest to you if you are facing the front of the instrument (the 
side with the filter cube access door).

30. Click Open Control Dialog.
31. In the Control – ImageXpress Micro Filter Cube Settings dialog, 

click the arrow buttons to confirm that the filter cube is 
responding to the program. 

32. Click Done, then click OK to close the ImageXpress Micro Filter 
Cube Settings dialog.

33. Select ImageXpress Micro Shutter from the Claimed Devices list 
and click Settings. 

Figure 3-7: ImageXpress Micro Shutter Settings dialog
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34. In the ImageXpress Micro Shutter Settings dialog, confirm that the 
Open Delay and Close Delay fields are both set to 20 milliseconds.

35. Click Open Shutter Control Dialog. 
36. In the Control – ImageXpress Micro Shutter Settings dialog, click 

Toggle to confirm that the shutter is responding.
37. Click Done, then click OK to close the ImageXpress Micro Shutter 

Settings dialog.

38. Click OK to close the User Settings hardware configuration dialog and 
continue to the next procedure.

Verifying Camera Settings in the Meta Imaging Series Administrator 
Complete the following procedure to ensure that the correct version of 
the ImageXpress Micro System camera driver is installed:

1. From the Configure Hardware dialog, click Configure 
Acquisition.

2. In the Configure Acquisition dialog, ensure that a driver is listed 
in the Installed Drivers column.

3. If a driver is not listed in the Installed Drivers column, or if more 
than one driver is listed, contact Molecular Devices support to 
determine which driver is required for your system.

Note: If you have a plate handling robot attached to the 
ImageXpress Micro System, you should confirm those settings as 
well. For information, see Verifying External Control Settings on 
page 221.
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4. In the Installed Drivers column, select the appropriate driver.
5. Click Configure to query the camera. 
6. In the camera driver dialog, ensure that the camera is available in 

channel 1. This confirms that the camera is responsive. 
7. If the camera was not queried successfully, ensure that the cabling is 

correct from the ImageXpress Micro System main unit to the computer 
and that the camera power supply is plugged in and, if required, turned 
on.

8. Click OK to close the camera driver dialog.
9. Click OK to close the Configure Acquisition dialog.
10. Click OK to close the Configure Hardware dialog.
11. Click OK to close the Meta Imaging Series Administrator and then 

continue to the next procedure.

Verifying and Backing Up Settings in the MetaXpress 
Software Application

After confirming hardware settings in the Meta Imaging Series 
Administrator, you should also check the following settings from within 
the MetaXpress Software application:

• Magnification Settings
• Illumination Settings
• Calibration Settings
• Laser Autofocus Sensor Settings

During the verification process, it is recommended that you backup these 
settings as described in the procedures. This will allow you to restore the 
settings in case they are lost.

Verifying and Backing Up Magnification Settings 
You will need to confirm magnification settings for the ImageXpress 
Micro System objectives before using your system. Complete the 
following procedure to check the magnification settings in the 
MetaXpress Software application:

1. Open the MetaXpress Software and log into the database.

Note: For additional information about any of the dialogs in the 
MetaXpress Software application, press the F1 key to access the online 
help for the active dialog.
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2. Click Devices > Configure Magnification.
In the simplified menu structure, click Control > Devices > 
Configure Magnification.

Figure 3-8: Configure Magnification dialog 

3. In the Configure Magnification dialog, ensure that the ImageXpress 
Micro setting exists and its checkbox is selected in the Settings field. 

4. Confirm that the Defined Settings field contains a setting for each 
objective on your system.

5. Click Backup. 
The Backup All Magnification Settings dialog appears.

6. Select a name and location for the backup and click Save.
7. Settings can be restored by clicking Restore and choosing the 

saved file.
8. Click Close to exit the Configure Magnification dialog.
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Verifying Illumination Settings
You will need to confirm illumination settings for the ImageXpress Micro 
instrument before using your system. Complete the following procedure 
to check the Illumination settings in the MetaXpress Software 
application:

1. Open the MetaXpress Software application and log into the database.
2. From the Devices menu, select Configure Illumination. 
3. In the Configure Illumination dialog, ensure that ImageXpress Micro 

Filter Cube is selected in the Device Positions field.
4. Ensure that the ImageXpress Micro Shutter is selected as Active for 

each filter set.
5. Ensure that the correct illuminations are listed in the Defined Settings 

field.

Figure 3-9: Configure Illumination dialog

6. Set up other illumination settings if needed. The value in the 
Wavelength field should match the center wavelength for the emission 
filter.

7. Click Backup. 
8. In the Backup All Illumination Settings dialog, select a name and 

location for the backup and click Save.
9. Settings can be restored by clicking Restore and choosing the 

saved file.
10. Click Close to exit the Configure Illumination dialog.
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Verifying and Backing Up Calibration Settings 
Complete the following procedure to confirm and backup calibration 
settings in the MetaXpress Software application:

1. Click Measure > Calibrate Distances. 
In the simplified menu structure, click Measure > Distances > 
Calibrate Distances.

2. In the Calibrate Distances dialog, confirm that there are calibration 
settings in the dialog that match the objective settings from the 
Configure Magnification dialog.

Figure 3-10: Calibrate Distances dialog

3. Click Save to File. 
The Save Spatial Calibrations dialog appears.

4. Select a name and location for the backup and click Save.
5. Settings can be restored by clicking Load from File and choosing 

the saved file.
6. Click Close to exit the Calibrate Distances dialog.

Table 3-1 shows estimated values that can be used for 
ImageXpress Micro System calibration settings.
Table 3-1: Estimated Calibration Settings 

Objective Estimated Calibration

1x 6.50 μm/pixel

2x 3.25 μm/pixel
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4x 1.63 μm/pixel

10x 0.65 μm/pixel

20x 0.33 μm/pixel

40x 0.16 μm/pixel

60x 0.12 μm/pixel

100x 0.07 μm/pixel

Table 3-1: Estimated Calibration Settings (cont’d)

Objective Estimated Calibration

Note: Make sure the appropriate magnification setting is 
selected for each calibration.

For additional information on creating calibrations settings, refer 
to the MetaXpress Software online help. Press the F1 key when 
the Calibrate Distances dialog is open to access its online help. 
Also refer to the technical note “Spatially calibrating images in 
MetaMorph” available in the Molecular Devices support 
knowledge base at www.moleculardevices.com/Support.html.
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Verifying the Laser Autofocus Sensor
This procedure uses a bead plate to test that the laser autofocus (LAF) 
sensor is enabled and functional. Use the following procedure to confirm 
that the Laser Auto Focus is responding in the MetaXpress Software 
application:

1. Power on the system and open the MetaXpress Software 
application if it is not already open.

2. Click Screening > Plate Acquisition Setup.
In the simplified menu, click Screening > Acquisition Setup.

3. Click Acquisition Loop.
In the simplified menu, click Configure > Acquisition.

4. In the Autofocus options section of the dialog, ensure that 
Enable laser-based focusing is selected.

5. Click the Plate tab to highlight it.
6. Select the included Costar 96-well Plastic plate type from the 

Plate name field.
7. From the Screening menu, select Plate Acquisition and Control. 
8. The Plate Acquisition and Control dialog appears.
9. Click Eject Plate to move the stage to the load position.
10. Load the bead plate and click Load Plate.
11. Click Go To A1 to move the stage to the A1 position.
12. On the Plate Acquisition Setup dialog, click the Autofocus tab to 

highlight it.
13. Click Configure Laser Settings. 

The Configure Laser Autofocus Settings dialog appears.
14. Click Preview Pass.
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A window opens displaying a graph of focus intensities vs. 
Z-position.

Figure 3-11: Preview Pass graph

15. If the Preview Pass window contains at least one peak, the Laser 
Auto Focus Sensor is enabled and functional. 

16. If the Preview Pass window does not contain any peaks, ensure 
that the plate is properly seated, increase the Exposure value in 
the Configure Laser Autofocus Settings dialog, and try again. 

17. If the Preview Pass window still does not contain a peak, contact 
Technical Support and report the issue. (See Obtaining Support 
on page 34.) For more information on the Preview Pass window, 
see Confirming Laser Auto Focus Settings for Plate Files on 
page 57.

18. Click Close to exit the Configure Laser Autofocus Settings dialog.
52 5015321 C 



System Installation and Testing
Verifying the Plate Reference Point (A1 Center)
Complete the following procedure to ensure that the plate reference 
point (A1 center) is properly set:

1. Power on the system and start the MetaXpress Software 
application if it is not already running.

2. From the Screening menu, select Plate Acquisition Setup.
3. Click the Objective and Camera tab to highlight it.
4. Select the lowest power objective from the Magnification drop-down 

list (usually this is a 4x magnification), and then enter a binning value of 
1 in the Camera Binning field.

5. Select a gain value of 2 in the Gain field.
6. Click the Plate tab to highlight it.
7. Select 96 Wells (8x12) plate type from the Plate name field.
8. Click the Sites to Visit tab to highlight it.
9. Ensure that Site Acquisition Option is set to Single site.
10. Click the Wl (Wavelength) 1 tab to highlight it.
11. Select FITC from the Illumination setting drop-down list and enter an 

exposure time of 100 msec in the Exposure field.

12. From the Screening menu, select Plate Acquisition and Control. 
The Plate Acquisition and Control dialog appears.

13. Ensure that W1 – FITC is selected in the Wavelength field.
14. Enter a step size of 250 in the Step size field.

Note: You need the metal X/Y calibration plate/slide holder that ships 
with the ImageXpress Micro instrument to complete this procedure.

Note: Cubes other than the FITC are acceptable to use however 
the contrast may not be as high as with the FITC. Exposure times 
will vary significantly depending on your light source and filter 
cube choice.
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Figure 3-12: Plate Acquisition and Control dialog

15. Click Eject Plate to move the stage to the load position.
16. Load the metal X/Y calibration plate. Ensure the notch in the 

plate is in the A1 position on the stage.
17. Click Load Plate to load the plate.
18. Click Go To A1 to move the stage to the A1 position.
19. Click Show Live to open a live image window.
20. If you are not using the 4x objective skip, go to Step 23.
21. Use the Z control arrows to step the Z-motor (reducing the step size as 

you get closer to focus if needed) until the A1 pinhole comes into focus.
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Figure 3-13: A1 Pinhole in focus at 4X

22. Verify that the hole is visually centered in the field of view. If it is not, or 
if you cannot find the hole, contact Technical Support. See Obtaining 
Support on page 34.

23. If your lowest magnification objective is greater than 4x:
 Move the stage up until you are close to focus and left until 

you see the edge of the insert hole. 
 Align the left side of the hole with the left side of the image 

window and record the stage X position.
 Move the stage to the right until you see the edge of the 

insert hole. 
 Align the right side of the hole with the right side of the 

image window and record the stage X position.
 Calculate the horizontal center of the reference point.
 Repeat Step 23 for the vertical center of the reference point.
 Compare this stage position with the position of the stage 

when you click Go To A1.
24. Click F2: Stop to stop the live image.
25. Eject the X/Y calibration plate and continue to the next 

procedure.
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Verifying Plate Types
Complete the following procedure to ensure that the preconfigured plate 
type files included with the MetaXpress Software application are 
available from the Plate Acquisition Setup dialog:

1. Open the MetaXpress Software application if it is not already 
open.

2. Click Screening > Plate Acquisition Setup.
3. Click Configure > Plates.
4. Select the Plate name drop-down arrow to view the available plate 

type files.

Figure 3-14: Available plate type files

5. If there are a number of custom plate types available, then you are 
finished with this procedure.
OR
If there are no plate types listed except for the three defaults: 96 
Wells (8x12), 384 Wells (16x24), and Custom, continue with this 
procedure to load the preconfigured plate type files.

6. Insert the MetaXpress Software Installation USB flash drive into the 
computer.

7. When the MetaXpress Software installation screen appears, click 
Explore Installation Folders/Files. 
Windows Explorer opens showing the contents of the flash drive.

8. Open the Plates folder. 
This folder contains the preconfigured plate type files (.plt).

9. Copy the plate files that you want available to the Plates directory of 
your MetaXpress Software installation directory (by default, 
C:\MX6\Plates). These files will then appear in the Plate name filed in 
the Plates tab of the Plate Acquisition Setup dialog.

Note: The plate files will be read-only after they are copied off 
the flash drive. You must turn off the Read-only attribute of 
these files before you can use them in the MetaXpress Software 
application.
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10. Using Window Explorer, select all the plate files that you copied to the 
Plates directory (Shift + click to select multiple continuous items), right-
click the selected files, and select Properties. 
The Properties dialog appears. 

11. Under Attributes, uncheck Read-only, then click OK.

Confirming Laser Auto Focus Settings for Plate Files
Just before each site is acquired during plate acquisition, the laser 
autofocus system automatically moves the vertical (Z-axis) position of the 
objective to a point where the bottom of the well is in focus. Before using 
a plate file, confirm that the laser autofocus settings are optimal for the 
plate. You must prepare the plate that you are going to test by putting 
water or buffer similar to the buffer you will be using for real 
experiments in several of the wells.
Use the Laser Autofocus Wizard, available on the Plate tab, to confirm 
laser autofocus settings. The wizard walks you through the process. 
Additional information is available in the online help, in the topic 
“Configure Laser Autofocus Settings - Dialog Box Options.” 

Verifying Shading Correction Files
Shading correction files are needed for each objective and filter 
combination. They must be generated whenever an objective or filter is 
replaced, or added to the system, or whenever the lamp is replaced. For 
information on creating shading correction files, see Updating Shading 
Correction Settings on page 200. 
To use shading correction images during Plate Acquisition:

• Select Plate Acquisition Setup > Acquisition Loop > Perform 
shading correction.

Name shading correction images in the following format:

Note: The Laser Autofocus Wizard calculates measurements as 
accurately as possible. Some manual verification and adjustment of the 
settings may be necessary to optimize the results.

Note: If you are using an objective with a correction collar, ensure that 
the correction collar is set appropriately for the plate you are using. For 
information on configuring the correction collar, see Adjusting the 
Spherical-Aberration Correction Collar on ELWD Objectives on page 204.
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• shading_<magnification setting>_<wavelength>.tif
For example: shading_4x Plan Apo_DAPI.tif

By default, the MetaXpress Software application looks in the 
C:\Shading Images directory for shading correction images. To change 
the default image location:

1. Click Plate Acquisition Setup > Acquisition Loop > Directory.
2. Select a new location.

To ensure that properly named shading correction files exist for each 
objective and filter set combination, do the following:

1. Use Windows Explorer to navigate to the C:\Shading Images 
directory, or to another location if you have changed the default.

2. Locate the shading correction files. 
3. Ensure that the file names are formatted correctly and that a file exists 

for each objective and filter set combination.
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Preparing For Acquisition
This chapter provides plate acquisition guidelines to consider before 
acquiring experiment plate data. These guidelines help ensure that the 
images you acquire are the best possible quality. Review these guidelines 
before you define your plate acquisition experiment criteria.

Preparing to Acquire Fluorescence Images
When acquiring fluorescence images in a screening environment, follow 
a basic set of rules and guidelines to acquire quality images. As with any 
biological assays, the assay conditions need to be correctly evaluated to 
obtain a meaningful result. Include in your sample preparation both 
negative and positive controls so you can judge the validity of your assay. 
Molecular Devices recommends using a stain such as Hoechst or DAPI to 
stain your cells, since this stain can be used for focusing as well as 
segmentation for your analysis. 
Despite the image enhancement tools and options available to you in the 
MetaXpress® Software application, it is difficult to analyze a poor quality 
image. Starting with quality images helps ensure that your image data is 
more meaningful, and yields more information.
The following are the criteria to consider for attaining the highest 
possible fluorescence image quality:

• Choice of Fluoroprobes: Ensure that you use probes that provide 
good staining and an excitation/emission pattern suitable for the 
filter cubes you have chosen for your ImageXpress Micro System.

• Illumination: Check that your light source is functioning 
correctly. The basic design of the ImageXpress Micro System light 
source and light path within the imager help ensure that the light 
reaching your sample is the best possible quality. If you find that 
the light quality has become degraded, contact your system 
administrator or your Molecular Devices representative to 
correct the problem.

• Objective choice: The magnification setting will depend on the 
type of information you are interested in obtaining. In general, 
for counting cells, a 10x objective is suitable. For translocation, a 
10x or 20x objective is appropriate.

• Wavelength: Select the correct wavelength for your 
fluoroprobes. The Chroma website at www.chroma.com is a 
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good resource to help you determine the best filters to use with 
your stain of interest.

• Exposure: The correct exposure time is crucial for your 
acquisition and analysis. Clicking the Auto Expose button on the 
one of the Wavelength tabs in the Plate Acquisition Setup dialog 
provides you with a good starting point. Adjust the exposure 
time after that so the grayscale intensity within a cell is about 
three times the intensity of the background. In general, that 
means you can reduce your exposure time, which decreases your 
acquisition time.

Evaluating your Experiment Requirements
Nearly all settings for plate acquisition are made in the Plate Acquisition 
Setup dialog. The settings that you choose are dependent on the content 
and distribution of your samples, as well as the requirements of your 
experiment. To help you determine what your settings should be, a brief 
checklist is included in this chapter.
Experiment requirements that you should consider include the following:

• What is the nature of your sample material? Is it very dense or 
thin? Dense sample material requires more light and might mean 
that the Z-setting for focus will vary from sample to sample. If 
your sample is very dense, you might need to choose the Low 
Signal algorithm on the Auto Focus tab. If the focal plane varies 
greatly from well to well, you should set up a focus configuration 
to compensate for this.

• Which stains and filter cubes will you use for your samples? Your 
ImageXpress® Micro System uses standard filter cubes to create 
the correct excitation wavelength and the corresponding 
emission wavelength filtration for your experiment. It also uses 
dichroic filtration to separate the excitation wavelength from the 
emission wavelength. Specific filter cubes are designed to be 
used with specific stains. It is important that your filter cubes are 
a correct match for your stains. 

• How many wells are in each plate? For each experiment, you 
must specify the number of wells in the plates that you are using. 
You must use the same type of plate consistently throughout the 
experiment, and you must be sure that the plate dimensions are 
correctly specified. Molecular Devices recommends that for any 
given experiment, you use only one brand of plate from a single 
manufacturer. Mixing various plate types from different 
manufacturers could introduce unknown variables and 
contribute to creating flawed data.
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• Which wells need to be imaged? You can acquire images from 
any or all wells in a plate. The Plate tab on the Plate Acquisition 
Setup dialog enables you to choose the specific wells from which 
you want to acquire images. However, you must apply this well 
selection to all plates in the experiment.

• Will you acquire multiple sites per well? Using multiple sites in a 
single well enables you to acquire images from a greater area of 
the well. If you select the Single Sites option on the Sites to Visit 
tab, an image will be acquired for only a single site located in the 
center of the well. The multiple sites option enables the 
MetaXpress Software application to acquire separate images of 
contiguous areas.
Using the stitch command, you can assemble the smaller 
separate images into a single large image. This capability enables 
you retain or improve image resolution while increasing the 
image area of coverage. Unless you use a journal to change 
settings during the experiment, the sites you select are used 
during the entire experiment. 
Sites can also be used to include specific areas of the wells in 
your experiment data, while at the same time excluding other 
areas of the well.

• Will you use a standard MetaXpress Application Module to 
analyze your data? You need to base your acquisition settings on 
the requirements of the application module used. The most 
important requirements are to prepare your samples correctly 
and to ensure that you use the appropriate filter set for each 
stain that you have applied.

Conditions that Interfere with Obtaining Quality Images
The following conditions or situations can interfere with obtaining the 
highest quality images:

• Optics have been degraded by dust, dirt, fingerprints, or oil 
contamination: If you detect any contamination on your 
objectives, you should inform your system administrator, who 
can take steps to clean the optics and correct the problem.

• Uneven background: The first step to correct an uneven 
background is to check for uneven illumination. If the 
illumination is uneven during fluorescence acquisition, contact 
your system administrator. 

• Uneven illumination: Your ImageXpress Micro System is 
designed to provide high quality, evenly distributed illumination 
across the image field. If you observe that the light across your 
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field is uneven, contact your system administrator or Molecular 
Devices representative.

• Poor quality microplates: Not all microplates are the same 
quality. The composition of the material of the bottom of the 
microplate needs to be of optical quality, or the images can be 
degraded. For fluorescence imaging, microplates with black well 
sides usually work the best. Plastic bottom plates are usually 
more uneven and distort light more than glass bottom plates.

• Incorrect microplates: Some experiments call for black, opaque 
microplates instead of clear ones. To additionally improve 
quality, you can use black opaque covers on your microplates. 
Also, if you are screening multiple plates, be sure that all plates 
are the same type from the same manufacturer. Well spacing can 
vary slightly from one manufacturer to another, and it is not 
possible to continuously change the settings for well spacing.

• For laser autofocus, bottom of plate has dust, dirt, fingerprints, 
or oil contamination: Since the laser measures the reflection 
from the bottom of the plate or from within the sample, 
interferences with reflection caused by dust particles, dirt, 
fingerprints, and scratches will affect the performance of the 
autofocus. To improve the autofocus, it is suggested that you 
clean the bottom of the plate using lens tissue and an optical 
cleaning solution. 

Additional Guidelines

Magnification
Magnification selection depends on the measurements needed. If you 
are interested in the total number of cells present, a 10x objective might 
be adequate. But if you are interested in co-localization of two probes, a 
higher magnification might be needed. Counting or localizing small 
organelles might require objectives above 40x. 

Exposure Time
The ratio between the Signal (intensity of the interested objects) and the 
Noise (the background and other forms of noise) (S/N) determines how 
hard it will be for the software to discriminate important features in an 
image. If this ratio is relatively small, it is more difficult to discriminate 
between objects and background. One method of increasing S/N is to 
increase the image exposure. Longer exposures provide higher signal in 
an image and, depending upon the sources of the noise, might not 
increase the noise to the same degree.
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Conversely, longer exposures can cause photo bleaching damage and 
saturate the camera. Intensity measurements of an overexposed image 
are not accurate and these images should be avoided. One exception to 
this rule is when you are interested in extremely faint features of your 
sample that are otherwise not visible. A good example of this is 
overexposure of a Neurite image where you are not interested in the 
bright cell body but you are interested in the weakly stained outgrowths.

Binning
Another method of increasing the S/N is to bin the pixels from the 
camera. Binning combines the electrons from adjacent pixels to create 
the effect of a single, larger pixel. Binning increases the S/N at the 
expense of decreased resolution. Binning is often used to decrease the 
exposure time dramatically while maintaining the same S/N. Another 
positive feature of binning is that it produces smaller images that require 
less storage space.

Objective Choice
The choice of objective determines the magnification of the image, the 
depth of field of the image, and the brightness of the image. Another 
attribute of the objective is its numerical aperture (NA). With the 
magnification constant, brightness is proportional to NA4. Higher NA 
objectives also produce a sharper picture due to a narrower depth of 
field; this might or might not be an advantage if some of your objects are 
in different Z positions. Unfortunately, higher NA objectives, such as a 
SuperFluor 20x, cannot reach the outer rows and columns of some 
multiwell plates (such as a 384-well plate) because of the of the plate 
skirt height.

Use of Different Fluorochromes
Individual fluorochromes have unique characteristics that help 
determine their best use. Some fluorochromes provide brighter 
intensities and require shorter exposure time, while others do not bleach 
as quickly and enable a longer exposure time. There also might be 
toxicity issues with some cell types or bleed through issues between 
pairs of fluorochromes. These factors should be considered when 
choosing a fluorochrome. 

Shading
Shading is an artifact that can come from the objective, damaged optics, 
misalignment of the light source, or background light from the room. 
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Shading should be addressed in the hardware first and if this fails, by 
using the available shading correction within the software.

Plate Choice
There are numerous types of multiwell plates available from a variety of 
vendors. Molecular Devices recommends determining what plates to use 
for your screening experiments based on the following guidelines:

• Compatibility: Verify that your cells are compatible with the 
plate material. Given the wrong surface, some cells might not 
bind and will act in an unusual manner, such as rounding up, or 
migrating to the edges of the well. If you are using 
immunohistochemistry you might require a much higher 
background staining in plastic as compared to glass.

• Fluorescence background: There is a large difference in auto 
fluorescence between glass and plastic. Also, there can be up to 
a 5X difference in auto fluorescence among plates from different 
manufacturers. If your signal is low, switching plate brands is a 
good troubleshooting tool.

• Plate skirt height: You should use a plate with a small skirt height 
(the height difference between the edge of the plate and the 
bottom surface of the wells) if you are using a high magnification 
or SuperFluor objective. If the skirt height is too high, you might 
not be able to image the outermost parts of a plate (the 
outermost rows and columns on a 384 well plate or some sites 
on the outermost rows and columns on a 96-well plate).

• High magnification image clarity: When using high 
magnifications, there are significant differences in clarity 
between standard plastic plates, optically clear plastic plates, 
and glass bottom plates.

• Plate flatness or reproducibility of the Z pattern: A truly flat 
plate is faster to scan than an uneven plate because the search 
range can be made smaller. The reproducibility of a plate allows 
you to set tighter focus ranges specifically for that plate type. 
This reduces the amount of focusing needed and speeds up 
acquisition. The major component in plate flatness is the 
variation from a well to a neighboring well.

• Outside edge of the plate: If you use a plate handling robot, 
some types of plates do not work well with the fingers supplied 
with the robot and will require custom fingers to work correctly. 
If one or more plate types do not work with your robot grippers, 
contact Molecular Devices for assistance.
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Correction Collars
If you are using an objective with a correction collar, ensure that the 
correction collar is set appropriately for the plate you are using. For 
information on configuring the correction collar, see Adjusting the 
Spherical-Aberration Correction Collar on ELWD Objectives on page 204.
5015321 C 65 



ImageXpress Micro Widefield High Content Screening System User Guide
66 5015321 C 



5
Setting Up Plate Acquisition
Before configuring an experiment, it is important to become familiar with 
the configuration tools that you use in the MetaXpress® Software. The 
foundation of the MetaXpress Software is the MetaMorph® Microscopy 
Automation and Image Acquisition Software. The MetaMorph Software 
contains numerous dialogs for image acquisition, processing, and 
acquisition. The MetaXpress Software adds database integration and 
tools for controlling the ImageXpress® Micro imaging systems and 
acquiring and analyzing microplates. This chapter explains the Plate 
Acquisition Setup dialog, which is the dialog that is used to configure a 
screening experiment.

Note: For information about the various dialogs (Plate Acquisition, 
Plate Acquisition Setup, and Plate Acquisition and Control) that are 
that are used to acquire plate data, see Chapter 6: Acquiring Plates on 
page 143.
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Accessing the Plate Acquisition Setup Dialog
The MetaXpress Software main menu includes the Screening menu, 
which is used specifically in the MetaXpress Software for protocol 
configuration, image acquisition and acquisition. The Screening menu 
provides access to all plate configuration and acquisition-specific dialogs, 
including the Plate Acquisition Setup dialog. Figure 5-1 and Figure 5-2 
show the options that are available from the Screening menu.

Figure 5-1: Default Screening menu

Figure 5-2: Simplified Screening Menu
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Plate Acquisition Setup Dialog Layout
The Plate Acquisition Setup dialog provides three primary functions.

• Plate Navigation that provides manual control of some of the 
movable physical components of the ImageXpress® Micro imager

• Configuration Control on the Configure tab for configuring plate 
acquisition protocols

• Acquisition Control on the Run tab for carrying out a plate 
acquisition according to a selected protocol

Figure 5-3: Plate Acquisition Setup dialog
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The dialog has the following layout.
• Protocol: A drop-down list of the eight most recently used plate 

acquisition protocols.
• Load Protocol button: Opens the Load Plate Acquisition 

Protocol dialog in which you select a protocol for plate 
acquisition. 

• Eject Plate/Load Plate button: Toggles between these two 
options. Eject Plate opens the sample door for loading or 
removing a plate. Load Plate closes the sample door so that the 
plate can be acquired. 

• Plate map: The top left graphic. A graphical representation of the 
type of plate for which you are configuring the wells. The graphic 
is interactive to provide manual control for moving a stage to a 
specific well. When the Plate Acquisition Setup opens the first 
time before any protocols are configured and loaded, all the 
wells in the Plate map are a bright green, which indicates that 
they are all turned on and that data will be acquired for all of 
them. You use this interactive graphic to configure only those 
wells for which data is to be acquired. 

Note: Beginning with Version 6.0 of the MetaXpress Software, 
the Plate map and Site map navigation functions that were 
previously available only from the Plate Acquisition and Control 
dialog are now also available from the Plate Acquisition Setup 
dialog. You can continue to use the Plate Acquisition and 
Control dialog, but for efficiency and convenience, you can just 
use the single Plate Acquisition Setup dialog.
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Figure 5-4: Plate Acquisition Setup dialog, Plate map 

• Site map: The top right graphic. A graphical representation of the 
number of sites in each well and the position of the sites that are 
to be acquired for each well. The graphic is interactive to provide 
manual control for some of the movable physical components of 
the ImageXpress® Micro imager, including moving the focus. You 
use this interactive graphic to configure the sites that are to be 
acquired.

Figure 5-5: Plate Acquisition Setup dialog, Site map

• Active Wavelength field: Displays the currently selected 
acquisition wavelength.
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• Active Wavelength tools: Provide shortcuts to various functions 
that can be carried out for the currently selected acquisition 
wavelength. 

Figure 5-6: Active Wavelength tools

• Configure tab: Provides the necessary options for configuring a 
plate acquisition protocol. The Configure tab is organized in a 
“top-to-bottom” tab structure that runs down the left side of the 
dialog that is designed to guide you through the process of 
setting up your protocol configuration in a logical order. Each tab 
is dedicated to a specific type of function or setting. The tabs are 
dynamically updated according to the options that you have 
selected and the number of wavelengths that you are acquiring. 
See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 

Tab on page 82.
 Plate Acquisition Setup Dialog: Configure Tab, Acquisition 

Tab on page 99.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136
• Run tab: Provides the necessary options for acquiring a plate 

according to a selected protocol.

Note: There are a few applicable use cases for the Active 
Wavelength tools when configuring a plate acquisition protocol 
and these are discussed where appropriate in this chapter; 
however, you use these tools primarily when acquiring plate 
data. As a result, these tools are discussed in detail in Chapter 6: 
Acquiring Plates on page 143.
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• Save Protocol button: Opens the Save Acquisition Setting dialog 
in which you can save the current plate acquisition settings as a 
protocol. See Saving a Plate Acquisition Protocol on page 141.

Figure 5-7: Save Acquisition Setting dialog

• Summary button: Opens the Summary panel, which displays a 
summary of all the current acquisition settings. See Summary 
Panel on page 140.

• Close button: Closes the Plate Acquisition Setup dialog. If you 
made changes to the configuration settings for the loaded 
protocol, then a message opens asking if you want to save the 
current configuration before closing.

Note: This chapter details the Configuration Control functions 
on the Configure tab. For detailed information about the Plate 
Navigation function and the Acquisition Control functions that 
are available on the Run tab, see Chapter 6: Acquiring Plates on 
page 143.

Note: When you are configuring a protocol on the Plate 
Acquisition Setup dialog, red or yellow Warning icons might be 
displayed. A yellow icon can mean that an optional field is not 
filled in or could indicate another minor error. A red icon means 
that a required field is either not filled in or contains invalid data 
that must be changed. Figure 5-8 shows the dialog with several 
Warning icons.
5015321 C 73 



ImageXpress Micro Widefield High Content Screening System User Guide
Figure 5-8: Plate Acquisition Setup dialog with Warning icons

Plate Acquisition Setup Dialog: Configure Tab, Objective and Camera 
Tab

You set the camera binning and gain as well as the magnification setting 
for a protocol the Objective and Camera tab. Based on these settings, 
you can improve either the image acquisition speed or the image quality. 

Figure 5-9: Plate Acquisition Setup dialog: Configure tab, 
Objective and Camera tab
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Table 5-1: Plate tab configuration options 

Option Description

Magnification Selects the magnification setting for the protocol. 
Magnification settings assign X and Y offset values 
(parcentricity) and a Z offset (parfocality) to a specific 
objective. When you select a specific objective, the system 
is physically moved to this objective position.

Note: The available magnifications are created with the 
Configure Magnification dialog. See Verifying and 
Backing Up Magnification Settings on page 46. You must 
assign a calibration to each magnification setting. See 
Verifying and Backing Up Calibration Settings on page 49.

Camera binning Specifies the binning value that is to be applied to the 
camera. Binning combines the output of adjacent pixels in 
square multiples. For example, a camera binning value of 1 
is only one pixel, a binning value of 2 combines 2x2 or four 
pixels in a square, a binning value of 3 combines 3x3 or 
nine pixels in a square, and so on. This reduces the image 
file size and resolution, but increases signal-to-noise ratio.

Note: If sufficient light is available, lower camera binning 
increases the image resolution, but higher binning 
improves the signal-to-noise ratio. Higher binning also 
improves speed.

Camera gain Specifies the amplification that is to be applied to the 
camera output.

Note: Some cameras that are offered with the 
ImageXpress® Micro system do not have adjustable gain.
5015321 C 75 



ImageXpress Micro Widefield High Content Screening System User Guide
To configure Objective and Camera options

1. Open the Objective and Camera tab.
2. Select the magnification setting for the protocol to move the 

selected objective into position.
3. Specify the binning value that is to be applied to the camera.
4. If applicable, select the amount of gain.

5. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 

Tab on page 82.
 Plate Acquisition Setup Dialog: Configure Tab, Acquisition 

Tab on page 99.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

Plate Acquisition Setup dialog: Configure Tab, Plate Tab
You configure the plate dimensions that are necessary to correctly 
control the X, Y, and Z movements of the ImageXpress Micro System on 
the Plate tab. Correct entry of the plate dimensions ensures that the 
imager does not make any movements that might create a potentially 
hazardous situation. The dimensional information that you define for the 
plate also ensures that the laser-based autofocusing is as accurate as 
possible.

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.

Note: The resulting pixel size (image calibration) is updated 
based on the current magnification and binning settings.
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Figure 5-10: Plate Acquisition Setup dialog: Configure tab, Plate 
tab

Note: The MetaXpress Software installation USB memory stick comes 
with a variety of common plate types already configured. Check the 
Plates folder of the MetaXpress Software CD for plate files. To use these 
plate files in the MetaXpress Software, you must copy them from the 
Plates folder on the memory stick into the Plates directory of your 
MetaXpress Software installation (the default plates directory is 
C:\MX#\Plates). After copying the plate files, make sure that the file 
properties are "writeable" and not read-only. These plate types are then 
be available from the Plate name drop-down list on the Plate tab. When 
you select a pre-configured plate type, the default values for the plate 
dimensions are displayed in the appropriate fields on the tab. After you 
have added a given plate type to C:\MX#\Plates, you must run the Laser 
Autofocus Wizard to define the laser settings for the plate type.
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Table 5-2: Plate tab configuration options 

Option Description

Plate name Specifies the plate type that you are using for the protocol. 
You can select an existing configuration, or you can create 
a new custom plate configuration. The tab fields are 
automatically populated with values according to the plate 
type that you select. If your plate type is not available on 
the Plate name list, then you must manually type the 
manufacturer’s plate specifications for these values. 

Note: The manufacturer generally cannot provide values 
for the Plate Bottom settings, including Optical thickness 
(which is not the same as plate thickness) and the Bottom 
variation. You must run the Laser Autofocus Wizard to 
measure these values on the instrument to ensure proper 
focusing. See Plate Dimensions Considerations on 
page 80.

Save 
Configuration

Opens the Save Configuration dialog, which you can use 
to name and save a a new custom plate configuration 
based on the currently displayed plate type values.

Number of rows Indicates the number of rows for the selected plate type. 

Number of 
columns

Indicates the number of columns for the selected plate 
type. 

Well shape Indicates the shape of the well on the plate: either Circle 
or Square.

Well diameter Specifies the diameter of the well in μm. 

Note: The wells for many plate types have a slight conical 
shape. If you are creating a new custom plate 
configuration, then you must provide the diameter of the 
bottom of the well, not the top.

Column spacing Specifies the spacing in μm between each well on the X 
axis. 

Note: Generally, this value should be the same for both 
the X and Y axis; however, if you are creating a new 
custom plate configuration, you can specify different 
values if needed. 
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Plate length Specifies the plate length in mm. The ANSI standard is 
127.8 mm.

Column offset Specifies the distance in μm between the center of well 
A01 and the left edge of the plate. 

Row Spacing Specifies the spacing in μm between each well on the Y 
axis. 

Note: Generally, this value should be the same for both 
the X and Y axis; however, if you are creating a new 
custom plate configuration, you can specify different 
values if needed. 

Plate width Specifies the plate width in mm. The ANSI standard is 85.5 
mm.

Row offset Specifies the distance in μm between the center of well 
A01 and the top edge of the plate. 

Well depth Specifies the well depth in μm. 

Note: The correct Well depth value is required for 
autofocusing and fluidics events.

Plate height Specifies the plate height in mm.

Note: The correct Plate height value is required for 
autofocusing and fluidics events.

Edit Plate Bottom 
Settings

Opens the Configure Plate Bottom Settings dialog, which 
you can use to adjust plate bottom settings. 

CAUTION! This dialog is intended primarily for 
informational and diagnostic purposes, and only 
advanced users should use this feature to adjust 
plate bottom settings. If you adjust plate bottom 
settings incorrectly, you might damage the objective 
or plate. Molecular Devices strongly recommends 
that you use the Laser Autofocus Wizard instead to 
calculate the plate bottom measurements.

Table 5-2: Plate tab configuration options (cont’d)

Option Description
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Plate Dimensions Considerations
Even if you use an existing plate type configuration, Molecular Devices 
recommends that you use the Laser Autofocus Wizard to verify the 
accuracy of the Bottom thickness and four different variation 
measurements for your plates, where:

• Bottom thickness is a value in μm that is the average thickness 
for the well bottom. 

• The four different measurements are the following.
 Bottom thickness max variation
 Adjacent well max variation
 Intra-well max variation
 Plate max variation

Although plate manufacturers generally provide reliable plate and well 
dimensions, you must calculate the plate bottom measurements, such as 
average thickness and maximum variation in thickness of the entire 
plate. These parameters are critical and can vary from lot to lot. Also, 
plate manufacturers can change plate parameters without changing 
plate names. The Laser Autofocus Wizard walks you through steps to 
automatically calculate plate bottom dimensions as well as the exposure 
times that are required for each objective.

Laser Autofocus 
Wizard

Opens the Laser Autofocus Wizard, which guides you step 
by step through the process of automatically calculating 
plate bottom dimensions and the exposure times that are 
required for each objective. 

Table 5-2: Plate tab configuration options (cont’d)

Option Description

Note: All plate bottom thickness values (also known as reduced 
thickness measurements) are optical thickness as measured using the 
objective. The values are not the physical thickness measurements that 
the manufacturer provides. The optical thickness is the physical 
thickness of the plate bottom divided by the refractive index of the 
material.
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CAUTION! You must not use the Laser Autofocus Wizard for slides as it 
calculates incorrect settings for slides. If you need assistance with slides, 
contact Technical Support. See Obtaining Support on page 34. 

To configure the dimensions for a new custom plate 
configuration
If your custom plate is 96-well or 384-well format, then you can select 
the appropriate template, and modify any values as needed. If your 
custom plate is any other size, then you must specify all the values for 
the plate.

1. Choose the appropriate size for your custom plate.
2. Click Save Configuration.
3. In the Plate Acquisition - Save Configuration dialog, type the name for 

your custom plate configuration, and then click Save.
4. In the Well shape field, select the well shape for the plate.
5. Complete the remaining configuration fields as required. See 

Table 5-2 on page 78.

CAUTION! You must enter the Well depth and Plate height values and all 
other plate dimensions correctly before you run the Laser Autofocus 
Wizard, or the wizard will more than likely fail

Note: The Laser Autofocus Wizard calculates measurements as 
accurately as possible. Some manual verification and adjustment of the 
settings might be necessary to optimize the results, particularly for 
thin-bottom plates. The MetaXpress Software online help topic 
“Configure Laser Autofocus Settings - Dialog Box Options” provides 
detailed information about the settings that the wizard calculates. Press 
F1 with the dialog open to access the help. Contact Technical Support if 
you need additional assistance. See Obtaining Support on page 34.

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.
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6. Click Laser Autofocus Wizard and follow the steps that the 
wizard provides to calculate plate bottom measurements.

7. If required, in the Well depth and Plate height fields, edit the 
values.

8. Click Save Configuration.
9. In the Plate Acquisition - Save Configuration dialog, click Save, and 

then in the Plate Acquisition message dialog, click Yes at the prompt to 
overwrite the existing custom plate type.

10. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 

Tab on page 82.
 Plate Acquisition Setup Dialog: Configure Tab, Acquisition 

Tab on page 99.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit Tab
You configure the number of sites that are to be acquired for each well in 
a plate acquisition protocol on the Sites to Visit tab. You can acquire a 
single site per well, or multiple sites per well. The number of sites that 
you can acquire in a well depends on the size of the well, the objective 
magnification, the distribution of sample material in the well, the type of 
plate, and the fluid content of the well.
The dialog tab is dynamically updated with the appropriate configuration 
options based on the site option that you select. The Site map, which is a 
graphical representation of the sites that you are configuring, is 
dynamically updated based on the configuration options that you select 
and the values that you specify for these options. See:

Note: If needed, adjust any objectives with correction collars to 
match the plate type.
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• To acquire a single site in each well on page 83.
• To acquire a fixed number of sites in each well on page 85.
• To configure adaptive acquisition for well sites on page 89.
• To configure a multi-well acquisition on page 96.

To acquire a single site in each well
The Single site option acquires a single site that is centered in each well.

Figure 5-11: Plate Acquisition Setup dialog: Configure tab, Sites 
to Visit tab, Single site option selected

Note: You use the Plate map and Site map that are at the top of the 
Plate Acquisition Setup dialog to select and move to the wells and sites 
that are to be analyzed in a plate acquisition protocol. This topic and all 
other plate navigation dialogs are covered in detail in Chapter 6: 
Acquiring Plates on page 143. 

Note: To acquire a single off-center site, you should select Fixed number 
of sites, configure the site layout, and then deselect the unwanted sites. 
See To acquire a fixed number of sites in each well on page 85.
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1. Open the Sites to Visit tab.
2. Select Single site.
3. Optionally, to specify a percentage of the width (X) and height (Y) 

of the camera's field of view to acquire, select Custom Field of 
View, and then type the new X and Y values.

4. If data is not going to be acquired for all the wells in a plate, then on the 
Plate map, do any of the following as needed to configure the wells for 
which data is to be acquired.

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.

Note: The full field of view for the camera is 100 percent (100% 
in the X field and 100% in the Y field). So, for example, if the full 
field of view width is 1000, to acquire a width of 500, you would 
type 50 in the X field and 50 in the Y field. This feature is 
particularly useful if the image that is acquired using the full field 
of view is not evenly illuminated or if the image that is acquired 
includes the area outside the well boundary. By reducing the 
field of view, you can acquire an image of only the properly 
illuminated area or of only the area within the well.

Note: If a shading correction image was acquired with the full 
field of view, then you can use the Custom Field of View feature 
with shading correction. See To carry out shading correction on 
acquired images on page 134.
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 To turn off a well, click it. The well turns light gray, which 
indicates that data will not be acquired for the well. To turn it 
back on, click the well again. The well turns light green again.

 To turn off all the wells in the column in a single step, click 
the column header. To turn all the wells back on, click the 
column header again.

 To turn all the wells in a row off in a single step, click the row 
ID. To turn all the wells back on, click the row ID again.

 To turn off a contiguous group of wells in a single step, click 
and hold the left mouse button, and then drag the cursor 
across the appropriate wells. To turn the wells back on, click 
and hold the left mouse button, and then drag the cursor 
across the wells again.

 To turn on or off all wells in a plate in a single step, click in 
the upper left corner of the plate just to the outside of the 
first well, A01, on the plate.

5. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Acquisition 

Tab on page 99.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

To acquire a fixed number of sites in each well

Note: You can configure the wells for which data is to be 
acquired as part of a protocol, or you can select the wells “on 
the fly” at the time that you run the protocol. See Chapter 6: 
Acquiring Plates on page 143.

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.
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1. Open the Sites to Visit tab.
2. Select Fixed number of sites.

Figure 5-12: Plate Acquisition Setup dialog: Configure tab, Sites 
to Visit tab, Fixed number of sites option selected

3. Optionally, to specify a percentage of the width (X) and height (Y) 
of the camera's field of view to acquire, select Custom Field of 
View, and then type the new X and Y values.

Note: The full field of view for the camera is 100 percent (100% 
in the X field and 100% in the Y field). So, for example, if the full 
field of view width is 1000, to acquire a width of 500, you would 
type 50 in the X field and 50 in the Y field. This feature is 
particularly useful if the image that is acquired using the full field 
of view is not evenly illuminated or if the image that is acquired 
includes the area outside the well boundary. By reducing the 
field of view, you can acquire an image of only the properly 
illuminated area or of only the area within the well

Note: If a shading correction image was acquired with the full 
field of view, then you can use the Custom Field of View feature 
with shading correction. See To carry out shading correction on 
acquired images on page 134.
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4. In the Columns and Rows fields, specify the maximum number 
of sites that are to be visited. For example, specify 2 columns and 
2 rows, which are the default values, to acquire up to four sites, 
specify 3 columns and 3 rows to acquire up to nine sites, and so 
on. 

5. If data is not going to be acquired for all the wells in a plate, then on the 
Plate map, do any of the following as needed to configure the wells for 
which data is to be acquired.
 To turn off a well, click it. The well turns light gray, which 

indicates that data will not be acquired for the well. To turn it 
back on, click the well again. The well turns light green again.

 To turn off all the wells in the column in a single step, click 
the column header. To turn all the wells back on, click the 
column header again.

 To turn all the wells in a row off in a single step, click the row 
ID. To turn all the wells back on, click the row ID again.

 To turn off a contiguous group of wells in a single step, click 
and hold the left mouse button, and then drag the cursor 
across the appropriate wells. To turn the wells back on, click 
and hold the left mouse button, and then drag the cursor 
across the wells again.

 To turn on or off all wells in a plate in a single step, click in 
the upper left corner of the plate just to the outside of the 
first well, A01, on the plate.

6. If data is not going to be acquired for all the sites in a well, then on the 
Site map, do any of the following as needed to configure the sites for 
which data is to be acquired.

Note: The maximum number of columns and rows that can be 
configured is 45 × 35.

Note:  You can configure the wells for which data is to be 
acquired as part of a protocol, or you can select the wells “on 
the fly” at the time that you run the protocol. See Chapter 6: 
Acquiring Plates on page 143.
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 To turn a site off, click it. The site turns gray, which indicates 
that data will not be acquired for the site. To turn the site 
back on, click the site again. The site turns bright green 
again.

 To turn off a contiguous group of sites in a single step, click 
and hold the left mouse button, and then drag the cursor 
across the appropriate sites. To turn the sites back on, click 
and hold the left mouse button, and then drag the cursor 
across the sites again.

7. Optionally, do one of the following as needed.
 To manually adjust the spacing between adjacent sites, 

where the default value is zero, or no spacing, type the X and 
Y values for the spacing in the Spacing (μm) fields.

 To manually adjust the spacing between adjacent sites so 
that the sites overlap, type negative X and Y values for the 
spacing in the Spacing (μm) fields.

 To automatically adjust the spacing between adjacent sites 
so that there is zero spacing between them, click Tile Sites. 
The X and Y spacing values are set to zero.

 To automatically adjust the spacing between the adjacent 
sites to the maximum allowed value based on the selected 
plate type, click Fit sites to well. The X and Y spacing values 
are updated accordingly.

 To automatically overlap the sites by 10%, click Overlap Sites 
10%. The X and Y spacing values are updated to the 

Note: The site controls apply to all sites in all wells at the same 
time. When you turn on or off sites for a selected well, then all 
wells in the plate will have data acquired for the same sites. 

Note: You can configure the sites in a well for which data is to be 
acquired as part of a protocol, or you can select the sites “on the 
fly” at the time that you run the protocol. See Chapter 6: 
Acquiring Plates on page 143.

Note: The camera size limits these values, and therefore, the 
amount of overlapping that you can specify.
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appropriate negative values based on the selected plate 
type.

8. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Acquisition 

Tab on page 99.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

To configure adaptive acquisition for well sites
The Adaptive Acquisition™ option is a computational algorithm that is 
designed to analyze cell number on the fly during sample acquisition to 
increase the chances of collecting valid data in every well. If this option is 
selected, then the number of sites that are acquired per well is based on 
the number of cells per well. 

1. Open the Sites to Visit tab.
2. Select Adaptive Acquisition.

Note: The Adaptive Acquisition option can significantly reduce 
acquisition time for multi-wavelength acquisition that requires a 
minimum number of cells per well or for samples with differing 
conditions across the plate.

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.
5015321 C 89 



ImageXpress Micro Widefield High Content Screening System User Guide
Figure 5-13: Plate Acquisition Setup dialog: Configure tab, Sites 
to Visit tab, Adaptive Acquisition option selected

3. Optionally, to specify a percentage of the width (X) and height (Y) 
of the camera's field of view to acquire, select Custom Field of 
View, and then type the new X and Y values.

4. In the Columns and Rows fields, specify the maximum number 
of sites that are to be visited. For example, specify 2 columns and 

Note: The full field of view for the camera is 100 percent (100% 
in the X field and 100% in the Y field). So, for example, if the full 
field of view width is 1000, to acquire a width of 500, you would 
type 50 in the X field and 50 in the Y field. This feature is 
particularly useful if the image that is acquired using the full field 
of view is not evenly illuminated or if the image that is acquired 
includes the area outside the well boundary. By reducing the 
field of view, you can acquire an image of only the properly 
illuminated area or of only the area within the well.

Note: If a shading correction image was acquired with the full 
field of view, then you can use the Custom Field of View feature 
with shading correction. See To carry out shading correction on 
acquired images on page 134.
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2 rows, which are the default values, to acquire up to four sites, 
specify 3 columns and 3 rows to acquire up to nine sites, and so 
on. 

5. If data is not going to be acquired for all the wells in a plate, then on the 
Plate map, do any of the following as needed to configure the wells for 
which data is to be acquired.
 To turn off a well, click it. The well turns light gray, which 

indicates that data will not be acquired for the well. To turn it 
back on, click the well again. The well turns light green again.

 To turn off all the wells in the column in a single step, click 
the column header. To turn all the wells back on, click the 
column header again.

 To turn all the wells in a row off in a single step, click the row 
ID. To turn all the wells back on, click the row ID again.

 To turn off a contiguous group of wells in a single step, click 
and hold the left mouse button, and then drag the cursor 
across the appropriate wells. To turn the wells back on, click 
and hold the left mouse button, and then drag the cursor 
across the wells again.

 To turn on or off all wells in a plate in a single step, click in 
the upper left corner of the plate just to the outside of the 
first well, A01, on the plate.

6. If data is not going to be acquired for all the sites in a well, then on the 
Site map, do any of the following as needed to configure the sites for 
which data is to be acquired.

Note: The maximum number of columns and rows that can be 
configured is 45 × 35. 

Note: You can configure the wells for which data is to be 
acquired as part of a protocol, or you can select the wells “on 
the fly” at the time that you run the protocol. See Chapter 6: 
Acquiring Plates on page 143.
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 To turn a site off, click it. The site turns gray, which indicates 
that data will not be acquired for the site. To turn the site 
back on, click the site again. The site turns bright green 
again.

 To turn off a contiguous group of sites in a single step, click 
and hold the left mouse button, and then drag the cursor 
across the appropriate sites. To turn the sites back on, click 
and hold the left mouse button, and then drag the cursor 
across the sites again.

7. Optionally, do one of the following as needed.
 To manually adjust the spacing between adjacent sites, 

where the default value is zero, or no spacing, type the X and 
Y values for the spacing in the Spacing (μm) fields.

 To manually adjust the spacing between adjacent sites so 
that the sites overlap, type negative X and Y values for the 
spacing in the Spacing (μm) fields.

 To automatically adjust the spacing between adjacent sites 
so that there is zero spacing between them, click Tile Sites. 
The X and Y spacing values are set to zero.

 To automatically adjust the spacing between the adjacent 
sites to the maximum allowed value based on the selected 
plate type, click Fit sites to well. The X and Y spacing values 
are updated accordingly.

Note: You can configure the sites in a well for which data is to 
be acquired as part of a protocol, or you can select the sites “on 
the fly” at the time that you run the protocol. See Chapter 6: 
Acquiring Plates on page 143.

Note: Overlapping sites is not recommended for use with 
Adaptive Acquisition because it might result in some cells being 
counted more than once.
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8. Specify the Adaptive Acquisition settings.

Table 5-3: Adaptive Acquisition options 

Option Description

Minimum sites to 
visit

The minimum number of sites to visit in a well. The 
MetaXpress Software acquires at least this minimum 
number of sites and then it continues to acquire sites until 
the total number of cells counted per well value as 
specified in the Cell count per well field is reached.

Wavelength The wavelength that is used to differentiate nuclei in the 
source image. 

Note: This wavelength must be the same as the 
wavelength that is designated as being the first to be 
acquired. See To configure the acquisition wavelengths 
on page 108.

Approximate 
width

The approximate minimum width and the approximate 
maximum width of the nuclei that are expected to be 
detected. 

Note: Nuclei patterns in the source image that fall below 
this range are considered as noise. The algorithm might 
split larger objects that are above the maximum width 
into smaller objects, which can affect the cell count.

Intensity above 
local background 
gray levels

The intensity threshold of nuclei in the source image 
compared to the neighboring background values. This 
setting controls the sensitivity of detection. 

Note: For information about setting the intensity 
threshold, see To calculate the Intensity Above Local 
Background gray level value on page 96.

Note: The Approximate width and Intensity above local background gray 
levels work in conjunction – that is, how big must an object be and how much 
greater must its intensity be above the background to be considered a 
nucleus?
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9. Optionally, to determine if your current acquisition settings are 
appropriate for differentiating nuclei, select a well or wells and a 
site or sites for viewing, click Focus to bring the sample into 
focus, and then click Test Segmentation.

CAUTION! Focus carries out a large range autofocus on the 
currently selected well and site. To ensure that your cell counting 
settings are accurate, you must bring the sample into focus 
before you can click Test Segmentation.

Cell count per well The total number of nuclei in each well that the 
MetaXpress Software must acquire before stopping 
acquisition of the well. 

Note: The MetaXpress Software always acquires the 
minimum number of sites, even if the Cell count per well 
can be obtained with a fewer number of sites. As the 
Adaptive Acquisition mode runs, a real-time count of the 
cells in the currently selected well is displayed as the 
images are acquired. Adaptive Acquisition stops 
acquiring when the maximum number of sites that have 
been defined is reached, even if the specified cell count is 
not attained.

Table 5-3: Adaptive Acquisition options (cont’d)

Option Description
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After you click Test Segmentation, an image is snapped and the 
nuclei are counted. Both an acquisition overlay and the total 
number of cells counted in the image are displayed. 

Figure 5-14: An example of Test Segmentation results in the 
Adaptive Acquisition mode. The red shows the segmentation 
overlaid on the original DAPI image.

10. If your test results are satisfactory, then continue to Step 11; 
otherwise, repeat Step 8 and Step 9 until your test results are 
satisfactory.

11. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Acquisition 

Tab on page 99.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.
5015321 C 95 



ImageXpress Micro Widefield High Content Screening System User Guide
To calculate the Intensity Above Local Background gray level 
value
When calculating the Intensity Above Local Background gray level value, 
you should set this value to one that is approximately half of the final 
calculated value.

1. On the source image, locate one of the dimmest objects (for 
example, a nucleus or a micronucleus, if applicable) that the 
MetaXpress Software must be able to detect. 

2. Position your mouse pointer on the outside edge of the object 
and make note of the gray level value that is displayed in the 
status bar. 
For example, (48, 158) -> 18000 indicates that 18000 is the 
average gray level value of the nucleus.

3. Position your mouse pointer just outside of the object and make 
note of the gray level value that is displayed in the status bar. 
For example, (48, 162) -> 2000 indicates that 2000 is the average 
gray level value of the background just outside the object.

4. Subtract the gray level value of the background from the gray 
level value of the object. The result is the intensity above local 
background value. 
Using the examples above, 18000 – 2000 = 16000 for the 
Intensity Above Local Background gray level value. You would 
then set this value to approximately 8000.

To configure a multi-well acquisition
To acquire high density plates faster, you can carry out a multi-well 
acquisition. A multi-well acquisition uses the size of the camera field of 
view to acquire several wells simultaneously while taking a single image, 
thereby reducing plate acquisition time. The MetaXpress Software 
automatically calculates the number of wells in which a site can be 
simultaneously acquired and this value depends on the plate size and the 
magnification that is configured for the protocol. Common configurations 
for multi-well acquisitions include a 1536 well plate with a 4x 

Note: Instead of carrying out Step 2 and Step 3, you might 
consider drawing a line region across a cell and its local 
background, and then use the Linescan tool that is available from 
the Measure menu to see more exact intensity values. See the 
MetaXpress Software online help for information about this tool.
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magnification objective or a 384 well plate with a 2x magnification 
objective.

1. Open the Sites to Visit tab.
2. Select Multi-well.

Figure 5-15: Plate Acquisition Setup dialog: Configure tab, Sites 
to Visit tab, Multi-well option selected

3. Optionally, to specify a percentage of the width (X) and height (Y) 
of the camera's field of view to acquire, select Custom Field of 
View, and then type the new X and Y values.

Note: During a multi-well acquisition, unselected wells might be 
exposed to excitation light from imaging neighboring selected wells; 
however, images are not be saved for the unselected wells.

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.
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4. If data is not going to be acquired for all the wells in a plate, then on the 
Plate map, do any of the following as needed to configure the wells for 
which data is to be acquired.
 To turn off a well, click it. The well turns light gray, which 

indicates that data will not be acquired for the well. To turn it 
back on, click the well again. The well turns light green again.

 To turn off all the wells in the column in a single step, click 
the column header. To turn all the wells back on, click the 
column header again.

 To turn all the wells in a row off in a single step, click the row 
ID. To turn all the wells back on, click the row ID again.

 To turn off a contiguous group of wells in a single step, click 
and hold the left mouse button, and then drag the cursor 
across the appropriate wells. To turn the wells back on, click 
and hold the left mouse button, and then drag the cursor 
across the wells again.

 To turn on or off all wells in a plate in a single step, click in 
the upper left corner of the plate just to the outside of the 
first well, A01, on the plate.

Note: The full field of view for the camera is 100 percent (100% 
in the X field and 100% in the Y field). So, for example, if the full 
field of view width is 1000, to acquire a width of 500, you would 
type 50 in the X field. This feature is particularly useful if the 
image that is acquired using the full field of view includes the 
area outside the well boundary. By reducing the field of view, 
you can acquire an image of only the area that is within the well.

Note: If a shading correction image was acquired with the full 
field of view, then you can use the Custom Field of View feature 
with shading correction. See To carry out shading correction on 
acquired images on page 134.

Note: You can configure the wells for which data is to be 
acquired as part of a protocol, or you can select the wells “on the 
fly” at the time that you run the protocol. See Chapter 6: 
Acquiring Plates on page 143.
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5. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Acquisition 

Tab on page 99.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

Plate Acquisition Setup Dialog: Configure Tab, Acquisition Tab
At a minimum, you must specify the autofocus options and acquisition 
wavelengths for your protocol on the Acquisition tab. Optionally, you can 
also specify various settings such as fluidics events and shading 
correction. Depending on the options that you select, other tabs with 
additional configuration options might also be displayed. 

Figure 5-16: Plate Acquisition Setup dialog: Configure tab, 
Acquisition tab
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See:
• To configure autofocus options on page 100.
• To configure the acquisition wavelengths on page 108.
• To configure series acquisition options on page 119.
• To configure journals to run during acquisition on page 127.
• To configure post-acquisition analysis options on page 130.
• To carry out shading correction on acquired images on page 134.

To configure autofocus options
Two autofocus configuration options are available on the Acquisition 
tab.

• Laser-based autofocusing is generally set to find the bottom of 
the well, and then moves the objective a specified distance up 
from the well bottom. This method is generally the fastest and 
does not cause photo damage to your specimen; however, this 
method might not be sufficient if the distance above the bottom 
of the well varies in your sample. Thumbprints or scratches at 
the bottom of the plate can also affect laser-based autofocusing.

• Image-based focusing uses an algorithm to identify the best 
focus image. This method works best for experiments that use 
low power objectives or when the sample distance above the 
bottom of the plate varies; however, this method can be slower 
than laser-based autofocusing and it can fail if out-of-focus 
debris is present in a sample.

You can configure one or both of these autofocus options for a plate 
acquisition protocol. Generally, with the exception of oil-immersion 
objectives, you should use laser-based autofocusing. Certain types of 
samples generally benefit from image-based focusing in addition to the 
laser-based focusing, including live organisms, suspension cells, tissue 
samples, or assays where the best focus position varies with the 
phenotype. If you select both laser-based and image-based autofocusing, 
then laser-based autofocusing is used to obtain a specified position 
above the bottom of the well and the image-based focusing is used to 

Note: To configure fluidic stations, select Use Fluidics to open the 
Fluidics tab. For information about configuring fluidics stations and 
properties, see the ImageXpress® Micro Widefield High Content 
Screening System Options User Guide, or the MetaXpress Software help 
topic “Fluidics Events.” 
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fine tune the position. For oil-immersion objectives, you should use only 
image-based autofocusing. 

1. Open the Acquisition tab.

Figure 5-17: Plate Acquisition Setup dialog: Configure tab, 
Acquisition tab

2. Under Autofocus options, select one or both options.
 Enable laser-based autofocusing
 Enable image-based focusing (for acquisition or laser 

recovery)

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.

Note: Image-based focusing is best for complex samples with 
variations in distance between the surface of the plate and the 
sample.
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3. Open the Autofocus tab.

Figure 5-18: Plate Acquisition Setup dialog: Configure tab, 
Autofocus tab

4. Configure the autofocus options. See Table 5-4 on page 103.
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Table 5-4: Autofocus configuration options 

Option Description

Laser-based focusing: Available only if Enable laser-based 
autofocusing is selected on the Acquisition tab.

Configure Laser Settings Opens the Configure Laser Autofocus 
Settings dialog. The settings for this 
dialog will have been calculated by 
running the Laser Autofocus Wizard. If 
the wizard has not been run for a 
selected plate and objective, then dialog 
might be blank. You can modify the 
settings that the wizard has calculated 
for this dialog.

Note: The MetaXpress Software 
help topic “Configure Laser 
Autofocus Settings - Dialog Box 
Options” provides detailed 
information about the settings that 
the wizard calculates. Press F1 with 
the dialog open to access the help. 
For tips about using the Laser 
Autofocus Wizard, contact Technical 
Support for assistance. See 
Obtaining Support on page 34.

Well to well autofocus: Settings for adjusting the focus as the 
acquisition moves from well to well.

• Focus on well bottom The default value and the recommended 
option for most plate acquisition 
protocols. The initial focus on the plate, 
Find Sample, focuses on both the plate 
bottom and well bottom. As the system 
moves from well to well, the camera 
focuses on the well bottom only, using 
the Bottom variation settings from the 
plate configuration to determine the 
focus range.
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• Focus on plate 
bottom, then offset by 
bottom thickness

Offsets the laser by the Bottom 
thickness of the plate from the plate 
configuration. Select this option if you 
are using any of the following.
• A thin-bottom plate with an 

objective with a large depth of field 
because of low magnification or low 
numerical aperture. This is typically 
for 4x and below.

• A slide. 
• Multi-well acquisition.

• Focus on plate and 
well bottom

The laser focuses on both the plate 
bottom and the well bottom at every 
well. 

Note: This is recommended for plates 
with extreme bottom variation.

Note: Chamber slides with wells can use any of the above options.

Image-based focusing

Algorithm: The focusing algorithm.

• Standard The default algorithm, which is based on 
a standard group of settings including a 
normal camera signal level.

• Low Signal Based on a set of values that are 
designed to compensate for the 
following.
• The camera has a low signal level.
• Some pixel intensities are somewhat 

brighter when slightly out of focus.

The following options are camera configuration options.

Binning Sets the binning used by the camera 
during the Auto Focus and Show Live 
commands. Horizontal and vertical 
binning are always set to the same value.

Table 5-4: Autofocus configuration options (cont’d)

Option Description
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Custom exposure times Allows for setting custom exposure times 
for individual wavelengths during 
autofocus. If this is option is not 
selected, then the exposure time is 
calculated based on autofocus binning 
and acquisition exposure time. If this 
option is selected and you select either 
or both of the following options:
• Laser and Image or Laser with 

Image Recovery for the first 
acquisition wavelength (W1)

• Image-based for all subsequent 
acquisition wavelengths (W2, W3, 
and so on)

then you must also specify values for 
Exposure and Gain on the wavelength 
tabs. See To configure the acquisition 
wavelengths on page 108.

Allow image-based 
focusing for recovery from 
laser-based well bottom 
failures

Enabled only if both Enable laser-based 
focusing and Enable image-based 
focusing are selected. Use image-based 
focusing only if laser-based autofocusing 
cannot find the plate or well bottom. The 
image-based recovery search is centered 
on an estimated well bottom offset 
position. The estimated position is 
calculated using the plate bottom 
position that was found during the last 
successful laser autofocus, and then 
adding the plate bottom thickness and 
post-laser offset values to this plate 
bottom thickness. 

Initial well for finding sample - The well to use when carrying out the 
initial Find Sample autofocus.

• First well acquired Finds the sample autofocus using the 
first well that is acquired. This is the 
recommended setting for most 
protocols.

Table 5-4: Autofocus configuration options (cont’d)

Option Description
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• Specific well Finds the sample autofocus using a well 
that you specify. 

Note: After you select this option, you 
must specify the well row and well 
number. A1 is the default value.

• Skip Find Sample 
(select if sample is 
already in focus)

Disables the initial Find Sample 
autofocus when starting to acquire a 
plate. Select this option if your sample is 
already in focus.

Note: You should select this option if 
you are using an oil-immersion 
objective, and you must manually find 
the focus before starting the plate 
acquisition.

Number of wells to 
attempt initial find sample

Enabled only if First well acquired is 
selected. The default value is one. The 
first well in which a sample is found is 
the well that is used for autofocusing. 

Note: You should set this value to three 
or greater, particularly if you are 
running a robot for automated plate 
loading.

Site Autofocus: Displayed only if Fixed number of sites or Adaptive 
Acquisition is selected. Determines how autofocusing is carried out 
for each site.

First site only Autofocuses in the top-left site in the 
well.

Center of well only Autofocuses in the center of the well. 

Note: You should select this option 
when the magnification is low and the 
sites are relatively close together. 

Table 5-4: Autofocus configuration options (cont’d)

Option Description
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5. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:

All sites Autofocuses for each site.

Note: You should select this option 
with higher magnification, if the sites 
are spread far apart, and/or there is 
extreme variation in the plate bottom.

Timelapse Autofocus: Displayed only if the Time Series acquisition 
option is selected on the Acquisition tab. See To configure series 
acquisition options on page 119.

First timepoint only Recommended for fast kinetic 
acquisitions.

All timepoints Recommended for long timelapse 
acquisitions.

Every Nth timepoint You should set this to a value that is less 
than the number of specified timepoints. 
See To configure time series acquisition 
options on page 120.

View Focusing Details Opens the Auto Focus Details dialog, 
which details the current autofocus 
parameters. This information can be 
useful for diagnostic purposes when 
troubleshooting focusing issues. You can 
click Copy to copy the parameters to the 
clipboard, and then paste them into a 
third party application such as Microsoft 
word. This can be used, for example, if 
you need to supply this information to 
Technical Support. See Obtaining 
Support on page 34.

Table 5-4: Autofocus configuration options (cont’d)

Option Description
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 Plate Acquisition Setup Dialog: Configure Tab, Objective and 
Camera Tab on page 74.

 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 
page 76.

 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 
Tab on page 82.

 Plate Acquisition Setup dialog: Configure tab, Display tab on 
page 136.

To configure the acquisition wavelengths
You configure exposure time, autofocus, and timelapse settings for each 
acquisition wavelength on a wavelength tab. The total number of 
wavelength tabs depends on the number of wavelengths that are 
selected on the Wavelengths tab.

1. Open the Wavelengths tab. 

Figure 5-19: Plate Acquisition Setup dialog: Configure tab, 
Wavelength tab

2. In the Number of wavelengths field, select the total number of 
wavelengths that are to be used for acquisition. 

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.
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Figure 5-20: Plate Acquisition Setup dialog, Configure tab: Three 
placeholder wavelength tabs

3. For each placeholder tab, do the following in the order listed.
 Click the tab to open it.
 In the Illumination setting field, select the illumination 

wavelength; for example, DAPI.

 Configure the remaining acquisition wavelength options, 
where:

Note: You must select at least one acquisition wavelength. You 
can select up to a maximum of eight wavelengths. Individual 
placeholder tabs are displayed that correspond to the number of 
acquisition wavelengths that you have selected (W1, W2, W3, 
and so on). The red Warning icon indicates that you have yet to 
configure the acquisition wavelengths. See Figure 5-20 on 
page 109.

Note: After you select a wavelength, its name is displayed on a 
placeholder tab and in the Active Wavelength field at the top of 
the tab.
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Offset (μm) is the Z motor offset distance for each 
wavelength that is defined. For the first wavelength, 
if you are using laser-based focusing, then the offset 
is the distance between the bottom of the well and 
the in-focus plane. If you are using just image-based 
focusing, then no offset is required for the first 
wavelength. For the second and subsequent 
wavelengths, with laser-based or image-based 
focusing, the offset is the difference between the 
focus position of the Z motor using the first 
wavelength and the focus position of the Z motor 
using the second or subsequent wavelength. 

Table 5-5: Acquisition wavelength configuration options 

Option Description

Exposure Specifies the exposure time in milliseconds 
that is to be associated with the active 
wavelength. You can type a value in this field 
or click Auto Expose to automatically 
determine an exposure time.

Note: When you are configuring exposure 
times, you should check both positive and 
negative controls. If you use a dim sample to 
set the exposure time, then a bright sample 
might end up saturating.

Note: Auto Expose is simply a manual tool 
to help configure the plate. It does not auto 
expose while the plate is being acquired.

Target max intensity Specifies the intensity that auto exposure 
should attempt to attain for the brightest 
pixel in the image. 

Note: The recommended target intensity 
value is 75% of the maximum gray level that 
the camera driver reports as possible to 
obtain.

Autofocus options: Specifies the type of autofocus that is to be used 
when acquiring images. The options that are available depend on the 
Autofocus options that are specified on the Acquisition tab.
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• None No autofocusing is carried out. If you select 
this option, then no other autofocusing 
configuration options are available.

• Laser with Z-offset Displayed as an option only if Enable 
laser-based focusing is selected on the 
Acquisition tab. If selected, the laser 
autofocus is used based on the settings that 
the Laser Autofocus calculates, or as 
configured in the Configure Laser Settings 
dialog. Specify the post-laser offset in μm in 
the Offset field, or click Calculate Offset to 
automatically calculate the offset that is to be 
used for the first wavelength. 

• Calculate Offset 
icon (>)

Click to display the options that are used to 
calculate the offset. You can also do the 
following.
• Click Z stack: Shows distinct Z planes so 

that you can select the best in-focus 
plane.

Note: If Z stack is not selected, then 
the MetaXpress Software carries out an 
image autofocus and determines the 
best 
in-focus plane.

• Click Custom Range: Configure the total 
search range and step size that is used to 
calculate the offset.

Note: If Custom Range is not 
selected, then default values are used 
for the Calculate Offset tool using 
either Z stack or image autofocus.

Table 5-5: Acquisition wavelength configuration options (cont’d)

Option Description
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• Laser and image Displayed as an option for only the first 
acquisition wavelength (W1) and only if 
Enable laser-based focusing and Enable 
image-based focusing are selected on the 
Acquisition tab. If this option is selected, the 
laser autofocuses first, and then image-based 
focusing is used to fine tune the image. If this 
option is selected, then you must also specify 
values for the following.
• Image-based range +/- μm: Specifies the 

range that is to be used for the image-
based portions of autofocusing.

• Max. step: Specifies the maximum step 
size in μm of a single Z move that is to be 
used to attain the correct focus position. 
This setting is dependent on the 
objective that is used. You should set this 
option to a value of 25 μm or less. Use a 
smaller step size with higher NA 
objectives because the focus peak is 
narrower.

If Custom exposure time is selected on the 
Acquisition tab, then with Laser and image 
selected, you must also specify values for the 
following.
• Exposure (ms): Specifies the exposure 

time in milliseconds that is to be used for 
the acquisition wavelength when 
autofocusing.

• Gain: Sets the sensitivity of the camera 
when autofocusing.

Note: The Gain option is not available 
for every camera type.

Table 5-5: Acquisition wavelength configuration options (cont’d)

Option Description
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• Laser with image 
recovery

Displayed only for the first acquisition (W1) 
wavelength and only if Enable laser-based 
focusing and Enable image-based focusing 
are selected on the Acquisition tab and Allow 
image-based focusing for recovery from 
laser-based well bottom failures is selected 
on the Autofocus tab. If this option is 
selected, then you must also specify the 
following options.
• Image-based range +/- μm: Specifies the 

range that is to be used for the image-
based portions of autofocusing.

Note: You should adjust the range based on 
the sample variability. Note that a larger 
range requires a longer time to focus.

• Max. step: Specifies the maximum step 
size in μm of a single Z move that is to be 
used to attain the correct focus position. 
This setting is dependent on the 
objective that is used. Use a smaller step 
size with higher NA objectives because 
the focus peak is narrower.

Note: Smaller step sizes generally require 
more steps to arrive at the final focus 
position. Increasing the number of image 
autofocus steps increases the chances of 
photobleaching or phototoxicity. 

If Custom exposure time is selected on the 
Acquisition tab, then with Laser with image 
recovery selected, you must also specify 
values for the following.
• Exposure (ms): Specifies the exposure 

time in milliseconds that is to be used for 
the acquisition wavelength when 
autofocusing.

• Gain: Sets the sensitivity of the camera 
when autofocusing.

Note: The Gain option is not available for 
every camera type. 

Table 5-5: Acquisition wavelength configuration options (cont’d)

Option Description
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• Z-offset from W1 Available only for the second or greater (W2, 
W3, and so on) acquisition wavelengths. If 
this option is selected, then the specified 
offset is moved from the W1 focus position. 
Specify the post-laser offset in μm in the 
Offset field, or click Calculate Offset to 
automatically calculate the offset that is to be 
used for all subsequent acquisition 
wavelengths.

Note: The offset for W1 must be calculated 
before you can set this value.

Table 5-5: Acquisition wavelength configuration options (cont’d)

Option Description
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• Image-based Available for the second or greater (W2, W3, 
and so on) acquisition wavelengths and only 
if Enable image-based focusing is selected on 
the Acquisition tab. Specify the offset from 
W1 in μm in the Offset field, or click 
Calculate Offset to automatically calculate 
the offset that is to be used for all subsequent 
acquisition wavelengths. If this option is 
selected, then you must also specify the 
following options.
• Image-based range +/- μm: Specifies the 

range that is to be used for the image-
based portions of autofocusing.

Note: You should adjust the range based on 
the sample variability. Note that a larger 
range requires a longer time to focus.

• Max. step: Specifies the maximum step 
size in μm of a single Z move that is to be 
used to attain the correct focus position. 
This setting is dependent on the 
objective that is used. Use a smaller step 
size with higher NA objectives because 
the focus peak is narrower.

Note: Smaller step sizes generally require 
more steps to arrive at the final focus 
position. Increasing the number of image 
autofocus steps increases the chances of 
photobleaching or phototoxicity. 

If Custom exposure time is selected on the 
Acquisition tab, then with Image-based 
selected, you must also specify values for the 
following.
• Exposure (ms): Specifies the exposure 

time in milliseconds that is to be used for 
the acquisition wavelength when 
autofocusing

• Gain: Sets the sensitivity of the camera 
when autofocusing.

Note: The Gain option is not available for 
every camera type.

Table 5-5: Acquisition wavelength configuration options (cont’d)

Option Description
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Acquisition options - The options that are displayed are determined 
by the series option that is selected on the Acquisition tab.

Acquire Time Series selected

Timelapse - Specifies 
the image collection 
intervals to use for the 
wavelength.

• at all time points - The default value. 
Acquires an image at the indicated 
wavelength at each time point in the 
experiment.

• at start of experiment - Acquires an 
image at the indicated wavelength at the 
first time point only.

• at start/end of experiment - Acquires an 
image at the indicated wavelength at the 
first time point and the last time point 
for the experiment.

• every nth timepoint - Acquires an image 
at the indicated wavelength at the 
indicated time point interval, for 
example, every 5th time point, beginning 
with the first time point for the 
experiment.

Acquire Z Series selected

Z series • Single plane - The acquisition wavelength 
acquires only a single plane in the middle 
of the Z Series range. It is not going to 
acquire the entire Z series.

• 2D Projection Image Only - The 
acquisition wavelength is going to 
acquire the Z series, but every plane is 
not going to be retained. Instead, a 
projection is going to be acquired and 
this single image is saved. 

• Z Series and 2D Projection Image - 
Displayed if Acquire Z Series is the only 
series acquisition option that is selected 
on the Acquisition tab. Acquire Time 
Series cannot be selected. The 
acquisition wavelength is going to 
acquire the Z series, and every plane and 
the projection image are retained.

Table 5-5: Acquisition wavelength configuration options (cont’d)

Option Description
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2D Projection Image Displayed for all Z series acquisition options 
other than Single Plane. Indicates how the 
resulting 2D projection image will be 
produced.
• Best Focus - The default value. The 

MetaXpress Software estimates the 
regions of best focus in the image stack 
to within one-tenth pixel accuracy along 
the Z axis. Two resolution grid sizes are 
used to enhance the criterion of focus 
through the stack.

• Maximum - Recommended only for 
fluorescence. For each corresponding 
pixel position in the images, the pixel 
that has the highest intensity value out 
of all the planes is determined, and this 
is the value that is output to the resulting 
image. 

• Minimum - Recommended only for 
transmitted light. For each 
corresponding pixel position in the 
images, the pixel that has the lowest 
intensity value out of all the planes is 
determined, and this is the value that is 
output to the resulting image.

• Sum - The intensities of the pixels in the 
stack planes are added for each 
corresponding pixel position, and this is 
the value that is output to the resulting 
image.

Digital confocal Displayed only if your organization has 
purchased the optional Digital confocal 
feature. Select to carry out 
deconvolution-based image sharpening.

Note: For information about the Digital 
confocal option, go to 
http://www.moleculardevices.com/sup
port, click on the Knowledge Base link, 
and search for “Digital confocal.”

Table 5-5: Acquisition wavelength configuration options (cont’d)

Option Description
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4. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 

Tab on page 82.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

Shading correction Always displayed, regardless of the series 
option that is selected on the Acquisition tab. 
Indicates whether shading correction has 
been turned on for the protocol. See To carry 
out shading correction on acquired images on 
page 134.

Table 5-5: Acquisition wavelength configuration options (cont’d)

Option Description

Note: The tabs are displayed in the order in which you 
configured the active wavelengths, which, in turn, corresponds 
to the acquisition order. For example, if you configured the DAPI 
wavelength first, and then the FITC wavelength second, then 
two wavelength tabs would be displayed. The DAPI tab would be 
displayed first, and the FITC tab would be displayed second. To 
save time, you should configure the acquisition wavelengths in 
the order that minimizes filter movement.
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To configure series acquisition options
Two series acquisition options are available for configuration on the 
Acquisition tab.

• Acquire Time Series acquires images at multiple time points. If 
you select this option, then you must also specify the set of 
images that are to be acquired at each time point.

• Acquire Z Series acquires individual optical sections (planes) in 
sequence through a sample to produce a 3-D image of the 
sample. If you select this option, then you must also specify the 
number of steps and the step size for moving through the 
sample.

You can select one or both of these options.

1. Open the Acquisition tab. See Figure 5-21 on page 119.

Figure 5-21: Plate Acquisition Setup dialog, Configure tab, 
Acquisition tab

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.
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2. Under Acquisition options, select one or both of the following.
 Acquire Time Series 
 Acquire Z Series 

3. If you selected:
• Acquire Time Series, then continue to To configure time series 

acquisition options on page 120.
• Acquire Z Series, then continue to To configure Z series 

acquisition options on page 123.

To configure time series acquisition options
1. Open the Timelapse tab.

Figure 5-22: Plate Acquisition Setup dialog, Configure tab, 
Timelapse tab

2. Configure the time series acquisition options. See Table 5-6 on 
page 121.
120 5015321 C 



Setting Up Plate Acquisition
Table 5-6: Time series acquisition configuration options 

Option Description

Number of timepoints Specifies the total number of time points 
that are to be acquired. The default 
value is one. If you change this value, 
then the Duration field is automatically 
updated by calculating the duration from 
the number of time points and the time 
interval.

Perform time series for - Enabled only if the value for the Number of 
time points is > 1. Specifies the loop order that is to be used when 
acquiring images at multiple time points and also determines the set 
of images that are to be acquired at each time point.

• One well then the next A set of wavelength images is acquired at 
each site in the well at each time point. 

Note: This option is most common with 
a fluidics experiment, or with a 
photoactivation event.

• One row then the next All the images in one row’s worth of 
wells are collected at each time point. 
After the series is collected, the next row 
is acquired. 

Note: This option requires a longer 
time interval because all the wells in a 
row are acquired.

• One column then the 
next

All the images in one column’s worth of 
wells are collected at each time point. 
After the series is collected, the next 
column is acquired.

• All selected wells Every well that is selected for acquisition 
is acquired at each time point. The well 
selection is determined at the start of 
the first acquisition.

Note: Any refocusing that is carried after the images for the first 
timepoint are acquired is determined by the Timelapse Autofocus 
setting that is specified on the Autofocus tab. See To configure 
autofocus options on page 100.
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3. In the Interval field, type the amount of time between the start of an 
acquisition at one timepoint and the start of an acquisition at the next 
time point. The default unit of time is seconds (sec), but you can select 
milliseconds (ms), minutes (min), or hours (hr).

4. Optionally, change the value in the Duration field.

5. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 

Tab on page 82.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

Note: The Approximate minimum time interval is calculated as 
the sum of the exposure times per time point based on the well 
selection, site selection, wavelength settings, and loop order 
selection. If the actual acquisition time for one loop exceeds the 
Interval setting, then the next timepoint commences as soon as 
the previous timepoint completes.

Note: The value in the Duration field is the result of multiplying 
the number of time points by the interval. If you change the 
number of timepoints or the interval, then the value in the 
Duration field is automatically updated.

Note: The time unit for the duration values does not have to be 
the same as the time unit for the interval value. If you change 
the value for the duration, then the value for the Number of 
timepoints is automatically updated.
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To configure Z series acquisition options
1. Open the Z series tab.

Figure 5-23: Plate Acquisition Setup dialog: Configure tab, Z 
Series tab showing the Z Series diagram

2. Specify the Z series configuration options.

Note: The blue horizontal bars in the Z series diagram represent 
the planes that are to be acquired for a site.
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Table 5-7: Z series configuration options 

Option Description

# of Steps The number of planes at a given site/well 
position for which images are to be taken; for 
example, if set to 12, which is the default 
value, then 12 images will be taken along the 
Z axis of the image. You can do the following 
to adjust this value.
• Manually type a value in the field.
• Click the Up/Down arrows in the field.
• Use the slider bar that is displayed below 

the field.

Step Size The distance in μm between the image planes 
in the Z series. You can do the following to 
adjust this value.
• Manually type a value in the field.
• Click the Up/Down arrows in the field.
• Use the slider bar that is displayed below 

the field.

Note: Based on the numerical aperture (NA) 
setting for the objective, the MetaXpress 
Software automatically calculates a 
recommended Step Size that would provide 
the best detail for your Z series. You can click 
this Recommended Step Size message to 
automatically set the Step Size to this 
recommended value.

Note: As you adjust one or both of these values, then the 
MetaXpress Software automatically calculates the Range, 
which is the overall image depth from top to bottom of the 
image sample, and displays this value below the Step Size on 
the tab.
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3. Optionally, to navigate the Z series for site/well position and modify the 
coordinates for the Z motor before you acquire any images, do any of 
the following as needed.

Figure 5-24: Z Series diagram

 Click and drag the Ruler Zoom slider bar that is displayed 
below the Z series diagram to zoom in/zoom out on the 
diagram.

 Focus is displayed on the Z series diagram to indicate the 
position of the Z motor after autofocusing and wavelength 
offsets are applied. You can do the following based on this 
location.
 Click the Focus active wavelength tool to place 

the Z motor at the Focus indicator in the Z series 
diagram and display its current position in μm. The 
ruler markings indicate the distance in μm above and 
below the Focus position. 

 Click and drag the Top or Bottom flags to 
manually set the top and bottom positions for the 
Z series acquisition relative to the Focus position. 
As you manually adjust one or both of these 
values, the MetaXpress Software automatically 
calculates and displays the appropriate values for 
the # of Steps and the Range. The position in 
μm to which a flag is moved is temporarily 
displayed on the flag.

 Select Center Z Series Around Focus Result to evenly space 
the Z series planes above and below the Focus position. 
Now, if you click and drag a Top or Bottom flag on the Z 
series diagram to manually set the position for the Z series 
acquisition, the MetaXpress Software automatically moves 
the other position by exactly the same amount.
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 Click and drag the Current Position flag on the Z series 
diagram to update the current position for the Z motor. After 
you move the flag, you can then click Set T or Set B to set the 
top and bottom positions, respectively.

 Click on a blue bar in the Z series diagram to move the 
Current Position flag to this plane. (Remember, this flag 
indicates the current position for the Z motor.) Optionally, 
you can then click the Snap active wavelength tool to snap 
and display a real time image of the selected plane in an 
image Snap window. As you click on different planes in the Z 
series diagram, the image in the Snap window is updated 
accordingly. 

 To move the Z motor up or down one step at a time by the 
recommended Step Size, click the small step size arrows, 
which are the small black vertical arrows to the right of the Z 
series diagram. To move the Z motor up or down one step at 
a time by the defined Step Size, click the large step size 
arrows, which are the large black vertical arrows to the right 
of the Z series diagram. If you click and hold a Step Size 
arrow, then the Z motor is moved continuously. 

Note: If the Current Position flag is not displayed, use the Focus 
active wavelength tool first.

Tip: Use this function with the Start Live active wavelength tool. 
Click Start Live, and then with the Focus set, click and drag the 
Current Position flag to view the different positions in an image 
in real time. From this, you could determine such things as the 
location for the top of the cells in the sample. You could then 
click Set T on the Current Position flag to accurately set the 
position for the top of an image.

Note: You can also click and drag the Z slider bar at the top of 
the Snap image window to move through each plane in the 
acquired stack. To prevent asynchronous hardware moves, the 
position of the Current Position flag on the Z series diagram (i.e., 
the current position of the Z motor) is not updated. 
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4. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 

Tab on page 82.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

To configure journals to run during acquisition
You use the Journals tab to configure specific journals to run during 
different stages of the acquisition. You can configure only a single journal 
to run at an acquisition step.

1. Open the Acquisition tab.

Figure 5-25: Plate Acquisition Setup dialog: Configure tab, 
Acquisition tab

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.
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2. Select Run journals during acquisition.
3. Open the Journals tab. See Figure 5-26 on page 128.

Figure 5-26: Plate Acquisition Setup dialog, Configure tab, 
Journals tab

4. Select the specific acquisition step for the journal.
5. Click the Select Plate Acquisition Journal icon , for the step, 

and then in the Select Plate Acquisition Journal dialog, scroll to 
and select the appropriate journal file. 

6. After you select the journal, click Open to close the Select Plate 
Acquisition Journal dialog and return to the Journals tab. 
Table 5-8: Journal options 

Option Description

Before each image Runs only during the acquisition loop, after the 
illumination is set and focusing is done. 

After each image Runs only during the acquisition loop, after the 
shutter is closed and before images are saved.

Before focusing Runs only during the acquisition loop, just 
before the focus algorithm begins.

Start of z Runs before a Z series is started. The journal 
runs when the Z motor is at the lowest step in 
the series and before an image is acquired. The 
journal runs once for each wavelength that is 
configured to use the Z series.
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End of z Runs after a Z series is completed. The journal 
runs when the Z motor is at the highest step in 
the series and after any projection images are 
generated. The journal runs once for each 
wavelength that is configured to use the Z 
series.

Start of site Runs only during the acquisition loop, before 
any images are acquired from each site.

End of site Runs only during the acquisition loop, after all 
images have been acquired from each site.

Start of well Runs only during the acquisition loop, at the 
beginning of each well, before any images are 
acquired from a well.

End of well Runs only during the acquisition loop, at the 
end of each well, after all images have been 
acquired from a well.

Start of time point Runs only during the acquisition loop, at the 
beginning of each time point, before any images 
are acquired for a time point.

End of time point Runs only during the acquisition loop, at the 
end of each time point, after all images have 
been acquired for a time point.

Start of plate Runs after the stage is moved to the find sample 
position, but before the find sample action is 
performed.

End of plate Runs after the last acquisition for a plate is 
complete.

Prevent 
asynchronous 
hardware moves

Optional. Select this option if any of the journals 
that are to be run move hardware such as 
changing shutters, moving focus, and so on. 
This option ensures that the journals run 
correctly.

Note: Do not select this option if no 
journals are being used as acquisition is 
unnecessarily slowed down.

Table 5-8: Journal options (cont’d)

Option Description
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7. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 

Tab on page 82.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

To configure post-acquisition analysis options
You can select a specific analysis to run on a plate after the acquisition is 
complete on the Analysis tab. If you select this option, then the analysis 
job is added to the Auto Run queue in the MDCStore database for 
analysis either by a MetaXpress system that is set to Auto Run mode or 
by the MetaXpress PowerCore Software. You can select from a list of 
saved assays and settings files from any application module, custom 
module, or journal assay that has been saved to the MDCStore database. 

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.
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1. Open the Acquisition tab.

Figure 5-27: Plate Acquisition Setup dialog, Configure tab, 
Acquisition tab

2. Select Analyze Images Immediately After Acquisition.
3. Open the Analysis tab. See Figure 5-28 and Figure 5-29 on 

page 132.

Note: The options that are displayed on the Analysis tab 
depend on the series acquisition mode (Acquire Time Series or 
Acquire Z Series) that is selected on the Acquisition tab as well 
as the image that is to be acquired and retained: Single plane, 
2D Projection Image Only, or Z Series and Projection Image.
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Figure 5-28: Plate Acquisition Setup dialog: Configure tab, 
Analysis tab (Time Series)

Figure 5-29: Plate Acquisition Setup dialog: Configure tab, 
Analysis tab (Z Series and 2D Projection Image Only)

4. On the Analysis drop-down list, select the post-analysis assay to 
run. 
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5. On the Setting drop-down list, select the appropriate settings file 
for this module or journal assay.

6. Specify the acquisition time points for which the analysis is to be 
run.

Note: This list includes any application modules or journal 
assays that have been saved to the MetaXpress Software 
database. The list of available assays is the same list that is 
available on the Run Analysis tab on the Review Plate Data 
dialog.

Note: The list includes all setting files that have been previously 
saved to the MetaXpress Software database. 

Table 5-9: Time point options - Time series acquisition

Option Description

All time points The default value. Analyze all the acquisition 
time points.

Time point range Analyze only those acquisition time points 
that fall within the indicated range. 

Stack of all time points Available if the selected analysis is a journal. 

Table 5-10: Time point options - Time series acquisition with Z 
series acquisition for at least one acquisition wavelength; 2D 
Projection Image Only

Option Description

All time points The default value. Analyze all the acquisition 
time points.

Time point range Analyze only those acquisition time points 
that fall within the indicated range. 

Stack of all time points Available if the selected analysis is a journal. 
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7. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 

Tab on page 82.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

To carry out shading correction on acquired images
You specify whether to carry out shading correction in acquired images 
on the Acquisition tab. Before you can carry out shading correction, the 
appropriate shading correction images must have been acquired for each 
acquisition wavelength and saved to a directory that you have specified 
as the Plate Acquisition Shading Correction directory. The default value 
for this directory is C:\Shading Images. The name for a shading image 
must include the exact matches for the magnification and illumination 
settings; for example, 

Shading_10XPlan Fluor_DAPI.tif

Table 5-11: Time point options - Z series acquisition for at least 
one acquisition wavelength; Z Series and 2D Projection Image

Option Description

All Z points The default value. Analyze all the acquisition 
planes.

Z step range Analyze only those planes that fall within the 
indicated range. 

Stack of all Z steps Available if the selected analysis is a journal. 

Projection Image Analyze only the projection image.

Note: If a shading correction image was acquired with the full field of 
view, then you can use the Custom Field of View feature on the Plate 
tab with shading correction. See Plate Acquisition Setup dialog: 
Configure Tab, Plate Tab on page 76.
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1. Open the Acquisition tab.

Figure 5-30: Plate Acquisition Setup dialog, Configure tab, 
Acquisition tab

2. Select Perform shading correction.
3. If needed, click Directory and in the Browse for Folder dialog, 

browse to and select the directory that contains the required 
shading correction images. After you have selected the folder, 
click OK to close the dialog and return to the Acquisition tab.

4. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 

Tab on page 82.
 Plate Acquisition Setup dialog: Configure tab, Display tab on 

page 136.

Note: If a shading image is not present for a particular combination of 
magnification and illumination settings, then no shading correction is 
carried for the wavelength.
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Plate Acquisition Setup dialog: Configure tab, Display tab
You configure the settings for the MetaXpress Software desktop 
appearance such as image size and positions, the Plate Acquisition Setup 
dialog size and position and other image properties, during acquisition 
on the Display tab. You can choose to display images only during 
autofocus, only during acquisition, or both. You can also choose to 
display a color overlay of wavelength images during acquisition.

Figure 5-31: Plate Acquisition Setup dialog: Configure tab, 
Display Settings tab
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To configure the display settings for an acquisition 
protocol

Table 5-12: Configure tab, Display tab options

Option Description

Auto Arrange Images Use the MetaXpress Software default 
settings for displaying images and 
dialogs during acquisition. Images are 
tiled and autoscaled and the status 
dialog is unobstructed. The Plate 
Acquisition Setup dialog also opens. 
You can manually change the display 
configuration using a variety of options 
for this preview.

Note: Use this option in 
conjunction with the Active 
Wavelength Preview tool to 
generate a preview of an acquired 
image for each configured 
acquisition wavelength.

Display images during 
autofocus

Selected by default. Displays the 
images that are acquired during image 
autofocus and during use of the 
Calculate Offset tool.

Display images during 
acquisition

Selected by default. Displays each 
image as it is acquired.

Display a color overlay of 
wavelength images during 
acquisition

Displays a color composite of the 
wavelengths that are acquired at each 
site.

Note:  As you are configuring an acquisition protocol, you can open the 
Summary panel and leave it open to view the current values for all the 
protocol settings. See Summary Panel on page 140.
5015321 C 137 



ImageXpress Micro Widefield High Content Screening System User Guide
1. Open the Display tab.
2. Click Auto Arrange Images to use the MetaXpress Software 

default settings for displaying images during acquisition. You can 
leave the images in this default layout, or you can manually 
adjust them by doing any of the following as needed.

 Rearrange the position of the image windows.
 Rearrange the position of the Plate Acquisition Setup dialog.
 Change the size of the image windows.
 Change the size of the Plate Acquisition Setup dialog.
 Use the image preview tools to change the size, scaling, or 

LUT for an image.

Figure 5-32: Display Settings tab, preview for manually adjusting 
the image display properties

3. Optionally, select or clear any or all the image preview options as 
needed: Display images during autofocus, Display images 
during acquisition, or Display a color overlay of wavelength 
images during acquisition.

Note: If the image windows are not visible, then click the Active 
Wavelength Preview tool to display an image window for each 
configured acquisition wavelength.
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4. If you are done configuring the plate acquisition protocol, then 
continue to Saving a Plate Acquisition Protocol on page 141; 
otherwise, continue to any other configuration as needed. See:
 Plate Acquisition Setup Dialog: Configure Tab, Objective and 

Camera Tab on page 74.
 Plate Acquisition Setup dialog: Configure Tab, Plate Tab on 

page 76.
 Plate Acquisition Setup Dialog: Configure Tab, Sites to Visit 

Tab on page 82.
 Plate Acquisition Setup Dialog: Configure Tab, Acquisition 

Tab on page 99.
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Summary Panel
The Summary panel displays a summary of all the current acquisition 
settings. The Summary panel is displayed to the right of the Plate 
Acquisition Setup dialog. When the Plate Acquisition Setup dialog first 
opens, the Summary panel is closed. 
After you open the Summary panel, you can leave it open at all times 
during the configuration of an acquisition protocol, or you can toggle its 
display, and open it only when it is convenient for you.

1. At the bottom of the Plate Acquisition Setup dialog, click 
Summary >>. See Figure 5-33 on page 140.

Figure 5-33: Plate Acquisition Setup dialog with open Summary 
panel

2. Optionally, do any or all of the following as needed.
 Use the Scroll bar to the right of the Summary panel to scroll 

up and down through its display.
 Click Copy to copy the contents to the client clipboard. You 

can then paste these copied contents into a third party 
application such as Microsoft Word as needed.
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 Click Print to print the contents to a selected printer.
3. When you are done viewing or working with the contents of the 

Summary panel, you can leave it open at all times during the 
configuration of an acquisition protocol, or you can click Summary << 
to close it.

Saving a Plate Acquisition Protocol
When you save a plate acquisition protocol, you have the option of 
saving the protocol to a database or to a file. The default location is to 
save to a database. Your organization’s working needs should determine 
whether to save the protocol to a database or a file. For example, if your 
organization plans on integrating your ImageXpress® Micro system to a 
robot for automated plate loading, then you must save the protocol to a 
file.

To save a plate acquisition protocol to a database
1. Click Save Protocol.
2. In the Save Acquisition Setting dialog, in the Setting Name field, type 

the name for the plate acquisition protocol.
3. Click Save.

You can now acquire your plate data with the saved protocol. See 
Chapter 6: Acquiring Plates on page 143.

Note: This option is useful, for example, if you need to copy and 
paste the contents to send them to Technical Support when you 
are troubleshooting a protocol configuration. See Obtaining 
Support on page 34.
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To save a plate acquisition protocol to a file
When you save a protocol to a file, the file type is .HTS and you cannot 
change this. The default location for saving a protocol is 
C:\MX6\HTSSTATE, but you c an select a different location.

1. Click Save Protocol.
2. Select Save to file rather than database.
3. Click Save.
4. In the File name field on the Plate Acquisition Setting dialog, type a 

name for the protocol.
5. Optionally, select a different location in which to save the file.
6. Click Save.

You can now acquire your plate data with the saved protocol. See 
Chapter 6: Acquiring Plates on page 143.
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Acquiring Plates
You can initiate plate acquisition from any of the following four locations 
in the MetaXpress® Software application:

• Plate Acquisition Setup dialog
• Plate Acquisition and Control dialog
• Plate Acquisition dialog
• Plate Acquisition toolbar

Before Version 6.0 of the MetaXpress® Software, each of these locations 
served a specific function in the plate acquisition flow such as:

• Making changes to the X, Y, and Z positions to accomplish correct 
plate and focus alignment.

• Selecting or typing an Experiment base name.
• Selecting and loading the protocol (Settings file) to use for the 

acquisition.
• Viewing the summary of acquisition settings.
• Acquiring a plate.

Beginning with Version 6.0 of the MetaXpress® Software application, 
however, all the functions that were previously available only from the 
Plate Acquisition and Plate Acquisition and Control dialogs are now also 
available from the Plate Acquisition Setup dialog. You can continue to 
use the Plate Acquisition and Plate Acquisition and Control dialogs to 
carry out specific functions for acquiring plates in the MetaXpress® 
Software application and for historical purposes, the use of these dialogs 
is still documented in this chapter. For efficiency and convenience, 
however, Molecular Devices recommends that you use the Plate 
Acquisition Setup dialog.

Note: If you are using a robotic plate handler to load your plates, then 
you initiate acquisition from within the environment of the software 
that controls the plate handler device.
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Plate Acquisition Setup dialog
After you have configured a plate acquisition protocol, you will most 
likely need to move the stage or the focus to ensure correct plate and 
focus alignment before you can run the protocol to acquire plate data. 
The Plate Acquisition Setup dialog provides two maps—the Plate map 
and the Site map—for accomplishing these tasks. Other controls on this 
dialog are provided for initiating autofocus, specifying the protocol 
variables such as the storage name and location and the plate name, 
loading a protocol, specifying the wells and/or sites for which to acquire 
data, opening a Live window or a Preview window, snapping an image, 
and acquiring a plate. 

To load a plate acquisition protocol
1. On the MetaXpress Software main menu, click Screening > Plate Setup 

dialog.

2. On the Plate Acquisition Setup dialog, click Load Protocol.
3. On the Load Plate Acquisition Protocol dialog, do one of the following:

Note: The procedures in this section are organized to guide you 
through the process of running a plate acquisition protocol in the most 
logical order, but you can carry out the procedures in the order that best 
suits your working needs.

Note: If the correct protocol is already selected on the Protocol 
drop-down list when the Plate Acquisition Setup dialog opens, 
then you can skip to Step 4.
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4. Click Eject Plate, to open the door, and then load the plate for which 
data is to be acquired. 

5. Click Load Plate to close the door.
6. After you have loaded a plate acquisition protocol, if the protocol 

specifies the correct wells and sites for which data is to be acquired, 
then continue to To verify the acquisition settings on page 148. 
Otherwise, continue to To configure the wells and sites for which to 
acquire data (Optional) on page 145.

To configure the wells and sites for which to acquire 
data (Optional)
After you have loaded a plate acquisition protocol, if the protocol does 
not specify the wells and sites for which data is to be acquired, or if you 
need to select different wells and sites, then you can configure the wells 
and sites at the time that you run the protocol.
The top left graphic on the Plate Acquisition Setup dialog is the Plate 
map. You use this interactive graphic to move the stage and to configure 
only those wells for which data is to be acquired. 

Table 6-1: Loading a plate acquisition protocol

Option Steps

To load a protocol from 
the database

• On the Protocols in Database drop-
down list, select the protocol that is 
to be loaded.

• Click Load from DB.

To load a protocol from a 
file

• Click Load From File.
• In the Load Plate Acquisition 

Protocol dialog, browse to and select 
the correct protocol (a .HTS file), and 
then click Open.
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Figure 6-1: Plate Acquisition Setup dialog, Plate map 

The top right graphic on the Plate Acquisition Setup dialog is the Site 
map. You use this interactive graphic to move the focus and to configure 
the position of the sites in a well that are to be acquired. 

Figure 6-2: Plate Acquisition Setup dialog, Site map
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To configure the wells and sites for which to acquire data:
1. Configure the wells for which data is to be acquired. The following 

actions are available for the Plate map.
 To turn off a well, click it. The well turns light gray, which 

indicates that data will not be acquired for the well. To turn it 
back on, click the well again. The well turns light green again.

 To turn off all the wells in the column in a single step, click 
the column header. To turn all the wells back on, click the 
column header again.

 To turn all the wells in a row off in a single step, click the row 
ID. To turn all the wells back on, click the row ID again.

 To turn off a contiguous group of wells in a single step, click 
and hold the left mouse button, and then drag the cursor 
across the appropriate wells. To turn the wells back on, click 
and hold the left mouse button, and then drag the cursor 
across the wells again.

 To turn on or off all wells in a plate in a single step, click in 
the upper left corner of the plate just to the outside of the 
first well, A01, on the plate.

2. Configure the sites in a well for which data is to be acquired. The 
following actions are available for the Site map.
 To turn a site off, click it. The site turns gray, which indicates 

that data will not be acquired for the site. To turn the site 
back on, click the site again. The site turns bright green 
again.

 To turn off a contiguous group of sites in a single step, click 
and hold the left mouse button, and then drag the cursor 
across the appropriate sites. To turn the sites back on, click 
and hold the left mouse button, and then drag the cursor 
across the sites again.

3. Continue to To verify the acquisition settings.

Note: The site controls apply to all sites in all wells at the same 
time. When you turn on or off sites for a selected well, then all 
wells in the plate will have data acquired for the same sites. 
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To verify the acquisition settings
After you have configured the wells and sites for which to acquire data, 
you should verify that your current acquisition settings are appropriate 
for the objects that are to be detected at each acquisition wavelength. 
You will most likely need to move the stage or the focus to verify correct 
plate and focus settings before you can run the protocol to acquire plate 
data. You use the functions that are available from the Plate map to 
move the stage to test settings on appropriate controls wells before you 
run the protocol. You use the functions that are available from the Site 
map to test settings on a different site that is within the well. After you 
have moved the stage or focus, you can use the Snap, Test, and Preview 
functions that are available for the Active Wavelength tools to verify 
your acquisition and focus settings.

Figure 6-3: Wavelength selection and interactive Wavelength tools

1. To move the stage to a well, right-click the well. 
The well turns dark green and it is surrounded by a black box, 
which indicates that the well is currently in position for image 
acquisition.

2. To move the stage to a site within the current well, right-click the site. 
The site turns dark green, which indicates that the site is 
currently in position for image acquisition. The current well 
position and site location, for example, Well: A01, Site: 2, is 
displayed above the Site map.

Note: The Snap and Test functions for an acquisition wavelength are 
also available on the Run tab. See Figure 6-4: Plate Acquisition Setup 
dialog, Run tab on page 149.

Note: You can move the stage to an unselected well. If you 
move the stage to a well that is turned off, then the well is 
displayed in dark gray.

Note: You cannot move the stage to an unselected site.
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3. Open the Run tab.

Figure 6-4: Plate Acquisition Setup dialog, Run tab

4. Verify your acquisition settings. 
You can verify settings on an individual wavelength basis, or you 
can verify your settings for all acquisition wavelengths in a single 
step. Test results are displayed for each acquisition wavelength in 
standalone image windows.

Note: The Exposure Time value and the Focus Offset value that 
are displayed for each acquisition wavelength at the bottom of 
the Run tab are the values that you specified for the wavelength 
during configuration of the loaded acquisition protocol. You can 
modify these values for an acquisition wavelength here, or from 
the individual wavelength tabs. See To configure the acquisition 
wavelengths on page 108.
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5. If you are satisfied with the results, then continue to To run a plate 
acquisition protocol on page 151; otherwise, modify your acquisition 
settings and repeat this procedure as needed until you are satisfied 
with the results, and then continue to To run a plate acquisition 
protocol on page 151. 

Table 6-2: Verifying acquisition settings

Option Description

Individual wavelength In the Active Wavelength field, select an 
acquisition wavelength, and then from the 
Active Wavelength tools, run the 
appropriate tests as needed.
• Snap: Acquires a single image at the 

current well and site position (XY-
position), focus (Z-position), 
wavelength, and exposure time.

• Test: Autofocuses and acquires all 
planes for the currently selected active 
wavelength to test the acquisition of 
its autofocus, exposure time, Z-series 
and display settings.

Note: You can also run these tests 
using the Snap and Test options that 
are displayed next to each acquisition 
wavelength at the bottom of the Run 
tab.

All wavelengths Preview: Autofocuses and acquires all 
planes for all acquisition wavelengths at 
the same time to test the acquisition of 
their exposures and display settings. The 
results of this testing are displayed in a 
separate image window for each 
acquisition wavelength. 

Tip: If you need to modify your acquisition settings, then you 
can click Start Live to assist you. When you click Start Live, the 
MetaXpress Software continuously acquires images based on the 
current acquisition settings, and then updates these images as 
you modify the settings. Be aware, however, that this might 
cause photobleaching of the sample.
150 5015321 C 



Acquiring Plates
To run a plate acquisition protocol
After you have loaded a protocol, configured the wells and sites for which 
to acquire a data, and verified that your current acquisition settings are 
appropriate, then you can run the loaded protocol and acquire the plate 
data.

1. Enter the information for your experiment.

2. Click Acquire Plate to acquire images from a plate based on the settings 
for the loaded protocol. 
The Plate Acquisition Setup dialog closes and the Plate 
Acquisition Status dialog opens. The dialog displays an image of 
the plate wells that have been acquired (outlined in black) and 
the well that is currently being acquired (outlined in red). The 

Note: If you modify the acquisition settings for a protocol, then 
you can run the protocol as-is, or optionally, you can click Save 
Protocol to save the protocol. You can save the modified 
protocol as a new protocol, or you can overwrite the existing 
protocol.

Table 6-3: Experiment information

Option Description

Folder Name Recommended. The name of the folder in which 
the plate acquisition data is to be stored.

Plate Name Required. The name/id of the plate for which data 
is being acquired. 

Storage Location Required. The location in which the folder that 
contains the acquisition data is to be saved. Your 
Administrator configures the available options. 

Barcode Optional. You can enter the value manually, or 
automatically using a hand-held barcode scanner. 

Note: If the instrument is being used with a 
robotic plate handler, then the automation 
software populates the barcode value as 
appropriate.

Description Optional. A description of the experiment that 
you are running to acquire the plate data.
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well/site ID for the well that is currently being acquired is 
displayed below this graphic. Wells are acquired in a serpentine 
fashion– going down one column, and then up the next column. 
After acquisition begins, the estimated time remaining is 
displayed. An image is displayed briefly for each acquisition 
wavelength in a standalone image window on the MetaXpress 
Software desktop as it is acquired and saved. After the last image 
is acquired and saved, the Plate Acquisition Status dialog closes 
and the Plate Acquisition Setup dialog reopens.

Figure 6-5: Plate Acquisition Status dialog

Plate Acquisition and Control Dialog
At the beginning of the process, while designing your experiment, you 
will most likely need to make changes to the X, Y, and Z positions to verify 
correct plate and focus alignment. The Plate Acquisition and Control 
dialog provides controls that enable you to simplify and expedite this 
process. You can also use this dialog as a starting point for configuring 
the Plate Acquisition Setup dialog. Click Setup to open the Plate 
Acquisition Setup dialog. Other controls on this dialog enable you to 
initiate Autofocus, specify the experiment base name, Load Protocol, 
Save Protocol, display the summary, open a Live window, open a 
Preview window, Snap an image, and acquire a plate. For additional 
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information about this dialog, see the following topics or refer to the 
application help available in the MetaXpress Software.

Using the Plate Acquisition and Control Dialog
Use the Plate Acquisition and Control dialog to acquire images from 
multi-well plates using the settings defined in the Plate Acquisition Setup 
command. You can also control the stage and Z-motor from this dialog, 
as well as change the current wavelength and save and load settings.

There are several possible workflows available for your acquisition. One 
typical workflow for multi-well plate acquisition is as follows:

• Configure and save your settings file using the Plate Acquisition 
Setup dialog.

• Use the Plate Acquisition and Control dialog or toolbar to do the 
following:
 Load your settings file and review the settings using the 

Summary button.
 Confirm your settings if needed using the available tools.
 Enter an experiment base name.
 Start the acquisition. During acquisition, the acquired images 

are saved into the database.
• If you want to make any changes to the stage or Z Position, or 

snap an image to test the current settings before starting the 
acquisition, use the Plate Acquisition and Control dialog or the 
Plate Acquisition Toolbar to perform these and other tasks.

• Perform any post-acquisition analysis using the Review Plate 
Data or Plate Data Utilities dialogs. This can be configured to 
start automatically from the Plate Acquisition Setup dialog, if 
desired.

Note: Most of the tools available in the Plate Acquisition and Control 
dialog are also available in the Plate Acquisition toolbar. To display the 
Plate Acquisition toolbar, click Window>Toolbars>Plate Acquisition.
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Figure 6-6: Plate Acquisition and Control dialog 

Option Description

Plate Navigation:

• X, Y Controls Moves the stage in increments of one well in 
the direction of the selected arrow button.

• Well Indicates the well currently in position for 
image acquisition.

• Site Indicates a site within a specific well that is 
currently in position for image acquisition.

• Go to well Moves the stage to the well number that you 
type into the Go to well box.

• Go To A1 Moves the stage to the A1 position.

• Z Controls Moves the Z-motor in one-step increments in 
the direction of the selected arrow button. The 
step size is set in the Step Size field.

• Go to Origin Moves the Z-motor to the focus position as 
defined in the Focus dialog.

• Step size Sets the size of the individual focus increments 
using the Z control arrows.
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• Find Sample Performs a very coarse auto focus on the 
current well position. The range covered in Find 
Sample is the same as the initial Find Sample 
when starting an Acquire.

• Autofocus Performs autofocus on the current well as 
configured for the current wavelength in the 
Autofocus plane of the Plate Acquisition Setup 
dialog.

Acquisition Control:

• Load Settings Loads the selected settings from an existing 
screening settings file. Settings files are stored 
either in the database or on the file system. 
When you click Load Settings, the Load Screen 
Acquisition dialog appears. Check the boxes for 
the conditions and groups of settings that you 
want to load from the settings file, clear the 
ones that you do not want to load. Click Select 
All to load all conditions; click Clear all to clear 
all selections. Click Load to load your selected 
conditions. The Load Settings function is 
identical to the Load Settings option in the 
Experiment tab of the Plate Acquisition Setup 
dialog.

• Summary Lists the current settings selected for your 
acquisition, the number of selected wells, the 
number of sites in each well, the distance 
between images, the number of wavelengths, 
the total number of images, the amount of 
storage required, and the specified type of 
focusing for each wavelength for both the first 
and the remaining sites in the well. The 
Summary function is identical to the Summary 
tab in the Plate Acquisition Setup dialog.

• Save Settings Saves the current settings to a file on the local 
hard drive or to the database. When you click 
Save Settings, the Save Acquisition dialog 
appears. Type the name of a new settings file 
that you want to create, or select a listed 
settings file name to overwrite an existing 
settings file.

Figure 6-6: Plate Acquisition and Control dialog (cont’d)

Option Description
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• Setup Opens the Plate Acquisition Setup dialog and 
enables you to change acquisition settings.

• Experiment base name Defines the base file name.

• Wavelength Selects the wavelength to use for your snap or 
live image.

• Snap Current Acquires a single image of the currently in place 
well at the current settings for stage (XY-
position), focus (Z-position), wavelength, well, 
site, and exposure.

• Show Live Continuously acquires images based on the 
current settings, and updates the image as 
settings are changed.

• Preview Previews the current display and exposure 
settings by opening the Plate Acquisition Status 
dialog and autofocusing and acquiring an image 
for each wavelength. After all images have been 
acquired, you can change the configuration of 
the display by repositioning the image windows 
and dialog and changing the size, scaling, and 
LUT of images. These window new settings will 
be saved and used during acquisition.

• Acquire Starts the sequential acquisition of images from 
a plate based on the settings made in Plate 
Acquisition Settings dialog.

Reset IX Micro Turns off and then turns on the ImageXpress 
Micro instrument

Close Closes the dialog.

Figure 6-6: Plate Acquisition and Control dialog (cont’d)

Option Description
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To use the Plate Acquisition and Control dialog
The controls on the Plate Acquisition and Control dialog allow you to 
manually control certain microscope functions to enable you to test 
settings and conditions and acquire preliminary or test images of 
samples. The Acquire button is used to begin the automated acquisition 
process configured in the Plate Acquisition Setup dialog. Use the 
following procedure to familiarize yourself with the controls on the Plate 
Acquisition and Control dialog:

1. Click Screening > Plate Acquisition and Control.
The Plate Acquisition and Control dialog appears.

2. Ensure that a plate is in place on the microscope stage.
3. Click Go To A1 to move the plate to A1. 

OR
Type the well number that you want to view in the Go to well 
box, and click Go to well. The plate moves to the desired 
location.

4. To change the Z-focus motor position, use the Z-control arrows. 
5. Select a step size in the Step size field. Use a large value for 

course movement or a small value for fine movement.
6. Click Go to Origin to move the Z focus motor to its origin position 

as defined in the Focus dialog.
7. Click Find Sample to initiate the Find Sample focusing routine on 

the current well.
8. Click Autofocus to autofocus on the current well using the 

wavelength selected in the Wavelength field. 
9. Click Load Settings to open the Load Plate Acquisition Settings 

dialog and load a previously saved settings file.
10. Click Save Settings to open the Save Plate Acquisition Settings 

dialog and save the current settings to a file on the local hard 
drive or to the database. 

11. Click Summary to open the Plate Acquisition Summary dialog 
and view your current settings.

12. Click Setup to open the Plate Acquisition Setup dialog and 
change your acquisition settings.
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13. Click the Wavelength field to select a wavelength that has been defined 
for the current setting in the Plate Acquisition Setup dialog.

14. Click Snap Current to acquire a single image with the current settings.
15. Click Show Live to acquire images so you can manually focus the 

microscope.
16. Click Preview to open the Plate Acquisition Status dialog and an image 

view dialog for each wavelength. During this time, you can adjust the 
display of images and windows so that they will be appropriately sized 
and positioned for acquisition.

17. Click Acquire to acquire images.
18. Click Close to exit the dialog.

Plate Acquisition Dialog
The plate acquisition dialog has the least number of controls and options 
compared to the other three locations from which you can initiate plate 
acquisition. You can do only the following procedures:

• Select or type an Experiment base name
• Select and load the Settings file that you want to use for the 

acquisition.
• View the summary of acquisition settings.
• Acquire a plate.

Figure 6-7: Plate Acquisition dialog

Using the Plate Acquisition Dialog
Use the Plate Acquisition dialog to quickly start acquiring plates using any 
of the settings defined in the Plate Acquisition Setup command. You can 
also view a summary of the current settings file and change the base 
name of the experiment from this dialog.
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There are several possible workflows available for your acquisition. One 
typical workflow for multi-well plate acquisition is as follows:

• Configure and save your settings file using the Plate Acquisition 
Setup dialog.

• Use the Plate Acquisition and Control dialog or toolbar to do the 
following:
 Load your settings file and review the settings using the 

Summary button.
 Confirm your settings if needed using the available tools.
 Enter an experiment base name.
 Start the acquisition. During acquisition, the acquired images 

are saved into the database.
• Perform any post-acquisition analysis using the Review Plate 

Data or Plate Data Utilities dialogs. This can be configured to 
start automatically from the Plate Acquisition Setup dialog if 
desired.

Note: To perform additional configuration of the experiment before 
starting the acquisition, use the Plate Acquisition and Control dialog.
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To use the Plate Acquisition dialog
1. Click Screening > Plate Acquisition. 

The Plate Acquisition dialog appears.
2. Ensure that a plate is in place on the microscope stage.
3. Select a Settings file to use from the Settings field.
4. To change the experiment name, type a name in the Experiment Base 

Name field.
5. Click Summary to view details about the current settings.
6. Click Load Settings to open the Load Plate Acquisition Setting dialog. 
7. Select the checkboxes for the conditions and groups of settings that 

you want to load from the settings file, or click Select All to load all 
conditions. 

8. Click OK to load your selected conditions.
9. Click Acquire to acquire images from a plate based on the current 

settings.
10. Click Close to exit the dialog.

Observing Acquisition Progress
The following dialogs enable you to observe and determine the status of 
the progress of your plate acquisition:

• Screen Summary dialog
• Plate Acquisition Status dialog

Screen Summary Dialog
The Screen Summary dialog shows a complete summary list of all of the 
settings in the Plate Acquisition Setup dialog. This same information is 
also repeated on the Summary Tab of the Plate Acquisition Setup dialog. 
To view the Screen Summary dialog, click the Summary button on the 
Plate Acquisition and Control dialog.
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Figure 6-8: Screen Summary dialog
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Plate Acquisition Status
This dialog shows the progress of your plate acquisition by indicating the 
wells scheduled for acquisition, the wells that have been completed, and 
the well currently being acquired. 
To view the Plate Acquisition Status dialog, click Preview in the Plate 
Acquisition and Control dialog.

Figure 6-9: Plate Acquisition Status dialog

Legend: 
 White: Wells not scheduled for acquisition
 Green: Wells scheduled for acquisition
 Green with Gray outline box: Wells that have completed 

acquisition
 Green with Black outline box: Well currently being acquired
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Using the Plate Acquisition Toolbar
The Plate Acquisition toolbar contains tools used to control the hardware 
on the ImageXpress Micro System.
If the Plate Acquisition toolbar is not currently loaded, click Window > 
Toolbars > Plate Acquisition.

Figure 6-10: Plate Acquisition toolbar 

Icon Description

Moves the stage up in one-well increments

Moves the stage down in one-well increments

Moves the stage forward in one-well increments

Moves the stage backward in one-well increments

Moves the stage forward in one-site increments

Moves the stage backward in one-site increments

Moves the stage to the load/eject position.

Current well and/or site position

Moves the Z position (focus) upward in single step 
increments

Moves the Z position (focus) downward in single step 
increments

Performs a very coarse auto focus on the current well 
position. The range covered in Find Sample is the same 
as the initial Find Sample when starting an Acquire.

Performs auto focus on the current well as configured 
for the current wavelength in the Autofocus plane of 
the Plate Acquisition Setup tool

Selects the wavelength to use for the snap or live image
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Acquires a single image of the currently in place well at 
the current settings for stage (XY-position), focus (z-
position), wavelength, well, site, and exposure

Show Live continuously acquires images based on the 
current settings, and updates the image as settings are 
changed

Loads the selected settings from an existing screening 
settings file. Settings files are stored either in the 
database or on the file system. When you click Load 
Settings, the Load Screen Acquisition dialog appears. 
Check the boxes for the conditions and groups of 
settings that you want to load from the settings file, 
clear the ones that you do not want to load

Screen Summary lists the current settings selected for 
your acquisition, the number of selected wells, the 
number of sites in each well, the distance between 
images, the number of wavelengths, the total number 
of images, the amount of storage required, and the 
specified type of focusing for each wavelength for both 
the first and the remaining sites in the well

Previews the current display and exposure settings by 
opening the Plate Acquisition Status dialog and 
autofocusing and acquiring an image for each 
wavelength. After all images have been acquired, you 
can change the configuration of the display by 
repositioning the image windows and dialog and 
changing the size, scaling, and LUT of images. These 
new settings will be saved and used during acquisition

Starts the sequential acquisition of images from a plate 
based on the settings made in Plate Acquisition Settings 
dialog

Figure 6-10: Plate Acquisition toolbar (cont’d)

Icon Description
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7
Customizing the MetaXpress Software 
Application
A powerful feature of the MetaXpress® Software is the ability to 
customize the operation of the software for your users. Different 
objectives and workflows call for customized settings that can be 
switched as needed. Applications within the MetaXpress Software 
application, such as the Meta Imaging Series Administrator and the 
Create Taskbar command, allow you to create settings that match the 
needs of your users. The following topics will be covered in this section:

• Users and Groups in the Meta Imaging Series Administrator
• Custom Toolbars and Taskbars
• Default Paths for Data

Users and Groups in the Meta Imaging Series Administrator
The Meta Imaging Series Administrator commands enable you to define 
and configure settings for individual users and groups in the MetaXpress 
Software application. There are two modes for the Administrator: 
Single-User Mode and Multi-User Mode.
In Single-User mode, the Administrator enables you to select hardware 
settings and configure drop-ins and toolbars for groups that have already 
been created. In Multi-User mode, you create new groups, add users to 
different groups, and define hardware settings for groups. As a System 
Administrator, you will be working in Multi-User mode, creating groups 
and users for your MetaXpress system. For detailed instructions on 
setting up users and groups, refer to the online help for the Meta 
Imaging Series Administrator.

Note: The concepts of users and groups discussed in this chapter are 
specific to custom hardware and drop-ins/toolbars settings for the 
MetaXpress Software application. They are NOT related in any way to 
configuring users and groups within the database. For information on 
setting up users and groups with the database, refer to the MDCStore 
High Content Data Management Solution Database Schema Installation 
and Update Guide included on the MetaXpress Software installation USB 
flash drive.
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Your ImageXpress Micro System ships with a number of groups and 
hardware settings predefined. The number of groups depends on the 
configuration of your system. Figure 7-1 shows the Multiple User 
Configuration screen in the Meta Imaging Series Administrator.

Figure 7-1: Sample of the Multiple User Configuration screen

This sample shows a system with the following groups defined:
 MetaMorph: This is the default MetaMorph® Software 

application group. 
 MetaXpress: This is the ImageXpress Micro System and 

MetaXpress Software application group.
 MetaXpress Robot: The hardware settings in this group 

enable the optional CRS robot to be used with the 
MetaXpress system.

To enable a group (that is, to use the hardware and software settings 
created for a group), you must create users and assign them to the group.

Note: For more information on creating users and groups in the Meta 
Imaging Series Administrator, refer to the application help (press F1 to 
access the help).
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Creating an Offline Version of the MetaXpress 
Software Application
Molecular Devices recommends creating an offline group for MetaXpress 
Software users. This offline group has no hardware settings and is useful 
for analysis of acquired images. Since the offline group has no hardware 
settings, it does not attempt to establish communication with the other 
MetaXpress components. This allows the application to start faster, and 
allows you to run the software without turning on any hardware. Use the 
following procedure to create an offline MetaXpress group in the Meta 
Imaging Series Administrator:

1. From the Windows Start menu, click All Programs > MetaXpress 
> Meta Imaging Series Administrator. 
The Meta Imaging Series Administrator program opens.

2. If the program opens in Single User Configuration mode, click Enter 
Multi-User Mode.

3. Click Create Group. 

Figure 7-2: Create Group dialog

Note: You must exit the MetaXpress Software application before using 
the Meta Imaging Series Administrator. The two programs cannot run at 
the same time.

Note: For additional information about any of the dialogs in the Meta 
Imaging Series Administrator, press the F1 key to access the application 
help for the active dialog.
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4. In the Create Group dialog, type a group name into the Group 
Name field, for example, MetaXpress Offline.

5. Select MetaXpress from the Application field.
6. Select Offline from the Hardware Configuration field.
7. Select None from the Copy Settings From field.
8. Click Create.

The Create Group dialog closes and the new group is listed in the 
Groups field.

9. Select the new group in the Groups list, select a user from the Users 
list, and then click <<Add Users to add the user to the new group. Add 
users to the groups as needed.

10. Click OK to exit the Meta Imaging Series Administrator program.

Creating Group Icons and Adding Them to the 
MetaXpress Software Desktop
After creating the MetaXpress Offline group and adding users using the 
above procedure, you should use the Create Icons command to create 
icons for the new group. This command installs shortcuts for any new 
groups to the Meta Imaging Series folder on the MetaXpress Software 
desktop. These shortcuts can then be copied directly to the MetaXpress 
Software desktop. This enables users to choose which version to start 
from the desktop. Use the following procedure to create and add group 
icons to the MetaXpress Software desktop:

Note: You must add at least one user to the new offline group 
for it to be available.
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1. From the Windows Start menu, click All Programs > MetaXpress 
>Meta Imaging Series Administrator. 

2. In the Meta Imaging Series Administrator, click Create Icons to create 
the icons. 

3. Click OK to exit the Meta Imaging Series Administrator.
4. Double-click the MetaXpress 5.0 shortcut on your desktop.
5. In the MetaXpress 5.0 folder, confirm that a shortcut for the group that 

was created in the Creating an Offline Version of the MetaXpress 
Software Application on page 167 is listed.

6. Select and right-click the shortcut (for example, MetaXpress Offline), 
and then select Send To > Desktop. 
The shortcut is created on the desktop.

7. Double-click the desktop shortcut to open that instance of the 
application.

8. Repeat Step 6 as needed to add other shortcuts to the desktop.

Custom Toolbars and Taskbars
Now that you have the groups configured and the icons on the desktop, 
you can create or modify custom toolbars and taskbars to include specific 
combinations of tools and commands.

Customizing Toolbars
With the Configure Dropins/Toolbars command, you can add menu 
commands to toolbars, move commands from one tool bar to another, 
and add or remove journals to toolbars. Use the following procedure to 
customize the toolbars:

1. From the Windows Start menu, click All Programs > MetaXpress 
> Meta Imaging Series Administrator.

2. In the Meta Imaging Series Administrator, select the group that you 
want to edit the toolbar in from the Groups list and click Edit Group.

3. In the Edit Group dialog, click Drop-ins/Toolbars. 
4. In the Configure Dropins/Toolbars dialog, click the Toolbars tab, and 

clear the Use default toolbars checkbox.
5. Select Menus to add menu commands to toolbars.

OR
Select Toolbars to add toolbar commands to other toolbars.
OR
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Select Journals to add journals to any toolbar or to create new 
Journal toolbars.

6. To add any command to a toolbar, click and drag a command from the 
left window to the appropriate toolbar folder in the right window.

7. Click OK when finished. 
8. Click Yes in the dialog to confirm that you want the users in the group 

to use the modified configuration.
9. Click OK to exit the Edit Groups dialog.
10. Click OK to exit the Meta Imaging Series Administrator. 

The modified toolbars will be available the next time you start 
the corresponding version of the MetaXpress Software 
application.

Creating Taskbars
Taskbars are created directly in the MetaXpress Software application and 
are a convenient way to access frequently used commands and journals. 
Each taskbar can consist of up to 48 buttons in a configuration of rows 
and columns of your choosing. You can mix and match journals, 
commands, or other taskbars within the same taskbar. Taskbars differ 
from toolbars in that they enable you to add journals as well as 
commands. Molecular Devices recommends creating taskbars that 
combine commands and journals specific to your experiments. Use the 
following procedure to create and load a taskbar.

Note: You can use the Control or Shift keys in combination with 
a mouse click to select multiple commands, and then drag the 
commands to the appropriate toolbar folder.
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1. Start the MetaXpress Software application.
2. Click Journal > Taskbars > Create Taskbar. 

In the simplified menu, click Control > Journal > Taskbars > 
Create Taskbar.

3. When the Taskbar Editor dialog and New Taskbar window open, 
position them so that you can see both the dialog and the 
window at the same time.

4. Select the number of rows and columns for the taskbar by dragging the 
thick border of the New Taskbar window until the desired number of 
rows and columns appear in the window. 

5. Select the width of the buttons in the taskbar by dragging the thick 
border of the active button until the buttons are the desired width.

6. Select the desired category for the first item you want to add to the 
taskbar from the Category group.

7. When you have located the item you want to add to the taskbar, 
double-click its entry in the list to add it to active button in the taskbar 
as shown in Figure 7-3. 

Figure 7-3: Adding a function to a taskbar

Note: If you selected Journal or Taskbar as the Category, the 
directory names are displayed in square brackets in the list box 
below Category. Double-click a directory name to display the 
appropriate files in that directory or double-click the double 
period (..) to go up one level in the directory structure.
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8. Repeat Step 6 and Step 7 for each item you want to add to the taskbar. 
9. If necessary, click Undo to undo the last command or click Clear Button 

to clear an item from the active button.
10. If you want to rename the taskbar, click Rename Taskbar, and type the 

new name in the Taskbar Title field of the Rename Taskbar dialog. Click 
OK.

11. Click Save, and type a name in the File Name field of the Save As 
dialog. Navigate to the appropriate drive and folder, if necessary. Click 
Save.

12. To use the new taskbar (or a different taskbar) immediately, click 
Journal > Taskbars > Load Taskbar. Select the desired taskbar file and 
click Open.

13. Click Close to close the Taskbar Editor dialog.

Default Paths for Data
The Configure Default Paths command in the MetaXpress Software 
application is used to change the default file paths for each group or user. 
You can modify these paths so that the users on the system have their 
own dedicated data folders. These folders contain log files, calibration 
settings, and other data unique to each user. Molecular Devices 
recommends changing the following default paths on a MetaXpress 
system:

• Default Data Paths: Your MetaXpress computer has a dedicated 
hard drive partition for data. The default data file paths for each 
user should all point to this data drive. For example: 
D:\Data\Bob. The following data file types should have their file 
paths changed to point to the data drive:
 Log files
 Memory lists
 Calibrations

• Default HTS State Path: The MetaXpress settings file path should 
also point to the data drive. For example: D:\MX\HTSSTATE\.

• Default Assay Path: This path should point to an assay folder on 
the root directory of your C drive. For example: C:\Assay\.

Note: The MetaXpress settings file is saved to the database by 
default.
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Use the following procedure to edit the default data paths for a group:
1. Start the MetaXpress Software application.
2. Click Edit > Configure Default Paths.

Figure 7-4: Configure Default Paths dialog

3. In the Configure Default Paths dialog, select the item whose default 
file path you want to modify.

4. Click Modify.
5. When the Browse for Folder dialog, select the folder that you want to 

use for the new default path, or click New to create a new folder.
6. Click OK.
7. In the Configure Default Paths dialog, click OK to apply the new default 

path and close the dialog.

Note: Molecular Devices recommends making monthly backups 
of the Data, HTS State, and Assay files.
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8
Maintaining the ImageXpress Micro 
Instrument
User Safety Instructions 
To avoid personal injury or damage to your equipment during user 
service and maintenance, it is important to strictly observe the safety 
information outlined below: 

• Ensure that the power supply for the ImageXpress® Micro 
instrument is turned OFF and that the power cable is unplugged. 
If the MetaXpress® Software is running, first exit the program 
before turning off the instrument. 

• Disconnect the USB connection to the hardware server (host) PC, 
and turn off any attached peripherals, such as the robot plate-
loading arm. 

• Access ONLY the user-serviceable components inside the 
enclosure. Avoid contact with other components as they can be 
damaged or knocked out of alignment.

CAUTION! Be sure not to touch the autofocus laser. 

• Keep liquids, vapor, and dust well away from the interior of the 
instrument. Do not attempt to clean inside the enclosure. 

• Do not leave the interlocked access panels open for extended 
periods of time. 

• Ensure all components and access panels are replaced before 
restarting the instrument. 

Light Source
The ImageXpress Micro System is equipped with an external light source. 
The light source for the Standard model of the ImageXpress Micro 
System is equipped with a fuse-protected 300 W Xenon lamp. 

Note: The XL model of the ImageXpress Micro System is equipped with 
an external solid-state light source that has a rated lifetime of more than 
15000 hours. There are no user-replaceable parts in this light source.
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Changing the Lamp
When it is time to replace the lamp in the ImageXpress Micro System 
light source, be aware that the entire lamp assembly must be replaced, 
and not the bulb alone. For the Xenon lamp, this includes the bulb and 
heat sink.
Instructions for changing the lamp are available in the Molecular Devices 
knowledge base. Visit www.moleculardevices.com and follow the links to 
the knowledge base.

Changing the Light Guide
A liquid light guide couples the light from the light source to the 
illumination optics in the ImageXpress Micro System unit. The light 
source assembly is precisely aligned with the light guide during 
manufacture, and requires no further position adjustment. However, the 
light guide needs to be replaced if it is worn or damaged.
Instructions for replacing the light guide are available in the Molecular 
Devices knowledge base. Visit www.moleculardevices.com and follow 
the links to the knowledge base. 

Changing the Light Source Fuse 
The ImageXpress Micro System light source ships with a spare fuse, if 
applicable. 
Instructions for replacing the fuse are available in the Molecular Devices 
knowledge base. Visit www.moleculardevices.com and follow the links to 
the knowledge base. 

Replacing the Shutter (standard model only)
A solenoid-activated mechanical shutter controls the exposure of the 
sample to excitation light to minimize sample degradation and 
photobleaching. The shutter has an expected lifetime of 1 million cycles.
Instructions for replacing the shutter are available in the Molecular 
Devices knowledge base. Visit www.moleculardevices.com and follow 
the links to the knowledge base. 

WARNING! In the event that a lamp requires replacement, ensure 
that you have allowed the lamp to cool for at least 30 minutes. The 
lamp generates an extreme amount of heat and attempting to remove 
the lamp immediately after use can result in injury. 
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Filters Cubes 
If you decide to replace or add to any of the optical components in the 
factory-standard ImageXpress Micro instrument, there are two 
procedures that need to be completed: 

• Changing the component within the instrument.
• Updating the software to reflect the new hardware 

configuration. 

Changing Filter Cubes 
The ImageXpress Micro instrument’s filter cubes are mounted in a five-
position slider within the instrument enclosure. Filter cubes are delicate 
components, and special care is required when handling them. Please 
follow these outlined instructions for adding or replacing a filter cube. 
You can leave the lamp powered on during this procedure. 

CAUTION! We advise wearing powder-free gloves during the following 
procedure to prevent skin oils from damaging optical coatings. Read and 
follow the User Safety Instructions on page 175 for safe user-service 
procedures. 

1. From the Windows Start menu, click All Programs > MetaXpress 
Meta Imaging Series > Meta Imaging Series Administrator. 

2. Click Configure Hardware. 
3. Click Configure Devices. 
4. Select ImageXpress Micro Filter Cube Changer. 
5. Click Settings. 
6. Click the Eject Filter Cubes button. 
7. Close the Meta Imaging Series Administrator program. 
8. Power OFF the ImageXpress Micro instrument at the main power 

switch, which is located on the external power supply. 
9. Open the door on the front of the instrument that allows access 

to the filter cube changer. 
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10. Pull up on the front latch to release the filter cube cassette from the 
filter cube changer. 

Figure 8-1: Removing filter cubes

11. Remove the filter cube cassette. 
12. Slide the new cube into place and lightly tighten the hex screw. 
13. Place a finger underneath the ejected filter cube changer in the 

instrument to hold it in place. Carefully line up the filter cube 
cassette with the changer, and push the filter cube cassette back 
into place until the latch engages.   

CAUTION! If you feel resistance while replacing the filter cube 
cassette, do not proceed. Remove it and recheck to make sure 
that it is lined up correctly with the changer. 

14. Power ON the ImageXpress Micro instrument at the main power 
switch, which is located on the external power supply. 

15. Update the software to reflect the new hardware configuration. 
See Updating the System After Adding or Replacing a Filter Cube 
on page 179.
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Updating the System After Adding or Replacing a 
Filter Cube 

After installing a new filter cube, you must update the filter settings in 
the Meta Imaging Series Administrator and then update settings within 
the main MetaXpress Software program.

Editing the Filter Settings in the Meta Imaging Series 
System Administrator
Complete the following procedure to update your filter settings:

1. From the Windows Start menu, click All Programs > MetaXpress 
Meta Imaging Series > Meta Imaging Series Administrator. 

2. Select MetaXpress from the List of Groups field.
3. Click Configure Hardware. 
4. Click Install System Devices. 
5. From the Installed Devices list, select ImageXpress Micro Filter 

Cube and click Settings. 

Figure 8-2: ImageXpress Cube Settings dialog

6. Edit the name of the filter cube you are adding or replacing in 
the appropriate Position Labels field.
5015321 C 179 



ImageXpress Micro Widefield High Content Screening System User Guide
7. Click OK to close the Install System Devices dialog and return to the 
Configure Hardware dialog.

8. In the Configure Hardware dialog, ensure that the hardware settings 
you are using are selected in the Hardware Settings list and then click 
Configure Devices. 
The User Settings hardware configuration dialog appears.

9. From the Claimed Devices list, select ImageXpress Micro Filter Cube 
and click Settings. 
The ImageXpress Micro Filter Cube Settings dialog appears.

10. Again, edit the name of the filter cube you are adding or 
replacing in the appropriate Position Labels field.

11. Click OK to close the User Settings dialog and return to the 
Configure Hardware dialog.

12. Click OK to exit each dialog and close the Meta Imaging Series 
System Administrator.

Updating Illumination Settings
Complete the following procedure to update illumination settings within 
the MetaXpress Software application:

1. Open the MetaXpress Software application and log into the 
database.

2. Click Devices > Configure Illumination.
In the simplified menu, click Control > Devices > Configure 
Illumination.

3. In the Configure Illumination dialog, ensure that the illumination 
device you changed is selected in the Device Positions field and 
select the filter that you installed from the corresponding option 
field. See Figure 8-3 on page 181.

Note: The next steps involve entering the values again, this time 
starting from the Configure Devices dialog. This is to ensure that 
the settings carry over for all hardware profiles.
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Figure 8-3: Configure Illumination dialog

4. Select the ImageXpress Micro Shutter checkbox and select Open 
for the shutter. If you are doing a florescence experiment with 
transmitted light, select Closed.

5. Enter the name of the new filter in the Name field.
6. Enter the emission wavelength of the new filter in the 

Wavelength field.
7. Click Add/Replace to add this setting to the Defined Settings list.
8. If you replaced a filter with an existing setting, select the old 

setting from the Defined Settings field and click Remove.
9. After the settings are updated, click Backup.
10. Click Close.

Objectives
If you decide to add or replace any of the optical components in the 
factory-standard ImageXpress Micro System, there are two parts to the 
procedure: 

• Changing the component within the instrument. 
• Updating the software to reflect the new hardware 

configuration.

CAUTION! Read the section Correct Objective Placement before 
installing or replacing an objective.
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Correct Objective Placement
Molecular Devices recommends that users place the ELWD objectives 
(20X, 40X, 60X) or any other objective with a correction collar in one of 
the two outer positions (1 or 4) so that the correction collar can be 
accessed from one of the side panels. 

Changing Objectives
The ImageXpress Micro instrument’s objectives are mounted in a four-
position linear selector. Objectives are very delicate components, and 
special care is required when handling them. Objectives can be added or 
replaced by following these steps. 
You can leave the lamp powered on during this procedure. 

CAUTION! We advise wearing powder-free gloves during the following 
procedures to prevent skin oils from damaging optical coatings. 

1. Read and follow the User Safety Instructions on page 175 for safe 
user-service procedures. 

2. Read and follow Correct Objective Placement on page 182. 
3. In the MetaXpress Software or the Meta Imaging Series 

Administrator move the objective changer to an appropriate 
position for installing the objective. 
 Selecting position 1 (the position on the right) moves the 

objectives to the left. 
 Selecting position 4 (the position on the left) moves the 

objectives to the right. 
4. Exit the MetaXpress Software and turn off the ImageXpress 

Micro instrument at the main power switch, which is located on 
the instrument's external power supply. 

5. Place the new objective in its protective casing on a clean work 
area surface near the front of the ImageXpress Micro 
instrument. 
While moving objectives in and out, beware of the free-moving 
stage. It slides around loosely when the instrument is powered 
off. This can be a hazard to the objective in your hand. 

6. Remove the left or right (as appropriate) side panel of the 
instrument by grasping the handle, pulling it away from the 
instrument, and supporting the back of the door with your other 
hand. 

7. Reach in and unscrew any objective you want to remove. 
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 To access position 2, you need to remove the objective in 
position 1. 

 To access position 3, you need to remove the objective in 
position 4. 

8. Set the objective’s correction collar, if applicable. 
9. Reach in and screw in the objective. 
10. Replace the side door by aligning the tabs at the back of the 

door, and then snapping the front of the door into place. 
11. Turn ON the ImageXpress Micro instrument at the main power 

switch, which is located on the instrument's external power 
supply. 

12. Update the software to reflect the new hardware configuration. 
See Updating the System After Adding or Replacing an Objective 
on page 184.

Cleaning Objectives 
In the event that debris or contaminants have collected on an objective, 
follow these instructions for cleaning the objective lens: 

1. Read and follow the User Safety Instructions on page 175 for safe 
user-service procedures. 

2. In MetaXpress Software or the Meta Imaging Series 
Administrator Software select the desired objective.   

3. Open the top door. 
4. Exit MetaXpress Software and turn off the ImageXpress Micro 

instrument at the main power switch, which is located on the 
instrument's external power supply. 

5. To remove dust, use compressed air to blow dust contaminants 
off objectives. 

CAUTION! Do not use a product that disperses aerosol 
propellants or fluid onto the lens surface. 

CAUTION! Do not invert the compressed air can, as that 
disperses aerosol propellants. 
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6. To wipe the objective free of contaminants, use lens paper and solvent 
of choice. If unsure which solvent to use, consult the objective 
manufacturer for preferred cleansing solvent and procedure. 

CAUTION! Do not use Kimwipes to wipe a lens. 

Using Oil-Immersion Objectives 
Oil-immersion objectives can be used with the ImageXpress Micro 
System for research-mode imaging. Please consult with your sales 
representative for ordering information. 
To apply oil to the objective: 

1. Eject the plate to open the top door.   
2. Remove any plates in the system.   
3. Sparingly add oil to the top of the appropriate objective using a 

dropper bottle.   
4. Insert the sample, either with a thin glass coverslip or in a 

microplate with a thin glass bottom. Oil-immersion objectives 
are not compatible with plastic microplates.   

In the MetaXpress Software, slowly step up the objective until you are 
near to focus. Please note that oil-immersion objectives are not 
recommended for scanning entire microplates. 
When you are done with the oil-immersion objective, eject the plate, 
remove the sample, and clean the top of the objective with a piece of 
lens paper. 

Updating the System After Adding or Replacing an Objective 
After installing a new objective, you must update the objective settings in 
both the Meta Imaging Series Administrator and the main MetaXpress 
Software program. If the objective you are replacing was the one used to 
determine the plate bottom reference point, you will also need to repeat 
the procedure Determining the Plate Bottom Reference Point after 
Changing the Reference Objective on page 190, or contact Technical 
Support. See Obtaining Support on page 34.
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Editing the Objective Settings in the Meta Imaging 
Series System Administrator
Complete the following procedure to update your objective settings and 
enter Maintenance Mode:

1. From the Windows Start menu, click All Programs > MetaXpress 
> Meta Imaging Series Administrator.

2. Select MetaXpress from the List of Groups field.
3. Click Configure Hardware. 
4. Click Install System Devices. 
5. Select ImageXpress Micro Objective from the Installed Devices list and 

click Settings. 

Figure 8-4: ImageXpress Objective Settings dialog

6. If necessary, edit the text in the Objective # field for the new 
objective.

7. Change the Refractive Medium/Index value if needed.
8. Enter the numerical aperture for the new objective in the 

corresponding Num. Aperture field (the value is written on the 
objective).
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9. Click OK to close the ImageXpress Micro Objective Settings 
dialog.

10. Select ImageXpress Micro from the Installed Devices list and 
click Settings. 

11. In the ImageXpress Micro Settings dialog, ensure that the 
Parameter Group #1 tab is active and select the Maintenance 
Mode check box.

12. Click OK, and then click OK again as needed to return to the 
Configure Hardware dialog.

13. In the Configure Hardware dialog, ensure that the hardware 
settings you are using are selected in the Hardware Settings list 
and then click Configure Devices. 

14. In the User Settings hardware configuration dialog, double-click 
ImageXpress Micro Objective in the Claimed Devices list. 

15. In the ImageXpress Micro Objective dialog, enter the same 
information about the new objective that you entered in Step 6 
and Step 8.

16. Click OK, and then click OK as needed to exit the Meta Imaging 
Series Administrator and continue to Configuring Parfocality 
after Changing Objectives on page 186. 

Configuring Parfocality after Changing Objectives
To configure parfocality, you must use the MetaXpress Software 
application to find valid focus values for each objective and then enter 
them into the MetaXpress Objective dialog in the Meta Imaging Series 
System Administrator. See Table D-1: Recommended Filter set/FFC plate 
combinations on page 217. Complete the following procedure to 
configure parfocality:

Note: Make a note of the values you entered in Step 6 and 
Step 8. You will need to enter this information again for your 
specific hardware settings.

Note: The next steps involve entering some of the values again, 
this time starting from the Configure Devices dialog. This is to 
ensure that the settings carry over for all hardware profiles.
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1. Open the MetaXpress Software application.
2. Open the following dialogs:
 Devices > Configure Magnification

In the simplified menu, click Control > Devices > 
Configure Magnification.

 Acquire > Acquire
In the simplified menu, click Control > Acquire > 
Acquire.

 Devices > Stage > Move Stage to Absolute Position
In the simplified menu, click Control > Devices > 
Move Stage to Absolute Position.

3. If the following toolbars are not open, click Window > Toolbars, or In 
the simplified menu, click Control > Window > Toolbars, and select 
Device Control and Plate Acquisition.

4. Click Devices > Configure Magnification.
5. If not selected, select the check box next to the ImageXpress Micro 

Objective.

Figure 8-5: Configure Magnification dialog

6. Select the objective with the highest numerical aperture (NA) 
that is in position #1 from the field.

7. Select the FITC (or other visible light) illumination setting from the 
Illum field on the Device Control toolbar, as shown in Figure 8-6 on 
page 187.

Figure 8-6: Partial Device Control toolbar
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8. Click the Stage Load/Eject button on the Plate Acquisition toolbar to 
move the stage to the load position.

9. Load the bead plate that shipped with the instrument on to the stage, 
and then click the Stage Load/Eject button again to return the stage to 
its previous position.

10. In the Acquire dialog, click Show Live to open a live image window.
11. In the Move Stage to Absolute Position dialog, use the Current 

Position X, Y, and Z controls to find and focus a sample in the live image 
window.

Figure 8-7: Move Stage to Absolute Position dialog

12. When the sample is in focus, write down the Current Position Z 
value in the Focus Value column in Table 8-1 on page 188.
Table 8-1: Objective Focus Value

Objective Number Focus Value

1
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13. Use the field in the Configure Magnification dialog to switch to the 
objective in position #2 with the next highest NA.

14. Repeat Step 9 to Step 12 for each objective, writing down the focus 
values for each in Table 8-1. You will use these values to determine the 
Z-offsets for each objective (which is different than configuring Z offsets 
for laser autofocus).

15. After you have written down the focus values, close the MetaXpress 
Software application.

16. If the objective you are changing was the one used to determine the 
plate bottom reference point, see Determining the Plate Bottom 
Reference Point after Changing the Reference Objective on page 190.
OR
If the objective was NOT the one used to determine the plate 
bottom reference point, see Entering the Plate Bottom 
Reference Objective Value in the MetaXpress.ref Configuration 
File on page 195.

2

3

4

Table 8-1: Objective Focus Value

Objective Number Focus Value

Note: You will need to refer to these values later in subsequent 
procedures.

Note: It is important that you use the same filter set for all 
objectives.

Note: Since you found the X and Y coordinates of the sample in 
Step 11, you need to change only the Z position for each 
additional objective.
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Determining the Plate Bottom Reference Point 
after Changing the Reference Objective
The plate bottom reference point is a setting that the MetaXpress 
Software application uses for autofocusing. It is set when your system is 
configured before shipment. The reference point is determined using a 
particular objective (usually 10x) in a specific objective position. If you 
change this objective, you must determine the new plate bottom 
reference point and enter this value in the Meta Imaging Series 
Administrator.

The objective position used for this setup is specified in a line of the 
system calibration file MetaXpress.ref, located in the Hardware folder of 
your root install directory (C:\MX6\Hardware by default). The line is:

PlateBottomReferenceObjective=X
where X is the position of the objective used. If you need to update the 
plate bottom reference point, the value in the calibration file must also 
be updated. 
Complete the following procedure to determine both the plate bottom 
reference objective and the plate bottom reference point. 

1. Enter Maintenance mode. For information on how to enter 
Maintenance mode, see Editing the Objective Settings in the 
Meta Imaging Series System Administrator on page 185.

2. Remove any plates from the stage, and load one of the flat-field 
correction (FFC) plates that shipped with your system.

Note: Molecular Devices recommends that you leave the reference 
objective in place and only replace other objectives.

Note: Molecular Devices recommends that you contact Technical 
Support before attempting this procedure. See Obtaining Support on 
page 34.

Note: You do NOT need to perform this procedure unless you replaced 
the reference objective. If you did not replace the reference objective, 
see Editing the Objective Settings in the Meta Imaging Series System 
Administrator on page 185.
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3. Click Device > Configure Magnification.
in the simplified menu, click Control > Devices > Configure 
Magnification.

Figure 8-8: Configure Magnification dialog with objective # 
highlighted 

4. In the Configure Magnification dialog, select the objective you want to 
use as the reference from the field, and write down the plate bottom 
reference objective number (highlighted in Figure 8-8) in Table 8-2.

5. Close the Configure Magnification dialog. If a dialog appears 
prompting you to replace the stored setting, click No.

6. Open the following dialogs if they are not already open:
 Devices > Stage > Move Stage to Absolute Position

In the simplified menu, click Control > Devices > 
Move Stage to Absolute Position.

 Devices > Focus

Table 8-2: Plate Bottom Reference Objective

Plate Bottom Reference Objective

Note: You will refer to this value in Entering the Plate Bottom 
Reference Objective Value in the MetaXpress.ref Configuration 
File on page 195.
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In the simplified menu, click Control > Devices > 
Focus.

7. In the Move Stage to Absolute Position dialog, type 8000 in the 
Current Position: Z field and press Enter to move the Z-motor.

8. Type 64000 in the Current Position: X field and 33000 in the 
Current Position: Y field and press Enter to move to the 
approximate center of the plate.

9. In the Focus dialog, click Autofocus > Configure Laser.

Figure 8-9: Configure Laser Autofocus dialog

10. In the Configure Laser Autofocus dialog, select Start from 
current z-position.

11. Set the Full range value to 1000 microns (μm).
12. Set the Exposure 1st surface value to 10 microseconds (μs).
13. Set the Coarse step value to 10 microns (μm).
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14. On the Autofocus tab of the Focus dialog, click Preview Pass. 
A window opens displaying a graph of focus intensities vs. 
Z-position. Ideally, the graph should contain a sharp peak, made 
up of a red line and a green line, as shown in Figure 8-10.

Figure 8-10: Preview Pass dialog

15. If there is a peak in the graph, go to Step 16. If there is no peak, try the 
following:
 In the Focus dialog, increase the Current Position value by 

1000 and click Preview Pass. Repeat as needed until you 
cover a range between 8000 and 12000. If there is a peak in 
the graph, go to Step 16. If there is no peak, continue to the 
next step.

 Try moving to a new area of the FCC plate and repeat 
Step 14. If you still cannot find a peak after moving to a new 
area of the FCC plate twice and covering a z-range from 8000 
to 12000, contact Technical Support. See Obtaining Support 
on page 34.

Note: The top of the red peak represents the brightest pixel of 
the preview pass. The top of the green peak represents the 
highest focus score.
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16. When you see a peak (or 2 peaks) on the preview pass, click the trace 
line at the top of the green line of the first peak. 
The X, Y position is displayed as a tool tip as shown in 
Figure 8-11. This gives the Z-position of the plate bottom. In this 
example, the current Z-position value is 9172.8.

Figure 8-11: Z-position of peak

17. Write down the Z-position value for the center position in Figure 8-3.

18. Repeat Step 7 through Step 17 for each corner of the FCC plate. 
Enter the X and Y values in Figure 8-3 into the Move Stage to 
Absolute Position dialog. Write down the Z-position values 
(rounded off) for each corner in the Z Value column of Table 8-3.

Table 8-3: Plate Bottom Reference Point

Position X Value Y Value Z Value

1 Center 64000 33000

2 Upper Left 150000 11000

3 Lower Left 150000 74000

4 Upper Right 114000 11000

5 Lower Right 114000 74000
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19. Circle the lowest Z value in Figure 8-3 on page 194. 
This value is the Plate Bottom Reference Point. You will refer to 
this value in Entering the Focus Objective Values in the Meta 
Imaging Series Administrator on page 196.

20. Exit the MetaXpress Software application and continue to Entering the 
Plate Bottom Reference Objective Value in the MetaXpress.ref 
Configuration File on page 195.

Entering the Plate Bottom Reference Objective Value in 
the MetaXpress.ref Configuration File
Complete the following procedure to enter the value in the 
MetaXpress.ref configuration file:

1. Click Start > All Programs > Accessories > Notepad and then 
open the MetaXpress.ref file in the MetaXpress Hardware folder 
(C:\MX6\Hardware by default).

2. Edit the following line in the file, replacing the number with the 
objective position you entered in Table 8-2 on page 191.
[system calibration]
PlateBottomReferenceObjective=4

3. Save the modified file and close Notepad.

Note: Only perform this procedure if you needed to complete 
Determining the Plate Bottom Reference Point after Changing the 
Reference Objective on page 190.

Note: Make sure that the copy of the MetaXpress.ref that you 
open is located in the Hardware folder of the MetaXpress folder 
(For example, C:\MX6\Hardware) and NOT in the root directory.

Note: Do NOT use the Save As option in Notepad, as this causes 
a .txt extension to be added to the saved .ref file.
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Entering the Focus Objective Values in the Meta Imaging 
Series Administrator
The next step is to open the Meta Imaging Series Administrator and enter 
the values you recorded in the previous procedures. You also need to 
turn off Maintenance mode before you can continue to configure the 
device. Complete the following procedure to turn off Maintenance mode 
and enter the values in the Meta Imaging Series Administrator.

1. Start the Meta Imaging Series System Administrator.
2. Click Configure Hardware, and then click Install System Devices. 
3. Double-click ImageXpress Micro in the Installed Devices list. 
4. Clear Maintenance Mode.
5. Click OK to exit the ImageXpress Micro dialog
6. Double-click ImageXpress Micro Objective in the Installed 

Devices list. 

Figure 8-12: ImageXpress Micro Objective Settings dialog

7. Type the focus value for Objective #1 from Table 8-1 into the 
Position #1 Z Offset field.

8. Repeat Step 7 for Position #2 to 4 Z Offset fields.
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9. Click Normalize Offsets to calculate the offsets for each Z 
position.

10. Click OK to exit the ImageXpress Micro Objective dialog.
11. If you needed to complete the Determining the Plate Bottom 

Reference Point after Changing the Reference Objective on 
page 190, continue to Step 14.

12. OR
13. If you did not change or replace the reference objective, go to 

Step 18.
14. Double-click ImageXpress Micro Z in the Installed Devices list. 
15. The ImageXpress Micro Z dialog appears.
16. Type the value you circled in Step 19 of the Determining the 

Plate Bottom Reference Point after Changing the Reference 
Objective on page 190 into the Plate Bottom Reference field.

17. Click OK to exit the ImageXpress Micro Z Settings dialog, and 
then click OK to return to the Configure Hardware dialog.

18. From the Configure Hardware dialog, ensure that the hardware 
settings you are using are selected in the Hardware Settings list 
and then click Configure Devices. 

19. The User Settings hardware configuration dialog appears.

Note: The Position 1-4 Z Offsets refer to Objective numbers 1-4 
and are not in order of magnification. Refer to the Objective 
Labels fields to match the objective number with its 
magnification.

Note: In some cases, there might not be an objective in each 
position of the turret. If this is the case, enter the focus value for 
the highest magnification objective that you do have in each of 
the empty Position 1-4 Z Offset fields. Do not leave any of these 
values as 0.

Note: The next steps involve entering some of the values again, 
this time starting from the Configure Devices dialog. This is to 
ensure that the settings carry over for all your hardware profiles.
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20. Double-click ImageXpress Micro Objective in the Claimed 
Devices list. 

21. The ImageXpress Micro Objective dialog appears.
22. Edit the Objective Labels, Refraction Medium/Index, and Num. 

Aperture fields with the same values you entered in Step 6 to 
Step 8 of Editing the Objective Settings in the Meta Imaging 
Series System Administrator on page 185.

23. Repeat Step 7 through Step 9 to enter and normalize the Z 
offsets.

24. If you needed to complete the Determining the Plate Bottom 
Reference Point after Changing the Reference Objective on 
page 190, double-click ImageXpress Micro Z in the Claimed 
Devices list and enter the Plate Bottom Reference number as in 
Step 16.

25. Click OK to exit each dialog and close the Meta Imaging Series 
System Administrator.

Updating Magnification and Calibration Settings
Complete the following procedure to update magnification and 
calibration settings within the MetaXpress Software application:

1. Open the MetaXpress Software application and log into the 
database.

2. Click Devices > Configure Magnification.
In the simplified menu, click Control > Devices > Configure 
Magnification.

3. In the Configure Magnification dialog, ensure that ImageXpress 
Micro Objective is selected in the Settings field and select the 
installed objective from the field.

4. Enter the name of the new objective in the Name field.
5. Click Add/Replace to add this setting to the Defined Settings list.
6. If you replaced an objective with an existing setting, select the 

old setting from the Defined Settings field and click Remove.
7. After the settings are updated, click Backup.
8. Click Close to exit the Configure Magnification dialog.

Note: If you use more than one hardware profile, repeat Step 18 
to Step 23 as needed for each hardware profile.
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9. Click Measure > Calibrate Distances.
In the simplified menu, click Measure > Distances > Calibrate 
Distances.

10. In the Calibrate Distances dialog, click Setup.
11. Click New, type the name of your new objective in the 

Calibrations field, then press Enter.
12. When the fields in the lower half of the dialog become active, select 

Edit Units/Pix in the Define Calibrations By field.
13. Enter the calibration value for the new objective in the X and Y fields. 

The following estimated values can be used for ImageXpress Micro 
System calibration settings:

14. Select the new objective from the Magnification field.
15. Click Done.
16. After the settings are updated, click Save to file.
17. Click Close.

Table 8-4: Estimated Calibration Settings 

Objective Estimated Calibration

1x 6.50 μm/pixel

2x 3.25 μm/pixel

4x 1.63 μm/pixel

10x 0.65 μm/pixel

20x 0.33 μm/pixel

40x 0.16 μm/pixel

60x 0.12 μm/pixel

100x 0.07 μm/pixel

Note: For additional information on creating calibrations 
settings, refer to the application help available within the 
MetaXpress Software (press F1 when the Calibrate Distances 
dialog is open to access help). 
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Updating Shading Correction Settings 
This section explains how to run a journal to create shading correction 
files to use during plate acquisition in the MetaXpress Software 
application. Shading correction files are needed for each objective/filter 
combination and must be generated whenever an objective or filter is 
replaced or added to the system, or whenever the lamp or liquid light 
guide is replaced. You will need a flat-field correction (FFC) plate to focus 
the objective. 

This procedure assumes that if you have added or replaced an objective, 
you have already performed the following procedures.

• Editing the Objective Settings in the Meta Imaging Series System 
Administrator on page 185.

• Configuring Parfocality after Changing Objectives on page 186.
• Updating Magnification and Calibration Settings on page 198.

This section includes the topics:
• To import the journal suite into the MetaXpress Software on 

page 201
• To run the shading correction journal from the Main taskbar on 

page 203
You will need FFC plates appropriate for the filter sets you are using to 
generate the shading correction files. These plates are part of the 
accessory kit that shipped with the instrument. Remove the paper 

Note: The taskbar used for this procedure is the System Maintenance 
Taskbar.JTB which is part of the Main Taskbar.JTB. To determine if this is 
installed on your system, select Journal > Taskbar > Load taskbar, 
navigate to C:\MX6\Taskbars (or the directory where the current 
version of the software is installed) and then select the System 
Maintenance Taskbar.JTB file. If this taskbar is not installed on your 
system, contact Technical Support to obtain the journal suite file 
IXMTaskbar_v#.jzp.nal file, import it (See Obtaining Support on 
page 34.) After you have obtained the jour using the procedure in To 
import the journal suite into the MetaXpress Software on page 201.

Note: For shading correction images to be used during Plate 
Acquisition, the Perform shading correction checkbox must be selected 
in the Acquisition Loop tab of the Plate Acquisition Setup dialog.
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backing from each plate before use. Handle the plates by the edges to 
avoid getting fingerprints on the imaging surface. Never use alcohol or 
other solvents to clean the plates. You can use compressed air to remove 
dust from the plates. Table 8-5 lists the correction plate used for each 
filter set.

To import the journal suite into the MetaXpress Software 
Follow this procedure if the Main taskbar is not installed on your system. 
If the Main taskbar is installed, skip this section and proceed to To run 
the shading correction journal from the Main taskbar on page 203.
This procedure is easier to perform prior to creating additional groups 
(configurations) in the Meta Imaging Series Administrator. Once you have 
followed this procedure, you can then create additional groups by using 
the option to copy settings from an existing group.

1. Contact Technical Support to obtain the Journal Suite file, 
IXMTaskbar_v#.jzp (# is the current version of the software). 
See Obtaining Support on page 34.

2. Download the IXMTaskbar_v#.jzp file to the ImageXpress Micro 
System workstation.

3. Start and log in to the MetaXpress Software.
4. Click Journal > Import Journal Suite. 

In the simplified menu, click.
5. In the Import Journal Suite dialog, click Select Journal Suite. 
6. In the Select Import Suite File Name dialog, navigate to the 

IXMTaskbar_v#.jzp file and click Open. 

Table 8-5: Flat-field Correction Plates for each Filter Set 

FFC Plate Filter Set

DAPI Pink

Fura-2 Pink

CFP Pink

YFP Red

FITC Red

Cy3 Green

Rhodamine Red

Texas Red Red

Cy5 Red
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The path to the journal suite is displayed at the top of the Import 
Journal Suite dialog.

7. Click Select Import Location, and navigate to C:\MX6\TASKBARS 
and click OK. 
The path of the import location is displayed at the bottom of the 
Import Journal Suite dialog.

Figure 8-13: Import Journal Suite dialog

8. Click Import. 

9. Click Close.
10. Click Journal > Run Journal.
11. Navigate to C:\MX6\TASKBARS\Install, select the IXM Taskbar 

Installer.JNL file, and click Open.
12. In the Select System Type dialog, select either IXM (Standard) or 

IXM-XLS.
13. In the MetaXpress Directory, follow the prompts in the 

subsequent dialogs to confirm that the current version of the 
MetaXpress Software is installed in the correct directory 
(typically C:\MX6).

Note: There is no visual confirmation that the import is 
complete.
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14. In the Taskbar Installation Final Steps dialog, click Continue.
15. Click Journal > Journal Control > StartUp Journal.

In the simplified menu, click Control > Journal > Journal Control 
> StartUp Journal.

16. Navigate to C:\MX6\StartUp, select the startup journal (the name of 
the journal includes the appropriate ImageXpress Micro System model: 
Standard or XLS), and click OK.

17. Exit and restart the MetaXpress Software.
18. Click Journal > Recording Tools and confirm that the Pick Point option 

is listed. (It might be grayed out but it must be listed. If it is not listed, 
then contact Technical Support for assistance See Obtaining Support on 
page 34.)

19. Proceed to the next section to run the shading correction journal from 
the Main taskbar.

To run the shading correction journal from the Main taskbar
1. On the Main taskbar, select System Maintenance and then click Set up 

Shading Correction.
2. Follow the prompts to focus on the plates and create shading 

correction files.

Note: If the default file paths for journals, images, data, and so 
on do not go to the C:\MX6 folder, you will be prompted to reset 
them to go to that folder.

Note: Press <F4> on your keyboard to show or hide the taskbar 
that was most recently used.
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Adjusting the Spherical-Aberration Correction Collar on ELWD 
Objectives

The ELWD (extra long working distance) Nikon objectives that can be 
supplied with the ImageXpress Micro System have adjustable correction 
collars, used to minimize spherical aberration in the image of the 
specimen. The collars have a range of 0-2 mm correction, and changing 
this setting adjusts the distances between components inside the 
objective barrel. Image quality and resolution is largely dependent on 
properly setting these collars.
The settings to be used depend on the thickness of the microplate well or 
slide on which the specimen is mounted. In general, the correction collar 
should be set for the physical thickness of the plate or slide that you are 
imaging. The physical thickness can be determined by: 

• Obtaining the plate specifications from the plate manufacturer. 
• Smashing a spare plate and using calipers to measure the 

thickness. 
• Measuring the optical thickness with the laser autofocus and 

multiplying it by the refractive index (1.59 for polystyrene; 1.52 
for glass). 

After you have determined the thickness of your plate or slide, follow 
these steps to adjust a given correction collar:

1. Read and follow the User Safety Instructions on page 175 for safe 
user-service procedures. 

2. Follow the steps in Changing Objectives on page 182 for 
accessing the objective selector and lenses. If you put these 
objectives in the outer two positions, they can be accessed from 
the two side doors, which can be removed by hand. 

3. Locate the correction collar on the objective that you want to 
adjust.

4. Rotate the correction collar to its new setting.
5. Securely close the access doors.
6. Test the correction collar setting by examining the image quality 

of acquired images. If the quality has degraded, re-adjust the 
correction collar. 

Note: The graduated scale on the barrel and its current setting. 
You might have to use a flashlight to view the markings. 
204 5015321 C 



Maintaining the ImageXpress Micro Instrument
Cleaning the ImageXpress Micro System

The following procedure is designed to clean the plate-loading region of 
the instrument without damaging the internal components of the 
imaging system. 
To prevent damaging the instrument, please read and follow these 
precautionary guidelines carefully when cleaning your instrument:

• To protect the ImageXpress Micro System optics and electronics, 
do not remove the front panels of instrument during the 
cleaning procedure.

• Do not use any cleaning agents other than those recommended 
in this procedure without first contacting Molecular Devices 
Technical Support. See Obtaining Support on page 34.

• Do not use ultraviolet light for sterilization, as this can damage 
plastic components. 

• Do not use any organic solvents. 
• Do not pour or squirt water or alcohol directly onto the 

instrument, to prevent damaging internal components.
The following cleaning procedure is compatible with disinfectant wipes 
(or Kimwipes wipers with 70% ethanol).
You can leave the lamp powered on during this procedure.

To clean the ImageXpress Micro instrument 
1. Read and follow the User Safety Instructions on page 175 for safe 

user-service procedures.
2. In MetaXpress Software, open the instrument’s door. 
3. Exit the MetaXpress Software and turn off the ImageXpress 

Micro instrument at the main power switch, which is located on 
the instrument’s external power supply. 

4. Ensure that the side panels have not been removed, the filter 
cube access door is closed, and no sample is loaded. 

5. With gloved hands, use a damp wipe to wipe down the entire 
outer surface including side panels and top panels of the 
instrument. Then, use an alcohol wipe or a disinfectant wipe and 
go over the entire surface again. 

Note: This procedure does not guarantee that your instrument is 
decontaminated or sterile.
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6. Use forceps wrapped with Kimwipes to gently wipe the 
perimeter of the plate/stage region where a plate would 
normally be loaded. Wipe with damp Kimwipes first, and then 
with an alcohol or disinfectant wipe.

7. The stage is freely moving without power, so to clean the 
plate/stage region underneath where the plate is loaded, you 
can open the door and slide the stage around.

8. Use a fresh damp wipe to wipe down the stage area underneath 
and around the plate loading region, followed by wiping with an 
alcohol wipe or disinfectant wipe. 
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A
Operational and Environmental Specifications
Operational and environmental specifications are shown in Table A-1.
Table A-1: Operational and Environmental Specifications

Specification Measurement

Base Unit Weight 82 kg

Base Unit Dimensions 
(H x W x D)

490 mm x 460 mm x 800.5 mm

Mains Power Input 100 to 240 VAC, 50/60 Hz, 400 VA, 
2.0 A maximum

Options Controller 100 to 240 VAC, 50/60 Hz, 960 VA, 8 A

Camera Power Supply Standard: 100 to 240 VAC, 50/60 Hz, 240 VA, 
2.0 A
XLS: 100 to 240 VAC, 50/60 Hz, 120 VA, 1.0 A

Light Source Power Supply Standard: 100 to 240 VAC, 50/60 Hz, 360 VA, 
300 W
XLS: 100 to 240 VAC, 50/60 Hz, 288 VA, 2.5 A

Host Computer 100 to 240 VAC, 50/60 Hz, 690 VA, 5.8 A

Computer Monitor 100 to 240 VAC, 50/60 Hz, 35 W

Mains Voltage Fluctuations Not to exceed 10% of nominal supply voltage

Equipment Class 1

Pollution Degree 2

Installation Category 2

Operating Environment Indoor Use Only

Altitude Not to exceed 2000 m

Operating temperature 15°C to 30°C

Humidity 35% to 50% non-condensing

Ingress Protection IP20
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WARNING! If the ImageXpress Micro System is used in a manner not 
specified by Molecular Devices, the protection provided by the 
equipment might be impaired.

WARNING! The ImageXpress Micro System is an Equipment Class 1 
product that relies on protective earth grounding for safe operation. 
Any interruption of the protective earth ground conductor, inside or 
outside the instrument, or disconnection of the protective earth 
ground terminal can result in personal injury.

WARNING! Do not position the equipment so that it is difficult to 
operate the circuit breaker switches on the front of the equipment.

WARNING! For Environmental Control Options a tank or house 
CO2/air mixture (for example, 5% CO2/95% air) is required with an 
adequate CO2 regulator that can supply a maximum of 20 PSI (138 
kilopascal) to the CO2 inlet on the rear of the Options Controller. 
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B
Site Requirements
The ImageXpress® Micro System is designed to operate indoors under 
laboratory conditions. For optimal performance, site requirements must 
be met. As with any precision optical instrument, care should be taken to 
maintain a low-dust, low-vibration environment. Temperature and 
humidity extremes can compromise performance. 
Table B-1: Site Requirements

Item Description

Environmental Temperature 50° to 86° F (10° to 30° C). 

Environmental Humidity 5% to 95% non-condensing. 

Altitude Up to 1.25 miles (2000 m). 

Power Requirements The ImageXpress Micro System can be directly 
connected to all international supply voltages. 
The input voltage range is from 100 to 240 V~ 
and input frequency range 50 to 60 Hz. No range 
switching is required. Fluctuations must not 
exceed ±10% of the nominal voltage. Use the 
included IEC power cord to connect the external 
power supply to a GROUNDED power receptacle 
that is rated for 15 A. If using a power strip, do 
not connect the acquisition computer to the 
same power strip as the instrument and light 
source. 

Power Consumption ImageXpress Micro System power consumption 
is 1100 watts for 2 to 3 seconds at initialization, 
800 watts average operating RMS. 

Space Requirements Table or bench top 30 inches (76 cm) deep. 
There needs to be space below the table for the 
light source and power supply such that the 
light guide and power cable can easily reach the 
back of the instrument. 

Rear Clearance The rear of the instrument should be no closer 
than 6 inches (15 cm) to a wall. 

Weight Requirements Sufficient to support 180 lbs (82 kg) with 
minimal vibration. 
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C
Objectives Compatible with the 
ImageXpress Micro System
Table C-1 details the Nikon objectives that are compatible with the 
ImageXpress® Micro System. It also provides plate compatibility 
information.
Table C-1: Nikon Objectives Compatible with the ImageXpress Micro 
System 

Objective 
Magnificati
on and 
Type

Molecula
r Devices 
Part 
Number

Phase 
Contra
st

Numeric
al 
Apertur
e

Workin
g 
Distanc
e

Plate 
Compatibility

1x 
Plan 
Achromat

6500-
0119

No 0.04 3.2 mm Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt
Thick bottom 
(0.25 mm to 1 mm)1 

2x 
Plan Apo

1-6300-
0451

No .010 8.5 mm Thin bottom 
(0.17 mm)
Thin bottom 
(0.17 mm) No Skirt
Thick bottom 
(0.25 mm to 1 mm)

4x 
S Fluor

1-6300-
0189

No .020 15.5 m
m

Thin bottom 
(0.17 mm)
Thin bottom 
(0.17 mm) No Skirt
Thick bottom 
(0.25 mm to 1 mm)

4x 
Plan Apo

1-6300-
0121

No .020 15.7 m
m

Thin bottom 
(0.17 mm)
Thin bottom 
(0.17 mm) No Skirt
Thick bottom 
(0.25 mm to 1 mm)
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4x 
Plan Fluor DL

1-6300-
0292

Yes, PhL .013 16.2 m
m

Thin bottom 
(0.17 mm)
Thin bottom 
(0.17 mm) No Skirt
Thick bottom 
(0.25 mm to 1 mm)

10x 
Plan Fluor

1-6300-
0790

No .030 16.0 m
m

Thin bottom 
(0.17 mm)
Thin bottom 
(0.17 mm) No Skirt
Thick bottom 
(0.25 mm to 1 mm)

10x 
S Fluor

1-6300-
0122

No .050 1.2 mm Thin bottom 
(0.17 mm)
Thin bottom 
(0.17 mm) No Skirt
Thick bottom 
(0.25 mm to 1 mm)2 

10x 
Plan Apo

6500-
0120

No 0.45 4.0 mm Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt
Thick bottom 
(0.25 mm to 1 mm)

10x 
Plan Fluor 
DLL

1-6300-
0294

Yes, Ph1 0.30 16.0 m
m

Thin bottom 
(0.17 mm)
Thin bottom 
(0.17 mm) No Skirt
Thick bottom 
(0.25 mm to 1 mm)

10x 
Plan Fluor DL

1-6300-
0293

Yes, Ph1 0.30 15.2 m
m

Thin bottom 
(0.17 mm)
Thin bottom 
(0.17 mm) No Skirt
Thick bottom 
(0.25 mm to 1 mm)

Table C-1: Nikon Objectives Compatible with the ImageXpress Micro 
System (cont’d)

Objective 
Magnificati
on and 
Type

Molecula
r Devices 
Part 
Number

Phase 
Contra
st

Numeric
al 
Apertur
e

Workin
g 
Distanc
e

Plate 
Compatibility
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Objectives Compatible with the ImageXpress Micro System
20x 
Super Plan 
Fluor ELWD 
cc 0 mm to 
2 mm

6500-
0108

No 0.45 8.1 mm 
to 
7.0 mm

Thin bottom 
(0.17 mm)3 
Thin bottom 
(0.17 mm) No Skirt3 
Thick bottom 
(0.25 mm to 1 mm)

20x 
S Fluor

1-6300-
0411

No 0.75 1.0 mm Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt

20x 
Plan Apo

1-6300-
0196

No 0.75 1.0 mm Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt

20x 
Plan Fluor 
DLL

1-6300-
0295

Yes, Ph1 0.50 2.1 mm Thin bottom 
(0.17 mm) 
Thin bottom 
(0.17 mm) No Skirt 
Thick bottom 
(0.25 mm to 1 mm)2 

20x 
Super Plan 
Fluor ELWD 
DM cc 0 mm 
to 2 mm

6500-
0111

Yes, Ph1 0.45 8.1 mm 
to 
7.0 mm

Thin bottom 
(0.17 mm)3 
Thin bottom 
(0.17 mm) No Skirt3 
Thick bottom 
(0.25 mm to 1 mm)

40x 
Super Plan 
Fluor ELWD 
cc 0 mm to 
2 mm

6500-
0109

No 0.60 3.7 mm 
to 
2.7 mm

Thin bottom 
(0.17 mm)3 
Thin bottom 
(0.17 mm) No Skirt3 
Thick bottom 
(0.25 mm to 1 mm)

Table C-1: Nikon Objectives Compatible with the ImageXpress Micro 
System (cont’d)

Objective 
Magnificati
on and 
Type

Molecula
r Devices 
Part 
Number

Phase 
Contra
st

Numeric
al 
Apertur
e

Workin
g 
Distanc
e

Plate 
Compatibility
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40x 
Plan Apo

1-6300-
0412

No 0.95 0.14 m
m

Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt

40x 
S Fluor cc 
0.11 mm to 
0.23 mm

1-6300-
0197

No 0.90 0.3 mm Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt

40x 
Plan Fluor Oil

1-6300-
0416

No 1.30 0.2 mm Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt

40x 
Plan Fluor 
DLL

1-6300-
0297

Yes, Ph2 0.75 0.72 m
m

Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt

40x 
Super Plan 
Fluor ELWD 
ADM cc 
0 mm to 
2 mm

6500-
0112

Yes, Ph2 0.60 3.7 mm 
to 
2.7 mm

Thin bottom 
(0.17 mm)3 
Thin bottom 
(0.17 mm) No Skirt3 
Thick bottom 
(0.25 mm to 1 mm)

60x 
Super Plan 
Fluor ELWD 
cc 0.1 mm to 
1.3 mm

6500-
0110

No 0.70 1.8 mm 
to 
2.62 m
m

Thin bottom 
(0.17 mm)3 
Thin bottom 
(0.17 mm) No Skirt3 
Thick bottom 
(0.25 mm to 1 mm)

60x 
Plan Fluor

1-6300-
0414

No 0.85 0.3 mm Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt

Table C-1: Nikon Objectives Compatible with the ImageXpress Micro 
System (cont’d)

Objective 
Magnificati
on and 
Type

Molecula
r Devices 
Part 
Number

Phase 
Contra
st

Numeric
al 
Apertur
e

Workin
g 
Distanc
e

Plate 
Compatibility
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Objectives Compatible with the ImageXpress Micro System
1 Potential interference with microplate skirt when imaging edge wells.
2 Image degradation above microplate thickness 0.3 mm.
3 20x and 40x ELWD will image through cover slips, but other objectives will give 

better resolution and shorter exposures.

60x 
Plan Apo Oil

1-6300-
0417

No 1.40 0.21 m
m

Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt

60x 
Plan Fluor 
ELWD ADL cc 
0.1 mm to 
1.3 mm

6500-
0113

Yes, Ph2 0.70 1.8 mm 
to 
5.62 m
m

Thin bottom 
(0.17 mm)3 
Thin bottom 
(0.17 mm) No Skirt3 
Thick bottom 
(0.25 mm to 1 mm)

100x 
Plan Fluor

1-6300-
0415

No 0.95 0.2 mm Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt

100x 
Plan Fluor Oil

1-6300-
0418

No 1.30 0.2 mm Thin bottom 
(0.17 mm)1 
Thin bottom 
(0.17 mm) No Skirt

Table C-1: Nikon Objectives Compatible with the ImageXpress Micro 
System (cont’d)

Objective 
Magnificati
on and 
Type

Molecula
r Devices 
Part 
Number

Phase 
Contra
st

Numeric
al 
Apertur
e

Workin
g 
Distanc
e

Plate 
Compatibility

Note: When used with thin-bottom plates, the short working distance 
of 20X S Fluor, 20X Plan Apo, 40X S Fluor, 40X Plan Apo, 40X Plan Fluor 
Oil, 60X Plan Fluor, 60X Plan Apo, 100X Plan Fluor, and 100X Plan Apo 
objectives can cause interference with microplate skirt when imaging 
edge wells. Molecular Devices recommends to either omit the edge 
wells or use a plate with a low skirt.
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D
Filter Set/FFC Plate Combinations
Table D-1: Recommended Filter set/FFC plate combinations

Filter Set FFC Plate

DAPI Pink

FITC Red

TRITC Red

Cy3 Green

Cy5 Red

CFP Pink

YFP Red

Texas Red Red

GFP Red

Fura-2 340x (must be installed 
adjacent to Fura-2 387x)

Pink

Fura-2 387x (must be installed 
adjacent to Fura-2 340x)

Pink
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E
File Privileges for the MetaXpress 
Software Application
This appendix describes which directories must be accessible to 
MetaXpress® Software administrators and users.

Software Administrator
Read/write access is required for everything under the C:\MX6 tree. The 
Software Administrator also needs to create and periodically modify 
shading correction images on the C:\Shading Images directory. Because 
this is a possible security violation, this operation can be accomplished 
by the System Administrator so that the Software Administrator is not 
given write access to the root directory.

Note: The following assumes that the MetaXpress Software application 
has been installed in C:\MX6 (the default location).

Note: There are no restrictions as to where the software is installed. 
There is nothing that prevents you from installing the software to the 
path: C:\Program Files\MX6.
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Standard Users

Read Only access needed:
C:\MX6
C:\MX6\app\mmproc
C:\MX6\app\mmproc\Dropins
C:\MX6\Help\C:\MX\Help\ - all subdirectories - 
C:\MX6\Groups\

If the system is set up for multiple users:
C:\MX6\Groups\MetaXpress
C:\MX6\Groups\MetaXpress\Users

If the system is an acquisition computer:
C:\MX6\Hardware\
C:\MX6\Hardware\ - all subdirectories -
C:\MX6\Plates\
C:\MX6\Vinput\ - all subdirectories -

Read/Write and Modify Access needed:
C:\Analysis
C:\Assay
C:\Backup
C:\Shading

If the system is set up for a single user:
C:\MX6\Groups\MetaXpress

If the system is set up for multiple users:
C:\MX6\Groups\MetaXpress\Users\Individual user
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F
Robotic Plate Handling
If your ImageXpress® Micro System has a robotic plate handler integrated 
with the base imaging system, there are additional hardware and user 
procedures to become familiar with. The robotic plate handler is 
integrated with the ImageXpress Micro System in such a way that plates 
can be scanned for barcodes, loaded onto the imaging system where 
images are acquired, and then returned to a home location.
If you want to upgrade your system with a robotic plate handler, contact 
Molecular Devices sales support. 
A robotic plate handler is easily integrated with the ImageXpress Micro 
Imaging System. The Robot step-by-step protocol is as follows:

1. Fetch a microplate from a hotel shelf. 
2. Scan the microplate barcode. 
3. Load the microplate onto the ImageXpress Micro System. 
4. Acquire images.
5. Unload the microplate from the ImageXpress Micro System. 
6. Return the microplate to the original hotel shelf. 

Verifying External Control Settings
If you have a robot attached to the ImageXpress Micro System, you need 
to confirm that the External Control settings in the Meta Imaging Series 
Administrator are enabled and that the correct COM port is selected. Use 
the following procedure to confirm that the External Control settings in 
the Meta Imaging Series Administrator are enabled:

1. From the Windows Start menu, click All Programs > MetaXpress 
> Meta Imaging Series Administrator.

2. In the Meta Imaging Series Administrator, select MetaXpress 
from the List of Groups field.

3. Click Configure Hardware.
4. In the Configure Hardware dialog, click Install System Devices. 
5. In the Install Systems Devices dialog, ensure that External 

Control is listed in the Installed Devices list. If it is not, select it 
from the Available Hardware list and click Install>>.
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6. Select External Control from the Installed Devices list and click 
Settings.

7. In the External Control Settings dialog, click the Connections 
Settings tab.

CRS Catalyst Express Robot User Procedures 

Loading Plates onto the CRS Catalyst Express Robot 
In order to use the CRS Catalyst Express robot to scan barcodes and to 
load and unload plates onto the ImageXpress Micro instrument, you 
must properly load your plates onto the hotels of the robotic plate 
handler. If the plates are not loaded in the correct orientation, two errors 
will occur: 

• The barcode will not be scanned. 
• Well position A1 will not be correctly located in the front-left 

corner of the plate-loading region on the ImageXpress Micro 
instrument.   

The following steps will prevent these errors: 
1. If you plan to scan barcodes, properly affix the barcode labels 

before loading plates onto the robotic plate handler. We 
recommend that labels are located on the front left side of the 
plate and they must be consistently located in the same position 
on all plates being scanned. For example: 

Figure F-1: Boxed region shows barcode affixed on front of 
microplate 
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Robotic Plate Handling
2. The CRS Catalyst Express has three vertical racks (“hotels”) onto which 
you can load microplates. The directions that follow assume you are 
positioned in front of the robot as pictured immediately below. The 
hotel numbers (1 to 3) are at the front of the robot. 

Figure F-2: Numbers mark the three hotel racks where 
microplates are loaded 

3. Plates need to be loaded into the hotels with the barcodes facing 
the front of the robot. 

Note: We suggest using labels with a minimum line width of no 
less than 7.5 mm, preferably 10 mm. For recommendations on 
compatible barcode vendors, please contact Molecular Devices 
Technical Support. See Obtaining Support on page 34.
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Figure F-3: Box shows barcode centrally located on the 
microplate, which should be facing toward the front of the hotel 

4. When correctly placed in the hotels, well position A1 is located in 
the front left corner as viewed from the front of the robot. 

5. If your plates are loaded with the barcode facing front and A1 in 
the front left location, then your plates will be scanned and 
correctly loaded onto the ImageXpress Micro System plate-
loading region. 
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G
Electromagnetic Compatibility (EMC)
REGULATORY INFORMATION FOR CANADA 
(ICES/NMB-001:2006)

This ISM device complies with Canadian ICES-001.
Cet appareil ISM est confomre à la norme NMB-001 du Canada.

ISM EQUIPMENT CLASSIFICATION (Group 1, Class A) 
This equipment is designated as scientific equipment for laboratory use 
that intentionally generate and/or use conductively coupled radio-
frequency energy for internal functioning, and are suitable for use in all 
establishments, other than domestic and those directly connected to a 
low voltage power supply network which supply buildings used for 
domestic purposes.

INFORMATION FOR THE USER (FCC NOTICE)
This equipment has been tested and found to comply with the limits for 
non-consumer ISM equipment, pursuant to part 18 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a non-residential installation. This equipment 
generates, uses, and can radiate radio frequency energy and if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for 

help.
5015321 C 225 



ImageXpress Micro Widefield High Content Screening System User Guide
In order to maintain compliance with FCC regulations, shielded cables 
must be used with this equipment. Operation with non-approved 
equipment or unshielded cables is likely to result in interference to radio 
and TV reception. The user is cautioned that changes and modifications 
made to the equipment without the approval of the manufacturer could 
void the user's authority to operate this equipment.
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Index
A
Acquire Time Series acquisition 

option
defined 119

Acquire Z Series acquisition option
defined 119

acquired image
carrying out shading correction 

for 134

acquisition protocol
configuring post-acquisition 

analysis options for 130
configuring the acquisition 

wavelengths for 108
configuring the autofocus options 

for 100
configuring the journals for 127
configuring the MetaXpress 

desktop appearance settings for 
136

configuring the number of sites 
that are to be acquired for each 
well in 82

configuring the well sites for 
which data is to be acquired in 
145

configuring the wells for which 
data is to be acquired in 145

loading 144
running 151
saving 141
specifying the camera binning and 

gain for 74
specifying the plate dimensions 

for 76
specifying the series acquisition 

options for 119
viewing a summary of all current 

settings for 140
acquisition settings

verifying for an acquisition 
protocol 148
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acquisition wavelengths
configuring for an acquisition 

protocol 108
adjusting

correction collars 204
administrator 24
altitude, site requirement 209
apochromatic objectives 28
asynchronous command execution 

19
autofluorescence 25
autofocus laser 19, 22, 204
autofocus options

configuring for an acquisition 
protocol 100

AxoTrace messages, logging 36

B
bandpass filter 25
barcodes 222

location 222, 223
binning camera 63

C
camera

binning 63
CCD 19, 22
driver 45
sCMOS 19, 22

camera binning
specifying for an acquisition 

protocol 74

camera gain
specifying for an acquisition 

protocol 74
changing

objectives 182
Class 1 laser product 11
cleaning

objectives 183
the instrument 205

clearance
rear 209

cold mirror 20
computer

host 30
Configure tab, Acquisition tab on the 

Plate Acquisition Setup dialog 99
Configure tab, Display tab on the 

Plate Acquisition Setup dialog 136
Configure tab, Objective tab on the 

Plate Acquisition Setup dialog 74
Configure tab, Plate tab on the Plate 

Acquisition Setup dialog 76
Configure tab, Sites to Visit tab on the 

Plate Acquisition Setup dialog 82
correction collars

adjusting 204
CRS Catalyst Express robot 222

loading plates 222

D
database

saving an acquisition protocol to 
141

dichroic mirror 25
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Index
E
electromagnetic compatibility 225
EMC 225
emission 24

filters 25
environmental

humidity 209
temperature 209

epi-illumination 19, 25
excitation 24

filters 25

F
failure

interlock 10
file

saving an acquisition protocol to 
141

filter cube
changer 21
Nikon TE2000 21
replacing 177

filters
bandpass 25
interference 26
Semrock 21

fluorescence 24
fuse

replacing 176
Xenon light source 13, 176

H
hardware server 175
high-voltage electronics 13
host 175

computer 30
hotel numbers 223
hotel racks

numbering 223
humidity

environmental 209

I
illumination

optics 21
source 26

Image-based focusing
defined 100

instrument
cleaning 205

interference filters 26

J
journals

configuring for an acquisition 
protocol 127

L
lamps

solid-state 12, 175
Xenon, 300 W 11, 175
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laser
autofocus 204
Class 1 11

Laser-based autofocusing
defined 100

light guide 21
light source 20
loading plates

CRS robot 222
logging, AxoTrace messages 36

M
menu map 23
MetaXpress Software desktop 

appearance settings
configuring for an acquisition 

protocol 136
mirror

dichroic 25
motorized

objective changer 21
X-Y stage 22
Z stage 21

N
Nikon objectives, compatible with 

system 211
Nikon TE2000

filter cubes 21
non-interlocked service panels 10
numbering

hotel racks 223

O
objectives 21

changing 182
cleaning 183
correct placement 182
Nikon, compatible with system 

211
oil-immersion 184

optical path 26

P
peripherals 175
plate

clamp 22
Plate Acquisition and Control dialog 

152
Plate Acquisition dialog 158
Plate Acquisition Setup dialog

accessing 68
Configure tab, Acquisition tab 99
Configure tab, Display tab 136
Configure tab, Objective tab 74
Configure tab, Plate tab 76
Configure tab, Sites to Visit tab 82
layout of 69
Summary panel 140

Plate Acquisition toolbar 163
plate dimensions

configuring for an acquisition 
protocol 76
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